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Preface

This guide describes Oracle's StorageTek VSM GUI software. VSM GUI provides a point-and-click alternative to VTCS commands and utilities in the VSM environment.


Audience

This document is for administrators and analysts who install, configure, and use VSM GUI.





Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.


Access to Oracle Support

Oracle customers that have purchased support have access to electronic support through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.





Conventions

The following text conventions are used in this document:


	Convention	Meaning
	boldface	Boldface type indicates graphical user interface elements associated with an action, or terms defined in text or the glossary.
	italic	Italic type indicates book titles, emphasis, or placeholder variables for which you supply particular values.
	monospace	Monospace type indicates commands within a paragraph, URLs, code in examples, text that appears on the screen, or text that you enter.












1 Introduction

Welcome!

Oracle's StorageTek Virtual Storage Manager Graphical User Interface (VSM GUI) provides a Web-based interface to Virtual Tape Control Software (VTCS) management and reporting commands for the StorageTek VSM library products.

Packaged as a virtual machine to run in a VMware environment on your site's VM server, VSM GUI communicates with SMC at the mainframe host systems to gather, display, and report VSM-related data, and also to issue command requests directly to the Enterprise Library System (ELS) software.

The VSM GUI user interface provides context-sensitive displays that support intuitive access to VTCS commands. Graphical and tabular reports are provided, with dynamic tabbing used to display additional information that is specific to selected objects.






[bookmark: sthref10]
2 Installation and Configuration

[bookmark: sthref11]This chapter describes how to install and configure VSM GUI software.





Product Distribution Medium






Product Distribution Medium

The VSM GUI web application is distributed using a Virtual Machine (VM). The VM environment contains the operating system and software stack required to access VSM GUI. You will ingest the VM into a VMware environment at your site. The distribution type is Open Virtualization Format (OVA).


VM Resource Requirements

For best VSM GUI application performance, the following minimum resources should be allocated for the product VM:

	
32 GB memory


	
80 GB virtual disk space


	
4 CPU








VM Software Versions

The VM for the VSM GUI application works with the following VM environments:

VMware:

	
VMware ESXi: 5.1.0, Build 1483097


	
vSphere Client: 5.1.0, Build 1471691




	
Note:

Use a ESXi version that meets requirements for the VM server CPUs.














VM System OS/Software Stack Details

Third party software components installed and configured to support the VSM GUI application include:

Operating System: Oracle Linux 6.7

	
Hostname: vsmguisvr


	
User: vsmgui (customer access only)


	
User: oracle




Webserver: Weblogic 12.1.3

Database: Oracle Database 12c Release 12.1.0.1.0 - 64bit Production






Download VSM GUI Software






Download VSM GUI Software

	
Access the Oracle Software Delivery Cloud website at the following URL:

http://edelivery.oracle.com/


	
Sign in and accept the Export Restrictions agreement.


	
Locate the StorageTek VSM GUI software in the Product search box and then select the Linux x86-64 platform. When you have the correct product and platform in the Selected Products box, click Continue.


	
Available versions of the product are displayed, with the current release pre-selected. If this is correct, click Continue.


	
Review and accept the terms of the license agreements and click Continue.


	
When the files to download are displayed, click Download All.


	
When the files have downloaded, use the md5sum utility to verify the downloaded files:

	
On a UNIX/LINUX system, use the command:

md5sum -c VSMGUI_file_parts.md5sum


	
On a Windows system, Microsoft provides a free Microsoft File Checksum Integrity Verifier (fciv.exe) which can be downloaded for this.




The md5sum file is ASCII text if you need to verify files individually.


	
Combine the .ova file parts to create the full .ova file.

	
On a UNIX/LINUX system, use the command:

cat VSMGUI_n.ova.a* > VSMGUI_n.ova

where n is the version number in the file names, such as 1.2.3.00.000.


	
On a Windows system, from a DOS window, execute the provided batch file, cat_parts.bat.





	
Use the md5sum utility to verify the complete .ova file is correct:

	
On a UNIX/LINUX system, use the command:

md5sum -c VSMGUI_n.ova.md5sum

where n is the version number in the file name, such as 1.2.3.00.000.


	
On a Windows system, Microsoft provides a free Microsoft File Checksum Integrity Verifier (fciv.exe) which can be downloaded for this.




The md5sum file is ASCII text if you need to compare checksum manually.


	
Review the VSM GUI Release Notes for this release before proceeding.







VM System Deploy for VMware Environments






VM System Deploy for VMware Environments

	
On a Windows PC or server, install VMware vSphere Client software version 5.1.0, Build 1471691.


	
Start VMware vSphere Client and log in using credentials created at install time.

A Security Warning may be displayed for the Certificate. If so, click Ignore.


	
Optional: Save VM configuration from previous OVA install. If this is an upgrade to a previous OVA install and configuration, perform the following steps:

	
Save the current site configuration:

$ cd /opt/vsmgui/scripts

$ ./siteConfigCopy.sh save


	
Back up the site configuration and LDAP configuration to a PC or server:

/opt/Oracle/Middleware/Oracle_Home/user_projects/domains/vsmgui/config/config.xml

/home/vsmgui/siteConfigData.sql





	
Deploy VM using the VSMGUI_n.ova file by selecting Deploy OVF Template on the File menu.




	
Note:

If this is the first time the client software has been executed, the Home screen may be initially displayed. If so, click the Inventory icon and then deploy the OVF template as instructed above.








	
Follow the prompts in the Deploy OVF wizard as follows:

	
Source: Select the source location by browsing to the VSMGUI_n.ova file. Then click Next.


	
OVF Template Details: Click Next to continue.


	
Name and Location: Enter a name and location for the deployed template. This should be a name that communicates the VM type and version number (for example, VSM_GUI_1.2.3.00.000). Then click Next.


	
Storage: Select the data storage for this VM. Then click Next.


	
Disk Format: Select Thick Provision Eager Zeroed. Then click Next.


	
Network Mapping: Select the source network from the network inventory. Then click Next.


	
Ready to Complete: The deployment settings are displayed and you are asked if these are the options to use.

If not correct, click Back and correct the settings.

If correct, select Power On After Deployment. Then click Finish.










VM System Configuration






VM System Configuration

	
Access the new VM:

	
Select the new VSM GUI VM in the left pane list of virtual machines.


	
Select the Console tab in the main right pane. You may need to click the Console screen to display the desktop login.


	
Log in to Linux desktop:

Username: vsmgui

Password: vsm6admin





	
Open a command terminal and execute Linux/System configuration:

$ cd /opt/vsmgui/scripts

$ ./vsmGui_config.sh


	
Complete all configuration prompts:

	
At Would you like to configure/re-configure Network?, select y.


	
At Select Action, select Device Configuration and press Enter.


	
At Select a Device, select eth0 and press Enter.


	
At Network Configuration, enter the network configuration data for your site.

Do not change Name: eth0 or Device: eth0.

At Use DHCP [*], use the space bar to clear DHCP.

Fill in the Static IP, Netmask, Default Gateway IP, and optionally the primary and secondary DNS Servers.

Select OK to complete device configuration and then select Save to save it.


	
Enter DNS configuration. This step is optional. Configuration for DNS does not directly affect the use of the VSM GUI application.

Select DNS Configuration and fill in the IP addresses for the primary DNS server and, if available, the secondary and tertiary DNS servers, and also the DNS Search Path, such as mycompany.com. Do not change Hostname: vsmguisvr.

Select OK to complete DNS configuration and then select Save&Quit to save it and exit from Network Configuration.


	
Complete the prompts for Time Zone and NTP Server Configuration.





	
The operating system should reboot on completion of the configuration script. If the script instead returns to a prompt after completion, reboot as follows:

$ sudo shutdown -r now


	
Open a command terminal and start Oracle Database service after the system reboots:

$ su – oracle (password = vsm6sqladm!)

$ sqlplus /nolog

SQL> connect sys as sysdba; (password = vsm6sqladm)

SQL> startup;

SQL> quit

$ lsnrctl start

$ exit


	
Set up the database. As user: vsmgui, enter the following commands:

$ cd /opt/vsmgui/scripts

$ ./vsmGui_import.sh


	
Add an existing LDAP user that will be the VSM GUI administrator:

$ cd /opt/vsmgui/scripts

$ ./vsmGui_user.sh


	
Optional: Restore VM configuration from previous OVA install.

If this is an upgrade to a previous OVA install and you backed up the configuration files during VM system deployment, perform the following steps:

	
Copy siteConfigData.sql to /home/vsmgui


	
Copy config.xml to /opt/Oracle/Middleware/Oracle_Home/user_projects/domains/vsmgui/config/config.xml


	
Run the following to restore site configuration:

$ cd /opt/vsmgui/scripts

$ ./siteConfigCopy.sh restore





	
With the Oracle Database online, start the Weblogic Service:

$ sudo service weblogicd start

The command will direct output to the terminal during startup. After a prompt is returned, status can also be verified using the following command:

$ sudo service weblogicd status


	
Configure Weblogic to access the LDAP server for authentication.

See Release Notes on how to configure for Open LDAP or Microsoft Active Services.


	
Restart Weblogic after completing LDAP configuration:

$ sudo service weblogicd stop

$ sudo service weblogicd start
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VSM GUI Initial Site-Specific Configuration

Site configuration is required as a part of the initial VSM GUI installation process.




	
Note:

Ingest must be disabled before you add or change any value in the site configuration.







Site configuration is where you define local site-specific information that VSM GUI requires to operate correctly.

This information includes the set of tapeplexes from which data will be collected, the set of hosts connected to each tapeplex, and the values for various alert conditions that VSM GUI supports and displays.

Additionally, site configuration is where you define which users in your LDAP directory can access VSM GUI and the type of access that is allowed on each tapeplex for each user.


Site Configuration Tasks

Site configuration tasks include the following:

	
For each supported tapeplex, supply tapeplex names and severity level of log file messages


	
For each tapeplex, determine whether data for all VTVs or just initialized VTVs is to be collected


	
For each tapeplex, provide connection details for each connected host


	
Ensure there is at least one HTTP server defined for each tapeplex. VSM GUI can only collect data and display data from the defined HTTP server.


	
Ensure that each configured host runs a version of ELS supported by VSM GUI


	
Provide LDAP user names who may access VSM GUI. Optionally, provide Email addresses.


	
Assign user roles for each user on each tapeplex. The user role defines the set of VSM GUI pages available. If a user has no access for a tapeplex, then the user will not see data for that tapeplex.


	
Define alert levels for each tapeplex


	
Define VTSSs in each tapeplex and alert levels for each VTSS


	
The default database update configuration can be altered, if required. Several site configuration properties are editable to fine-tune host cycle times and batch record sizes for your site.








Required Site Data

You must collect the following information before performing site configuration:

	
A list of tapeplex names for which data will be collected


	
For each tapeplex, a list of connected hosts


	
For each tapeplex, a list of connected VTSSs


	
For each connected host, the host name or IP address, the SMC HTTP server port number, the SMC subsystem name, the ELS subsystem name, and the ELS version


	
A list of LDAP user names that will be allowed access to VSM GUI


	
For each LDAP user name, the name of the tapeplex or tapeplexes they may access


	
For each LDAP user name, the user role on each tapeplex they may access








VSM GUI User Names and User Role Definitions

VSM users can be any user names in your site's LDAP directory. The user name and login password for VSM GUI are the same as the user's LDAP login and password.

For each tapeplex a user is allowed to access, a user role is assigned that governs the level of VSM GUI access the user is allowed for that tapeplex.

There are three user roles:

	
VsmViewer: Accesses only the Status and Display tabs, with no access to context menus or Management and Administration tabs on the specified tapeplex


	
VsmOperator: Accesses the Status, Display, Management, and Administration tabs (excluding the Site Configuration and Download Logs options) on the specified tapeplex


	
VsmGuiAdmin: Accesses the Status, Display, and Administration tabs (excluding access to context menus) across all tapeplexes




An LDAP user was identified during "VM System Configuration" as the first VSM GUI user. This user's role is VsmGuiAdmin. You will log in as this user to perform initial site configuration.





Site Configuration Procedures

Site configuration procedures for VSM GUI are on the Administration menu. The procedures are in the form of a multi-page Site Configuration Wizard that steps you through the site configuration process.




	
Note:

For more information about each of the data entry fields in the Site Configuration Wizard, see "Administration Menu".







To perform site configuration:

	
Open a browser to the static host IP address you defined for VSM GUI during "VM System Configuration".


	
At the login prompt, log in to VSM GUI using the LDAP user name you defined as the administrator during "VM System Configuration".


	
At the Dashboard, click the Administration tab and select Site Configuration to open the Site Configuration Wizard.


	
At the Introduction page, review the displayed information and then click Next Page to begin the configuration process.


	
At the "Configure Supported Tapeplexes" page, define the tapeplexes and the hosts that are connected to each tapeplex. Then click Next Page.


	
At the "Configure Application Users" page, define the LDAP user names that will be allowed VSM GUI access, the tapeplexes each user will be allowed to access, and the user's role for each accessible tapeplex. Then click Next Page.


	
At the "Configure Alert Levels" page, define the critical alert level thresholds for each VTSS in each supported tapeplex. Then click Next Page.


	
At the "Edit Default Configuration Properties" page, fine-tune host cycle times and batch record sizes for your site if desired. Then click Next Page.


	
At the "Review Site Configuration Summary" page, review the configuration settings to ensure they are complete and accurate. To make changes, click Previous Page and Next Page to navigate among the pages.


	
When you are finished, click Done to close the Site Configuration Wizard. A dialog is displayed. Click OK to close the Site Configuration tab.







	
Note:

All site configuration data must be defined during the initial site configuration process but can be modified at any time.












Start Data Ingest Process






Start Data Ingest Process

Site Configuration must be completed for ingest to run successfully.

Start the ingest process as follows:

	
Log in to VSM server as user: vsmgui


	
Open a command terminal and run the following command:

$ sudo service ingestd start







Access VSM GUI






Access VSM GUI

After site configuration is complete and a successful ingest of data, the VSM GUI web application can be accessed on a client system using a local browser with the following URL:

http://server name or IP:7003/VSM_UI/faces/UIShell

Log in as the LDAP user that was assigned as the VSM GUI administrator during "VM System Configuration".










Getting Started
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3 Getting Started

When VSM GUI has been installed and configured for your site, the VSM GUI web application can be accessed by authorized LDAP users on a client system using a local browser.





Log in to VSM GUI






Log in to VSM GUI

Open a local browser to the internal Web address for VSM GUI at your site. The VSM GUI administrator should provide you with this address if you are authorized to access VSM GUI.

When prompted, enter your LDAP user name and password and then click OK.

[image: Surrounding text describes login.png.]

Login will continue if you are an authorized user. If not, contact the VSM GUI administrator for your site.




Accessibility Settings






Accessibility Settings

After a successful login, a dialog is displayed:

[image: Surrounding text describes accessability.png.]

Click Screen Reader to activate screen reader mode on the application.

Click Do not show these options again to hide this dialog for future logins.

Click Continue to close the dialog and display the VSM GUI Dashboard. The Accessibility settings are remembered for future logins.




	
Note:

You can change the Accessibility settings at any time by clicking Accessibility Settings in the upper right corner of the VSM GUI application pages. The Accessibility dialog is displayed.










User Role






User Role

Different users have different levels of access to VSM GUI.

For each tapeplex a user is allowed to access, a user role is assigned that governs the level of VSM GUI access the user is allowed for that tapeplex.

There are three user roles:

	
VsmViewer: Accesses only the Status and Display tabs, with no access to context menus or Management and Administration tabs


	
VsmOperator: Accesses the Status, Display, Management, and Administration tabs (excluding the Site Configuration and Download Logs options)


	
VsmGuiAdmin: Accesses the Status, Display, and Administration tabs (excluding access to context menus) across all tapeplexes







Logging Off






Logging Off

To log off and end a VSM GUI session, click Logout at the upper right on any VSM GUI display screen.




VSM GUI Dashboard






VSM GUI Dashboard

Once you are logged in, the initial VSM GUI display is the "Dashboard".

[image: Surrounding text describes vsmgu001_dashboard.png.]


The Dashboard indicates current VSM system status and provides alerts for key performance metrics. The Dashboard is always available during a VSM GUI session.

To end a VSM GUI session, click Logout.




VSM GUI Navigation Tree






VSM GUI Navigation Tree

The navigation tree left of the Dashboard contains links to the complete set of VSM GUI reports and commands. The links are organized in four menu tabs: Status, Display, Management, and Administration.

Click a tab to display its menu details. Your access to various functions depends on your "User Role".


Status

[image: Surrounding text describes vsmgu000_statusmenu.png.]


"Status Menu" options include:

	
"Dashboard"


	
"Active Processes"


	
"Queued Processes"


	
"Tasks"








Display

[image: Surrounding text describes vsmgu009_displaymenu.png.]


"Display Menu" options include:

	
"Display CLINK"


	
"Display Cluster"


	
"Display Configuration"


	
"Display Drive"


	
"Display MVC"


	
"Display MVC Pool"


	
"Display VLE"


	
"Display VTD"


	
"Display VTSS"


	
"Display VTV"








Management

[image: Surrounding text describes vsmgu020_management.png.]


"Management Menu" options include:

	
"Command Log"


	
"Audit"


	
"MVC Drain"


	
"Reclaim"


	
"Reconcile"


	
"Vary"








Administration

[image: Surrounding text describes adminmenu.png.]

"Administration Menu" options include:

	
"Site Configuration"


	
"Application Logs"


	
"Database Update Log"















Status Menu






















[bookmark: BABIBHHE]
4 Status Menu

[image: Surrounding text describes vsmgu000_statusmenu.png.]

.[bookmark: sthref55]This menu provides access to the following VSM GUI panes:


	
"Dashboard"



	
"Active Processes"



	
"Queued Processes"



	
"Tasks"









Dashboard






Dashboard

The VSM GUI Dashboard indicates current VSM system status and provides alerts for key performance metrics.

The Dashboard is initially displayed when you log in to VSM GUI and remains active throughout the VSM GUI session. To re-display the Dashboard during a session, just click the Dashboard tab at the top of the pane.

[image: Surrounding text describes vsmgu001_dashboard.png.]

Dashboard elements include:

	
"Status"


	
"VTV Counts"


	
"Free MVCs"


	
"MVCs in Error"




A database update error message is displayed at the top of the Dashboard if there has been an issue with the database refresh process. Click the error message to display the Database Update Log and manage the database refresh process manually.



Status

This data table shows current system status summarized for all VTSSs in each tapeplex or expanded to show each VTSS in a selected tapeplex.

To display, select Status and Dashboard on the navigation tree.

You may need to scroll horizontally or detach the table to view all columns.

[image: Surrounding text describes vsmgu002_status.png.]

Click the Expand button left of the tapeplex name to display the VTSSs for that tapeplex.

The status for each field is summarized with a status indicator:


	Icon	Name	Description
	[image: Surrounding text describes good.jpg.]
	Good	Indicates no threshold violations are detected
	[image: Surrounding text describes caution.jpg.]
	Caution	Indicates warning thresholds have been exceeded
	[image: Surrounding text describes critical.jpg.]
	Critical	Indicates critical thresholds have been exceeded
	[image: Surrounding text describes unknown.jpg.]
	Unknown	Indicates status could not be detected






Click a status indicator to display its details:

	
Click a VTSS Status or DBU indicator to view the "Display VTSS" panel filtered for the selected tapeplex or VTSS.


	
Click a RTDs or vRTDs indicator to view the "Display Drive" panel filtered for that drive type on the selected tapeplex or VTSS.


	
Click an IPCLINKs or FICON CLINKs indicator to view the "Display CLINK" panel filtered for the selected tapeplex or VTSS.


	
Click a Migrate Queue or Replication Queue indicator to view the "Queued Processes" panel filtered for the selected tapeplex or VTSS.




Table columns and descriptions include:


	Column	Description
	Tapeplex VTSS	The tapeplex name and the VTSS names in the tapeplex.
	VTSS Status	Indicates VTSS status:
Good: Indicates the VTSS is Online.

Warning: Indicates the VTSS is Online-p, Quiescing, Quiesced, or Started.

Critical: Indicates the VTSS is Offline or Offline-p.

Unknown: Indicates a value other than Online, Online-p, Offline, Offline-p, Quiescing, Quiesced, or Started.


	DBU	Indicates the DBU level:
Good: Indicates the DBU is less than the high auto-migrate threshold (HAMT).

Warning: Indicates the DBU is greater than or equal to the high auto-migrate threshold (HAMT).

Critical: Indicates the DBU is greater than the alert level for this VTSS.

Unknown: Indicates the DBU, alert level, or HAMT values are missing.


	RTDs	Indicates the RTD status:
Good: Less RTDs are offline than the warning number for this VTSS.

Warning: More RTDs are offline than the warning number for this VTSS.

Critical: More RTDs are offline than the critical number for this VTSS.

Unknown: Status of some RTDs is unknown, or critical/warning alert levels are missing.


	vRTDs	Indicates the vRTD status:
Good: Less vRTDs are offline than the warning number for this VTSS.

Warning: More vRTDs are offline than the warning number for this VTSS.

Critical: More vRTDs are offline than the critical number for this VTSS

Unknown: Status of some vRTDs is unknown, or critical/warning alert levels are missing.


	IP CLINKs	Indicates the IP Clinks status:
Good: Less IP CLINKs are offline than the warning number for this VTSS.

Warning: More IP CLINKs are offline than the warning number for this VTSS.

Critical: More IP CLINKs are offline than the critical number for this VTSS.

Unknown: Status of some IP CLINKs is unknown, or critical/warning alert levels are missing.


	FICON CLINKs	Indicates the FICON CLINKs status:
Good: Less FICON CLINKs are offline than the warning number for this VTSS.

Warning: More FICON CLINKs are offline than the warning number for this VTSS.

Critical: More FICON CLINKs are offline than the critical number for this VTSS


	Migrate Queue	Indicates the migrant queue level status:
Good: Less Migration processes in the queue than the warning number for this VTSS.

Warning: More Migration processes in the queue than the warning number for this VTSS.

Critical: More Migration processes in the queue than the critical number for this VTSS.

Unknown: Critical/warning alert levels are missing, or Queued Processes data is missing.


	Replication Queue	Indicates the replication queue level status:
Good: Less Replication processes in the queue than the warning number for this VTSS.

Warning: More Replication processes in the queue than the warning number for this VTSS.

Critical: More Replication processes in the queue than the critical number for this VTSS.

Unknown: Critical/warning alert levels are missing, or Queued Processes data is missing.








Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Columns	Show all or selected columns and manage hidden/visible status
	Detach	Display the table in a separate window
	Expand	Show individual VTSSs in the selected tapeplex
	Expand All Below	Expands all tapeplexes below the current selection
	Collapse All Below	Collapses all tapeplexes below the current selection
	Expand All	Expands all tapeplexes
	Collapse All	Collapse all tapeplexes
	Scroll to First	Scroll to the top of the list of tapeplexes
	Scroll to Last	Scroll to the bottom of the list of tapeplexes
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










VTV Counts

This graph shows VTV scratch and resident counts for each tapeplex.

To display, select Status and Dashboard on the navigation tree.

[image: Surrounding text describes vsmgu003_vtvscratch.png.]

Hover the mouse on an object to display summary data for the object.

Hover on a label to highlight related objects on the graph.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes verticalbargraph.jpg.]
	Vertical bar graph	Display the graph as a vertical bar chart
	[image: Surrounding text describes horizontalbargraph.jpg.]
	Horizontal bar graph	Display the graph as a horizontal bar chart
	[image: Surrounding text describes stackbargraph.jpg.]
	Stacked bar graph	Display the graph as a stacked bar chart
	[image: Surrounding text describes piechart.jpg.]
	Pie chart	Display the graph as a pie chart
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










Free MVCs

Free MVCs reports show free MVC status for MVC Pools or media types:

	
"Free MVCs: MVC Pools"


	
"Free MVCs: Media"




To display, select Status and Dashboard on the navigation tree.

[image: Surrounding text describes vsmgu004_freemvcs.png.]



Free MVCs: MVC Pools

The MVC Pools data table indicates Free MVCs current status for each MVC Pool on each tapeplex.

The status for each field is summarized with a status indicator:


	Icon	Name	Description
	[image: Surrounding text describes good.jpg.]
	Good	Indicates no threshold violations are detected
	[image: Surrounding text describes caution.jpg.]
	Caution	Indicates warning thresholds have been exceeded
	[image: Surrounding text describes critical.jpg.]
	Critical	Indicates critical thresholds have been exceeded
	[image: Surrounding text describes unknown.jpg.]
	Unknown	Indicates status could not be detected






Click a status indicator to display its details:

MVC Pools are shown to be in a critical state if the number of free MVCs is less than the Minimum Free MVCs value for the pool.

MVC Pools are shown to be in a warning state if the number of free MVCs is equal to than the Minimum Free MVCs value for the pool.

MVC Pools are shown to be in a good state if the number of free MVCs is greater than the Minimum Free MVCs value for the pool.

MVC Pools are shown to be in an unknown state if the Minimum Free MVCs value or the number of free MVCs is not known.

Hover the mouse on an object to display summary data for the object.

Click an MVC Pool in the data table to show the Display MVC Pool panel, filtered for that MVC Pool.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










Free MVCs: Media

The Media graph shows Free MVCs sorted by media type.

Click an object in the graph to show the Display MVC panel, filtered for that media type.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes verticalbargraph.jpg.]
	Vertical bar graph	Display the graph as a vertical bar chart
	[image: Surrounding text describes horizontalbargraph.jpg.]
	Horizontal bar graph	Display the graph as a horizontal bar chart
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Pane Information icon]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard












MVCs in Error

MVCs in Error reports show MVCs in error sorted by MVC Pool or media type:

	
"MVCs in Error: MVC Pools"


	
"MVCs in Error: Media"




To display, select Status and Dashboard on the navigation tree.

[image: Surrounding text describes vsmgu005_mvcinerror.png.]



MVCs in Error: MVC Pools

The MVC Pools graph show MVCs in error, sorted by MVC Pool.

Hover on an object to display summary data for the object.

Click an MVC Pools object to show the Display MVC Pool panel, filtered for that MVC Pool.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes verticalbargraph.jpg.]
	Vertical bar graph	Display the graph as a vertical bar chart
	[image: Surrounding text describes horizontalbargraph.jpg.]
	Horizontal bar graph	Display the graph as a horizontal bar chart
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










MVCs in Error: Media

The Media graphs show MVCs in error, sorted by media type.

Hover on an object to display summary data for the object.

Click a media object to show the Display MVC panel, filtered for that media type.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes verticalbargraph.jpg.]
	Vertical bar graph	Display the graph as a vertical bar chart
	[image: Surrounding text describes horizontalbargraph.jpg.]
	Horizontal bar graph	Display the graph as a horizontal bar chart
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard












Active Processes






Active Processes

This data table shows the active processes for all tapeplexes at the time displayed.

To display, select Status and Active Processes on the navigation tree.

You may need to scroll horizontally or detach the table to view all columns.

[image: Surrounding text describes vsmgu006_activeprocess.png.]


Click the arrows in any column header to sort the data table by that column in ascending or descending order.

You can "Cancel a Process" by right clicking its Process ID. A context menu is displayed with an option to cancel the process.

You can also filter data for individual data columns to further isolate specific information. See "Using Filters" for information about this feature.

Table columns and descriptions include:


	Column	Description
	Tapeplex	The tapeplex name.
	MVS Host	The MVS host running the process.
	Process ID	The Process ID for the function, which is a unique number in the range 0 - 65536. When the process ID reaches 65536 it wraps back to zero.
	Function	The type of request:
AllocSCR: Job allocation request for a scratch VTV.

AllocVTV: Job allocation request for a specific VTV.

Audit#: Audit utility request.

Cancel@: Cancel command.

Consold#: Consolidate or export utility task.

Consolid: Recall VTVs for remigration to a consolidation MVC. This appears as a child request to an Int_cons or Consold# request.

Dismount: Dismount a VTV from a VTD.

Display@: Display or query command.

Drain: Recall VTVs from MVC for remigration during drain or reclaim processing. This is a child of a VtvMover request.

Drain@: Drain command or utility.

DrainMVC: There is one DrainMVC request per MVC being drained. DrainMVC, which is a child request of a Drain@ request, is responsible for managing the entire drain process for a single MVC. The VTV column indicates the status of the processing against the MVC.

DELETSCR: Delete scratch utility.

Getmgpol: Obtain current management and storage class definitions.

Getconfig: Get configuration information

HSCChnge: Notification of parameter files being changed.

Import#: Importing of VTV or MVC by a utility.

Int_cons: PGMI initiated consolidate request

MEDVERfy: Media Verify parent task

Migrate: General request to perform the migrations of VTVs to a MVC. This may appear as a child to other request types.

Migrate@: Migrate command or utility. This includes migrates to threshold and auto migrates.

Mount: Mount a VTV upon a VTD. Depending upon circumstances, this may be subsequently seen as a VTV transfer or recall request.

Move MVC: There is one Move MVC request per MVC being processed by reconcile or archive. Move MVC, which is a child request of a MoveVTV# request, is responsible for managing the entire VTV movement process for a single MVC. The VTV column indicates the status of the processing against the MVC.


	
	MoveVTV#: This is a request from the ARCHIVE or RECONCILE utility commands to move copies of VTVs between MVCs. The value -TIME- in the VTV column indicates that the ELAPSED parameter was specified.
MvcMaint: MVCMAINT utility request.

MVC_chek: Check status of MVC.

MVC_eot: Reset the end of tape position of a MVC after completing a drain or reclaim. This is a child of either a DrainMVC, ReclmMVC or Move MVC request.

MVC_inv: Audit of an MVC. This appears as a child request to an Audit# request.MVCpool#: Obtain details and status of MVC pools for a utility.PGMI_req: A request received through the PGMI interface that has yet to be decoded.Query@l: Query or Display command.

MVC_upd: Reset or update MVC status.

Recall: General request to perform the recall of VTVs from a MVC. This may include a Cross TapePlex Autorecall (CTA) request from the mounting system. Recall may appear as a child to other request types.

Recall@: Recall command or utility.

Reclaim@: Auto reclaim request or a Reclaim command or utility. The value -TIME- in the VTV column indicates that the ELAPSED parameter was specified.

ReclmMVC: There is one ReclmMVC request per MVC being reclaimed. ReclmMVC, which is a child request of a Reclaim@ request, is responsible for managing the entire reclaim process for a single MVC. The VTV column indicates the status of the processing against the MVC.

Reconcil: Perform a crosscheck between the contents of the two VTSSs in a cluster.

Replicat: Perform the replication of VTVs between VTSSs in a cluster.

Scratch: Scratch a VTV request from HSC.

Sel_scr: PGMI select scratch

Set@: Set command.

Transfer: Mount a VTV upon a VTD by transferring the VTV between two VTSSs.

Unload: Unload MVC from RTD.

Uscratch: Unscratch a VTV request from HSC.

Vary_dev: Perform very processing against an individual RTD or CLINK. This appears as a child request to an VARY@ request.

Vary@: Vary command.

VtvMaint: VTVMAINT utility request.


	
	VTVMover: There is one VTVMover request per MVC being drained or reclaimed. This is a child of either a DrainMVC, ReclmMVC or Move MVC request. This request is responsible for the movement of VTVs from one MVC to another.
VTSS_inv: Audit of a VTSS. This appears as a child request to an Audit# request.

VTSS_list: Obtain a list of VTV resident within a VTSS. This appears as a child request to a Reconcil or auto migration request.

VTV_upd: Resynchronize VTV status in the VTSS with the CDS.


	Parent ID	The ID of the parent process associated with the request.
	VTSS	The VTSS name or the VTSS list name associated with the request.
	VTV Volser	The volser of the VTV currently being used in the process.
	MVC Volser	The volser of the MVC currently being used in the process.
	RTD Device Address	The unit address of the RTD currently being used in the process.
	VTD Device Address	The device address of the VTD currently being used in the process
	Task Type	The task that is processing the queue or the task to which the request is queued.
	Reason	The reason why the process is active.
	ACS	The ACS the process is using.
	LSM	The LSM the process is using.
	Storage Manager	The Storage manager the process is using.
	Internal Device Type	The Internal device type the process is using.
	For Mount	Indicates if the process is for a mount.
	For VTV Move	Indicates if the process is for VTV moves.
	Local Wait Time (mins)	The local wait time in minutes.
	Storage Class	The storage class for migration targets.
	Refreshed	The date and UTC time the data was stored or updated.






Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden/visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	See "Using Filters"
	[image: Surrounding text describes filterx.png.]
	Reset Filter	Reset the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard








Cancel a Process

To cancel a process, right click the Process Id for that process.

A context menu is displayed. Click Cancel on the context menu.

A dialog is displayed with details about the selected process.

Click Submit to cancel the selected process, or just close the Cancel tab to not submit the request.






Queued Processes






Queued Processes

This data table shows the queued processes for all tapeplexes at the time displayed.

To display, select Status and Queued Processes on the navigation tree.

You may need to scroll horizontally or detach the table to view all columns.

[image: Surrounding text describes vsmgu007_queuedprocess.png.]

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

You can "Cancel a Process" by right clicking its Process ID. A context menu is displayed with an option to cancel the process.

You can also filter data for individual data columns to further isolate specific information. See "Using Filters" for information about this feature.

Table columns and descriptions include:


	Column	Description
	Tapeplex	The tapeplex name.
	MVS Host	The MVS host running the process.
	Process ID	The Process ID for the function, which is a unique number in the range 0 - 65536. When the process ID reaches 65536 it wraps back to zero.
	Function	The type of request:
AllocSCR: Job allocation request for a scratch VTV.

AllocVTV: Job allocation request for a specific VTV.

Audit#: Audit utility request.

Cancel@: Cancel command.

Consold#: Consolidate or export utility task.

Consolid: Recall VTVs for remigration to a consolidation MVC. This appears as a child request to an Int_cons or Consold# request.

Dismount: Dismount a VTV from a VTD.

Display@: Display or query command.

Drain: Recall VTVs from MVC for remigration during drain or reclaim processing. This is a child of a VtvMover request.

Drain@: Drain command or utility.

DrainMVC: There is one DrainMVC request per MVC being drained. DrainMVC, which is a child request of a Drain@ request, is responsible for managing the entire drain process for a single MVC. The VTV column indicates the status of the processing against the MVC.

DELETSCR: Delete scratch utility.

Getmgpol: Obtain current management and storage class definitions.

Getconfig: Get configuration information

HSCChnge: Notification of parameter files being changed.

Import#: Importing of VTV or MVC by a utility.

Int_cons: PGMI initiated consolidate request

MEDVERfy: Media Verify parent task

Migrate: General request to perform the migrations of VTVs to a MVC. This may appear as a child to other request types.

Migrate@: Migrate command or utility. This includes migrates to threshold and auto migrates.

Mount: Mount a VTV upon a VTD. Depending upon circumstances, this may be subsequently seen as a VTV transfer or recall request.

Move MVC: There is one Move MVC request per MVC being processed by reconcile or archive. Move MVC, which is a child request of a MoveVTV# request, is responsible for managing the entire VTV movement process for a single MVC. The VTV column indicates the status of the processing against the MVC.


	
	MoveVTV#: This is a request from the ARCHIVE or RECONCILE utility commands to move copies of VTVs between MVCs. The value -TIME- in the VTV column indicates that the ELAPSED parameter was specified.
MvcMaint: MVCMAINT utility request.

MVC_chek: Check status of MVC.

MVC_eot: Reset the end of tape position of a MVC after completing a drain or reclaim. This is a child of either a DrainMVC, ReclmMVC or Move MVC request.

MVC_inv: Audit of an MVC. This appears as a child request to an Audit# request.MVCpool#: Obtain details and status of MVC pools for a utility.PGMI_req: A request received through the PGMI interface that has yet to be decoded.Query@l: Query or Display command.

MVC_upd: Reset or update MVC status.

Recall: General request to perform the recall of VTVs from a MVC. This may include a Cross TapePlex Autorecall (CTA) request from the mounting system. Recall may appear as a child to other request types.

Recall@: Recall command or utility.

Reclaim@: Auto reclaim request or a Reclaim command or utility. The value -TIME- in the VTV column indicates that the ELAPSED parameter was specified.

ReclmMVC: There is one ReclmMVC request per MVC being reclaimed. ReclmMVC, which is a child request of a Reclaim@ request, is responsible for managing the entire reclaim process for a single MVC. The VTV column indicates the status of the processing against the MVC.

Reconcil: Perform a crosscheck between the contents of the two VTSSs in a cluster.

Replicat: Perform the replication of VTVs between VTSSs in a cluster.

Scratch: Scratch a VTV request from HSC.

Sel_scr: PGMI select scratch

Set@: Set command.

Transfer: Mount a VTV upon a VTD by transferring the VTV between two VTSSs.

Unload: Unload MVC from RTD.

Unscratch: Unscratch a VTV request from HSC.

Vary_dev: Perform very processing against an individual RTD or CLINK. This appears as a child request to an VARY@ request.

Vary@: Vary command.

VtvMaint: VTVMAINT utility request.


	
	VTVMover: There is one VTVMover request per MVC being drained or reclaimed. This is a child of either a DrainMVC, ReclmMVC or Move MVC request. This request is responsible for the movement of VTVs from one MVC to another.
VTSS_inv: Audit of a VTSS. This appears as a child request to an Audit# request.

VTSS_list: Obtain a list of VTV resident within a VTSS. This appears as a child request to a Reconcil or auto migration request.

VTV_upd: Resynchronize VTV status in the VTSS with the CDS.


	Parent ID	The ID of the parent process associated with the request.
	VTSS	The VTSS name or the VTSS list name associated with the request.
	VTV Volser	The volser of the VTV currently being used in the process.
	MVC Volser	The volser of the MVC currently being used in the process.
	RTD Device Address	The unit address of the RTD currently being used in the process.
	VTD Device Address	The device address of the VTD currently being used in the process
	Task Type	The task that is processing the queue or the task to which the request is queued.
	Reason	The reason why the process is active.
	ACS	The ACS the process is using.
	LSM	The LSM the process is using.
	Storage Manager	The Storage manager the process is using.
	Internal Device Type	The Internal device type the process is using.
	For Mount	Indicates if the process is for a mount.
	For VTV Move	Indicates if the process is for VTV moves.
	Local Wait Time (mins)	The local wait time in minutes.
	Storage Class	The storage class for migration targets.
	Refreshed	The date and UTC time the data was stored or updated.






Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden/visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	See "Using Filters"
	[image: Surrounding text describes filterx.png.]
	Reset Filter	Reset the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard







Cancel a Process

To cancel a process, right click the Process Id for that process.

A context menu is displayed. Click Cancel on the context menu.

A dialog is displayed with details about the selected process.

Click Submit to cancel the selected process, or just close the Cancel tab to not submit the request.






Tasks






Tasks

This data table shows all tasks for all tapeplexes at the time displayed.

To display, select Status and Tasks on the navigation tree.

You may need to scroll horizontally or detach the table to view all columns.

[image: Surrounding text describes vsmgu008_tasks.png.]

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

You can also filter data for individual data columns to further isolate specific information. See "Using Filters" for information about this feature.

Table columns and descriptions include:


	Column	Description
	Tapeplex	The tapeplex the task is on.
	MVS Host	The MVS host.
	Task Number	The task number for each task on the current host.
	Task Type	INV: Inventory Manager
CMD: Command Task

DSP: Dispatcher Task

SS: VTSS Task

RTD: RTD Task

DRV: RTD Scheduler

SCR: Scratch Manager

RCM: Reclaim Manager

MSC: Migration Scheduler

CSH: Clink Scheduler

CLK: CLINK Task

UNK: Unknown


	Slot ID	The Slot ID of the lock within the lock buffer.
	VTSS	The VTSS the task is on.
	VTV Volser	The volser of the VTV used in the task.
	MVC Volser	The volser of the MVC used in the task.
	Path Name	The RTD, VTD, or path the task is using.
	Device Address	The RTD or VTD device address the task is using.
	VTD Device Address	The device address of the VTD that is using the task.
	Task Lock	Indicates lock status for the task. A task lock generally indicates contention with another host.
	VTV Lock	Indicates if the VTV in the task is locked.
	MVC Lock	Indicates if the MVC in the task is locked.
	RTD Lock	Indicates if the RTD in the task is locked.
	VTD Lock	Indicates if the VTD in the task is locked.
	Waiting Count	The count of requests waiting for locks.
	Pending Count	The count of pending requests.
	Function	The function of the task.
	Process ID	The process ID of the task.
	Parent ID	The process ID of the parent process.
	ACS	The ACS the task is using.
	LSM	The LSM the task is using.
	Storage Manager	The storage manager the task is using.
	Internal Device Type	The local wait time in minutes.
	For Mount	Indicates if the process is for a mount.
	For VTV Move	Indicates if the process is for VTV moves.
	Local Wait Time (mins)	The local wait time in minutes.
	Storage Class	The storage class for migration targets.
	Refreshed	The date and UTC time the data was stored or updated.






Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden/visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	See "Using Filters"
	[image: Surrounding text describes filterx.png.]
	Reset Filter	Reset the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard
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5 Display Menu

[image: Surrounding text describes vsmgu009_displaymenu.png.]

[bookmark: sthref66]This menu provides access to the following VSM GUI panes:


	
"Display CLINK"



	
"Display Cluster"



	
"Display Configuration"



	
"Display Drive"



	
"Display MVC"



	
"Display MVC Pool"



	
"Display VLE"



	
"Display VTD"



	
"Display VTSS"



	
"Display VTV"









Display CLINK






Display CLINK

This pane displays Cluster Links (CLINKS) information.

To display, select Display and CLINK on the navigation tree.

[image: Surrounding text describes vsmgu010_clink.png.]




Cluster Links (CLINKS)

This data table shows CLINK information.

You may need to scroll horizontally or detach the table to view all columns.

[image: Surrounding text describes vsmgu010a_clinktable.png.]


Click the arrows in any column header to sort the data table by that column in ascending or descending order.

Fields with a context menu indicator can initiate Management commands on specific data items. Right click a field to display the context menu and select the desired menu item.

You can also filter data for individual data columns to further isolate specific information. See "Using Filters" for information about this feature.

Table columns and descriptions include:


	Column	Description
	Tapeplex	The name of the tapeplex.
	VTSS	The primary or sending VTSS name.
Context menu: Audit VTSS, Vary VTSS.


	Partner Tapeplex	The partner tapeplex in the cluster.
	Partner VTSS	The secondary or receiving VTSS in the cluster.
Context menu: Audit VTSS, Vary VTSS.


	CLINK ID	The CLINK ID that has been assigned to the CLINK within the VTSS.
Context menu: Vary CLINK.


	Channel ID	The back-end channel interface to which the CLINK is connected.
	IPIFID	The IPIF ID of the CLINK.
	Cluster	The cluster name if the CLINK is used for replication of VTVs within the tapeplex and is part of a cluster. The VTSS name in the Partner VTSS column indicates the other VTSS that operates in the cluster.
	Status	One of the following:
MAINT: The link has failed or it has been varied into maintenance mode.

OFFLINE: The link is offline and unavailable to all hosts and VTSSs.

ONLINE: The link is online and available to all hosts and VTSSs.

ON-SYNC: Available for synchronous replication.

ON-ASYNC: Available for asynchronous replication.

P_OFFLINE: The link is pending offline.

P_ONLINE: The link is pending online.

RECOVERY: The link is being reset following an error or a vary online operation.

UNUSABLE: Not available for replication due to hardware errors or assigned-elsewhere conditions.

UUI ERR: This is a CLINK defined for electronic export and it has been unable to contact the remote VTCS. There should be messages in the HSC JOBLOG that indicate the reason for the problem. This could include problems with the definitions, the local SMC, or the remote HTTP server on the remote VTCS.


	Usage	One of the following:
ASSIGNED: Link is assigned to the host in the HOST field but is not currently replicating. This usage occurs when VTCS is starting or terminating link use or is attempting error recovery on the link after a replication failure.

FREE: Link is idle (not doing replications).

REPLICATING: Link is actively doing replications.


	MVS Host	The host that the link is assigned to.
	Partner VTD	The address of the VTD on the partner VTSS that forms the other end point to the connection. For a cluster link, the MVS address of the VTD is reported. For an electronic export link, this is not possible as there is no access to the other tapeplex configuration. In this case, only the ordinal number of the VTV is reported.
	Replication Capability	Indicates the CLINK is available for synchronous or asynchronous replication.
	Refreshed	The date and UTC time the data was stored or last updated.






Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden/visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	See "Using Filters"
	[image: Surrounding text describes filterx.png.]
	Reset filter	Reset the data filter
	[image: Pane Information icon]
	Refresh	Refresh with data from the VSM GUI database
	[image: Detach Pane icon]
	Detach	Display in a separate window
	[image: Filter Data icon]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard









CLINK Status

This graph shows current CLINK counts for each VTSS, sorted by current status.

[image: Surrounding text describes vsmgu010b_clinkstatus.png.]


Hover on an object to display summary data for the object.

Click an object to filter the data table by that object.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes verticalbargraph.jpg.]
	Vertical bar graph	Display the graph as a vertical bar chart
	[image: Surrounding text describes horizontalbargraph.jpg.]
	Horizontal bar graph	Display the graph as a horizontal bar chart
	[image: Surrounding text describes stackbargraph.jpg.]
	Stacked bar graph	Display the graph as a stacked bar chart
	[image: Surrounding text describes piechart.jpg.]
	Pie chart	Display the graph as a pie chart
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard









CLINK Usage

This graph shows current CLINK usage for each VTSS, sorted by current usage state.

[image: Surrounding text describes vsmgu010c_clinkusage.png.]


Hover on an object to display summary data for the object.

Click an object to filter the data table by that object.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes verticalbargraph.jpg.]
	Vertical bar graph	Display the graph as a vertical bar chart
	[image: Surrounding text describes horizontalbargraph.jpg.]
	Horizontal bar graph	Display the graph as a horizontal bar chart
	[image: Detach Pane icon]
	Stacked bar graph	Display the graph as a stacked bar chart
	[image: Detach Pane icon]
	Pie chart	Display the graph as a pie chart
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard
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Display Cluster

This pane displays Cluster information.

To display, select Display and Cluster on the navigation tree.

[image: Surrounding text describes vsmgu011_cluster.png.]



Clusters

This data table shows Cluster information.

You may need to scroll horizontally or detach the table to view all columns.

[image: Surrounding text describes vsmgu011a_clustertable.png.]


Click the arrows in any column header to sort the data table by that column in ascending or descending order.

Select a row to display data for that Cluster in the "CLINKs for Cluster" data table.

Fields with a context menu indicator can initiate Management commands on specific data items. Right click a field to display the context menu and select the desired menu item.

You can also filter data for individual data columns to further isolate specific information. See "Using Filters" for information about this feature.

Table columns and descriptions include:


	Column	Description
	Cluster	The cluster name.
	Tapeplex	The tapeplex name.
	VTSS	One of the VTSSs in the cluster.
Context menu: Audit VTSS, Vary VTSS.


	Direction	The direction of the link between the VTSSs, one of the following:
-----> or <----- indicates the direction of VTV replication in Uni-Directional Cluster. VTVs can only be replicated from the Sending to the Receiving VTSS.

<----> indicates that the VTSSs are configured as a Bi-Directional (Peer-to-Peer) Cluster. VTVs can be replicated from either VTSS to the other.


	Partner VTSS	The partner VTSS in the cluster.
Context menu: Audit VTSS, Vary VTSS.


	Mode	One of the following cluster operating modes:
ASYNC-REPLICATE: Both VTSSs in the cluster are online to VTCS. Production workload can go to either VTSS, but for a unidirectional (primary/secondary) cluster, VTVs can only be replicated from the sending VTSS. Synchronous replication is not enabled across the cluster.

SYNC-REPLICATE: Both VTSSs in the cluster are online to VTCS. Production workload can go to either VTSS, but for a unidirectional (primary/secondary) cluster, VTVs can only be replicated from the sending VTSS. Synchronous replication is enabled across the cluster.

DEGRADED: One of the two VTSSs in a bidirectional peer-to-peer cluster is either offline or quiesced. Production workload can go the remaining online VTSS. VTVs requiring replication, however, are allocated to the remaining VTSS only if no other full-function clusters are available and suitable. In this case, replicate VTVs are migrated immediately with keep and queued for replication when the other VTSS comes online. When the other VTSS comes online, VTCS reconciles the contents of both VTSSs.

DEGRADED SECONDARY: The primary is online to VTCS and the secondary is either offline or quiesced. Workload can run on the primary. VTVs requiring replication, however, are allocated to the primary only if no other full-function clusters are available. In this case, replicate VTVs are migrated immediately with keep and are queued for replication, which occurs when the secondary comes online.

DEGRADED PRIMARY: The secondary is online to VTCS and the primary is either offline or quiesced. Workload can run on the secondary. VTVs requiring replication, however, are allocated to the secondary only if no other full-function clusters are available. When the primary comes back online, VTCS reconciles the contents of the primary and secondary.

NON-OPERATIONAL: No workload is possible on this cluster.

CLINKS OFFLINE: All defined CLINKs are offline. No workload is possible on this Cluster.

ONLY SECONDARY: The Secondary is online to VTCS and the Primary has no CLINKs online. Workload can run on the Secondary. VTVs requiring replication, however, are allocated to the Secondary only if no other Full Function Clusters are available.

ONLY PRIMARY: The Primary is online to VTCS and the Secondary has no CLINKs online. Workload can run on the Primary. VTVs requiring replication, however, are allocated to the Primary only if no other Full Function Clusters are available. In this case, Replicate VTVs are migrated immediately with keep and are queued for replication.

FULL-FUNCTION: Indicates that both VTSSs are operational. If something goes wrong with the state of either VTSS, then it reports as degraded or non-operational.

Tracks MVC chaining when a file runs off the end of one volume onto another.


	Replication Capability	Indicates the cluster is available for synchronous or asynchronous replication.
	Refreshed	The date and UTC time the data was stored or last updated.






Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden/visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	See "Using Filters"
	[image: Surrounding text describes filterx.png.]
	Reset filter	Reset the data filter
	[image: Pane Information icon]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










CLINKs for Cluster

This data table displays CLINKs for the Cluster selected in the "Clusters" data table.

You may need to scroll horizontally or detach the table to view all columns.

[image: Surrounding text describes vsmgu011b_clusterclinks.png.]


Click the arrows in any column header to sort the data table by that column in ascending or descending order.

You can also filter data for individual data columns to further isolate specific information. See "Using Filters" for information about this feature.

Table columns and descriptions include:


	Column	Description
	CLINK ID	The CLINK ID that has been assigned to the CLINK within the VTSS.
	Channel ID	The back-end channel interface to which the CLINK is connected.
	IPIF ID	The IPIF ID of the CLINK.
	Status	One of the following:
Maint: The link has failed or it has been varied into maintenance mode.

OFFLINE: The link is offline and unavailable to all hosts and VTSSs.

ONLINE: The link is online and available to all hosts and VTSSs.

ON-SYNC: Available for synchronous replication.

ON-ASYNC: Available for asynchronous replication.

P_OFFLINE: The link is pending offline.

P_ONLINE: The link is pending online.

RECOVERY: The link is being reset following an error or a vary online operation.

UNUSABLE: Not available for replication due to hardware errors or assigned-elsewhere conditions.

UUI ERR: This is a CLINK defined for electronic export and it has been unable to contact the remote VTCS. There should be messages in the HSC JOBLOG that indicate the reason for the problem. This could include problems with the definitions, the local SMC, or the remote HTTP server on the remote VTCS.


	Usage	One of the following:
Assigned: Link is assigned to the host in the HOST field but is not currently replicating. This usage occurs when VTCS is starting or terminating link use or is attempting error recovery on the link after a replication failure.

Free: Link is idle (not doing replications).

Replicating: Link is actively doing replications.


	MVS Host	The host that the link is assigned to.
	Partner VTD	The address of the VTD on the partner VTSS that forms the other end point to the connection. For a cluster link, the MVS address of the VTD is reported. For an electronic export link, this is not possible as there is no access to the other tapeplex configuration. In this case, only the ordinal number of the VTV is reported
	Replication Capability	Indicates the CLINK is available for synchronous or asynchronous replication.
	Refreshed	The date and UTC time the data was stored or last updated.






Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden/visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Remove Pane icon]
	Selected Row Data	Show data for selected rows
	[image: Remove Pane icon]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Remove Pane icon]
	Print	Display as a printable page
	[image: Remove Pane icon]
	Filter	See "Using Filters"
	[image: Remove Pane icon]
	Reset filter	Reset the data filter
	[image: Pane Information icon]
	Refresh	Refresh with data from the VSM GUI database
	[image: Detach Pane icon]
	Detach	Display in a separate window
	[image: Filter Data icon]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard
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Display Configuration

This pane displays Configuration information.

To display, select Display and Configuration on the navigation tree.

[image: Surrounding text describes vsmgu012_config.png.]

Use the First Previous Next Last buttons to navigate among different tapeplexes.

Click the Print icon to display the form data in a separate window for printing.

Click the Refresh icon to refresh the data from the VSM GUI database or the Run ELS icon to refresh the actual configuration data by running appropriate ELS commands on the host.

Table columns and descriptions include:


	Column	Description
	VTSS Subsystems	Indicates the number of VTSSs in the tapeplex.
	Global Max VTV	Indicates the maximum number of VTVs that can be migrated to a single MVC.
	Global MVC Free	Indicates the minimum number of free MVCs in the MVC pool that causes VTCS to start an automatic space reclamation.
	Global VTV Attribute	Indicates when VTCS assigns a Management Class to a VTV, either ALLmount to assign a class whenever VTCS mounts the VTV or Scratch to assign a class only when VTCS does a scratch mount of the VTV.
	Global Recall with Error	Indicates whether VTCS recalls VTVs with read data checks during recall and drain operations, either Yes or No.
	Global Replication	Indicates when VSM replicates a VTV, either Always to replicate whenever the VTV is dismounted or Changed to replicate only if the VTV was Changed while it was mounted.
	Global VTV Page Size	Indicates the page size for VTV data stored in the VTSS and on the MVCs, either Standard or Large.
	Global Sync Replicate	Indicates whether the VTV synchronous replication feature is enabled, either Yes or No.
	Global Max RTDs	Indicates the maximum number of RTDs supported.
	Global Fast Migrate	Indicates whether the stacked/streamed migrates feature is enabled, either Stacked (or Yes) to enable the stacked method for migration, Stream to enable the streaming method, or No to disable the feature.
	Global Init MVC	Indicates whether un-initialized MVCs are to be initialized when they are first mounted, either Yes or No.
	Global Maximum VTV Size (MB)	Indicates the default maximum VTV size that is used during the creation of VTVs.
	Global Fast Reclaim	Indicates whether VTCS should perform Early Time to First Byte (ETTFB) concurrent tape recall/mount, either Yes or No.
	Global Locktout	Indicates the minimum number of minutes that a resource is locked before message SLS6946E is issued.
	Global Non-Library Drain	Indicates whether VTCS accepts non-library resident MVCs for drain/reclaim processing, either Yes to mount the non-Library MVC or No to suppress the mount and purge the request.
	Global Non-Library Migrate	Indicates whether non-library resident MVCs are selected for migration processing, either Yes or No.
	Global Non-Library Reclaim	Indicates whether non-library resident MVCs are selected for reclaim processing, either Yes or No.
	Global MVC Mount Timeout (mins)	Indicates the value in minutes when an MVC mount time out occurs.
	Global Log Policy	Indicates whether VTCS CDS logging is Optional or Required.
	Global Lock Structure	Indicates the Coupling Facility Structure that holds VTCS Lock Data.
	CDS Compatible Level 7.0	Indicates the CDS is compatible with ELS release 7.0.
	CDS Compatible Level 7.1	Indicates the CDS is compatible with ELS release 7.1.
	CDS Compatible Level 7.2	Indicates the CDS is compatible with ELS release 7.2.
	CDS Compatible Level 7.3	Indicates the CDS is compatible with ELS release 7.3
	Reclaim Max MVC	Indicates the maximum number of MVCs that are processed by a single space reclamation task.
	Reclaim Start	Indicates the percentage level at which automatic space reclamation starts for each ACS.
	Reclaim Max Concurrent MVCs	Indicates the maximum number of MVCs that VTCS concurrently processes for both drain and reclaim.
	Reclaim Threshold (%)	Indicates the percentage of fragmented space that makes an MVC eligible for demand or automatic reclamation.
	Reclaim Threshold (%) - VL	Indicates the percentage of fragmented space that makes a Virtual MVC (VMVC) eligible for demand or automatic reclamation
	Global Reclaim Inplace	Indicates whether dynamic reclaim supported is enabled within VTCS, either Yes or No.
	Reclaim Inplace Threshold (%)	Indicates the percentage of fragmented space that makes an MVC in partitioned format eligible for space reclamation processing.
	Reclaim Protect	Indicates the time in hours to prevent (or protect) an MVC from being re-used after it is drained or reclaimed.
	CDS Free Blocks	The difference between the minimum space required and the size of the CDS.
	Refreshed	The date and UTC time the data was stored or last updated.






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Remove Pane icon]
	Print	Display as a printable page
	[image: Pane Information icon]
	Refresh	Refresh with data from the VSM GUI database
	[image: Filter Data icon]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard








Display Drive






Display Drive

This pane displays Real Tape Drive and virtual Real Tape Drive information.

To display, select Display and Drive on the navigation tree.

[image: Surrounding text describes vsmgu013_drive.png.]




Drives (RTDs and vRTDs)

This data table displays RTD and vRTD drive information.

You may need to scroll horizontally or detach the table to view all columns.

[image: Surrounding text describes vsmgu013a_drivetable.png.]


Click the arrows in any column header to sort the data table by that column in ascending or descending order.

Click a row to display paths to that drive in the "Paths to Drive" data table.

Fields with a context menu indicator can initiate Management commands on specific data items. Right click a field to display the context menu and select the desired menu item.

You can also filter data for individual data columns to further isolate specific information. See "Using Filters" for information about this feature.

Table columns and descriptions include:


	Column	Description
	Tapeplex	The name of the tapeplex.
	Device Address	The RTD Address.
Context menu: Vary Drive.


	VLE	The VLE that the vRTD is on.
	Owner VTSS	The VTSS that is currently connected to the RTD.
	Device Type	The device type (RTD Type) of the RTD.
	Partitioning Support	The partitioning support setting, Yes, No, or Unknown.
	ACS	The ACS the RTD is attached to.
	LSM	The LSM the RTD is attached to.
	Status	One of the following RTD statuses:
RECOVER RTD: The RTD is being reset after a problem, a vary, or an initialization.

MIGRATE VTV: The RTD is migrating a VTV.

RECALL VTV: The RTD is recalling a VTV.

UNLOAD MVC: A forced unload of the RTD is occurring.

VTV TRANSFER: The RTD is migrating a VTV before recalling it on another VTSS.

AUDIT MVC: An MVC is being audited.

BUSY: The RTD is busy (non-specific task).

IDLE: An MVC is allocated to the RTD but the MVC is not being used.

ONLINE/FREE: The RTD is online and available.

MAINTENANCE: The RTD is in maintenance mode.

OFFLINE: The RTD is offline and unavailable to all hosts and VTSSs

RECOVERY: The RTD is being reset after an error or a vary online.

INITIALIZE: The host is verifying RTD status and availability.

SUSPEND: The RTD operations are suspended. This occurs when one or more RTDs and a CLINK are configured on the same port. The RTDs remain in SUSPEND mode while the CLINK is online.

PATH OFFLINE: The RTD status is unknown because the VTSS cannot contact the RTD or if the paths were not correctly configured.

PATH SUSPEND: The RTD is globally online but the path from the VTSS is suspended due to the RTD being paired with a Clink.

FAIL/OFFLINE: The RTD was placed offline due to a failure.

TOP ID: The process Id of the request that is top of the queue for next using this RTD from this host.

TOP HOST: The host which has the request that is top of the queue for next using this RTD.


	MVC Allocated	The volser of the MVC allocated for mounting on the RTD.
	MVC Mounted	The MVC that is currently mounted on the RTD.
	MVS Host	The host that currently owns the RTD.
	MVC Volser	The volser of the MVC currently mounted on the RTD or allocated to the RTD for mounting.
	Requests Queued	The number of requests that are currently queued.
	Allocation Time Remaining (mins)	The allocation time remaining, in minutes.
	Local Wait Time (mins)	The local wait time, in minutes.
	Global Wait Time (mins)	The global wait time, in minutes.
	Internal Device Type	The internal coding of the device type.
	Serial Number	The serial number of the RTD.
	Refreshed	The date and UTC time the data was stored or last updated.






Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden/visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Remove Pane icon]
	Selected Row Data	Show data for selected rows
	[image: Remove Pane icon]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Remove Pane icon]
	Print	Display as a printable page
	[image: Remove Pane icon]
	Filter	See "Using Filters"
	[image: Remove Pane icon]
	Reset Filter	Reset the data filter
	[image: Pane Information icon]
	Refresh	Refresh with data from the VSM GUI database
	[image: Detach Pane icon]
	Detach	Display in a separate window
	[image: Filter Data icon]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










Paths to Drive

This data table displays path information about the selected drive.

You may need to scroll horizontally or detach the table to view all columns.

[image: Surrounding text describes vsmgu013b_drivetable2.png.]


Click the arrows in any column header to sort the data table by that column in ascending or descending order.

You can also filter data for individual data columns to further isolate specific information. See "Using Filters" for information about this feature.

Table columns and descriptions include:


	Column	Description
	VTSS	The VTSS name.
	Path Name	The drive path name.
	Status	The drive's current status.
RECOVER RTD: The RTD is being reset after a problem, a vary, or an initialization.

MIGRATE VTV: The RTD is migrating a VTV.

RECALL VTV: The RTD is recalling a VTV.

UNLOAD MVC: A forced unload of the RTD is occurring.

VTV TRANSFER: The RTD is migrating a VTV before recalling it on another VTSS.

AUDIT MVC: An MVC is being audited.

BUSY: The RTD is busy (non-specific task).

IDLE: An MVC is allocated to the RTD but the MVC is not being used.

ONLINE/FREE: The RTD is online and available.

MAINTENANCE: The RTD is in maintenance mode.

OFFLINE: The RTD is offline and unavailable to all hosts and VTSSs

RECOVERY: The RTD is being reset after an error or a vary online.

INITIALIZE: The host is verifying RTD status and availability.

SUSPEND: The RTD operations are suspended. This occurs when one or more RTDs and a CLINK are configured on the same port. The RTDs remain in SUSPEND mode while the CLINK is online.

PATH OFFLINE: The RTD status is unknown because the VTSS cannot contact the RTD or if the paths were not correctly configured.

PATH SUSPEND: The RTD is globally online but the path from the VTSS is suspended due to the RTD being paired with a Clink.

FAIL/OFFLINE: The RTD was placed offline due to a failure.

TOP ID: The process Id of the request that is top of the queue for next using this RTD from this host.

TOP HOST: The host which has the request that is top of the queue for next using this RTD.


	Channel ID	The channel ID of the drive path.
	IPIF ID	The IPIF value that was specified for the path.
	Logical Device ID	The logical device ID assigned to the path.
	Refreshed	The date and UTC time the data was stored or last updated.






Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden/visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Remove Pane icon]
	Selected Row Data	Show data for selected rows
	[image: Remove Pane icon]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Remove Pane icon]
	Print	Display as a printable page
	[image: Remove Pane icon]
	Filter	See "Using Filters"
	[image: Remove Pane icon]
	Reset Filter	Reset the data filter
	[image: Pane Information icon]
	Refresh	Refresh with data from the VSM GUI database
	[image: Detach Pane icon]
	Detach	Display in a separate window
	[image: Filter Data icon]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard









Drive Status

This graph shows the current drive count by device type, sorted by drive status.

[image: Surrounding text describes vsmgu013c_drivestatus.png.]


Hover on an object to display summary data for the object.

Hover on a label to highlight related objects in the graph.

Click an object to filter the data table by that object.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Remove Pane icon]
	Vertical bar graph	Display the graph as a vertical bar chart
	[image: Pane Information icon]
	Horizontal bar graph	Display the graph as a horizontal bar chart
	[image: Detach Pane icon]
	Stacked bar graph	Display the graph as a stacked bar chart
	[image: Detach Pane icon]
	Pie chart	Display the graph as a pie chart
	[image: Remove Pane icon]
	Print	Display as a printable page
	[image: Pane Information icon]
	Refresh	Refresh with data from the VSM GUI database
	[image: Filter Data icon]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard









Drive Allocation

This graph shows the current drive count by device type, sorted by allocation state.

[image: Surrounding text describes vsmgu013d_driveallocate.png.]


Hover on an object to display summary data for the object.

Hover on a label to highlight related objects on the graph.

Click an object to filter the data table by that object.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Remove Pane icon]
	Vertical bar graph	Display the graph as a vertical bar chart
	[image: Pane Information icon]
	Horizontal bar graph	Display the graph as a horizontal bar chart
	[image: Detach Pane icon]
	Stacked bar graph	Display the graph as a stacked bar chart
	[image: Detach Pane icon]
	Pie chart	Display the graph as a pie chart
	[image: Remove Pane icon]
	Print	Display as a printable page
	[image: Pane Information icon]
	Refresh	Refresh with data from the VSM GUI database
	[image: Filter Data icon]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard









Drive Requests Queued

This graph shows the current number of requests queued at each device address.

[image: Surrounding text describes vsmgu013e_drivereqsqued.png.]


Hover on an object to display summary data for the object.

Click an object to filter the data table by that object.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Remove Pane icon]
	Vertical bar graph	Display the graph as a vertical bar chart
	[image: Pane Information icon]
	Horizontal bar graph	Display the graph as a horizontal bar chart
	[image: Detach Pane icon]
	Stacked bar graph	Display the graph as a stacked bar chart
	[image: Detach Pane icon]
	Pie chart	Display the graph as a pie chart
	[image: Remove Pane icon]
	Print	Display as a printable page
	[image: Pane Information icon]
	Refresh	Refresh with data from the VSM GUI database
	[image: Filter Data icon]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










Display MVC






Display MVC

This pane displays Multi-Volume Cartridge information.

To display, select Display and MVC on the navigation tree.

[image: Surrounding text describes vsmgu014_mvc.png.]



Multi-Volume Cartridges (MVCs)

This data table shows MVC information.

You may need to scroll horizontally or detach the table to view all columns.

[image: Surrounding text describes vsmgu014a_mvctable.png.]

Click a row to display VTVs for that MVC in the "VTVs on MVC" data table.

The status for some fields is summarized with a status indicator:


	Icon	Name	Description
	[image: Remove Pane icon]
	Good	Indicates no threshold violations are detected
	[image: Pane Information icon]
	Caution	Indicates warning thresholds have been exceeded
	[image: Detach Pane icon]
	Critical	Indicates critical thresholds have been exceeded
	[image: Filter Data icon]
	Unknown	Indicates status could not be detected






Click a status indicator to display its details.

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

Fields with a context menu indicator can initiate Management commands on specific data items. Right click a field to display the context menu and select the desired menu item.

You can also filter data for individual data columns to further isolate specific information. See "Using Filters" for information about this feature.

Table columns and descriptions include:


	Column	Description
	Tapeplex	The tapeplex the MVC belongs to.
	MVC Volser	The volser of the MVC.
Context menu: Audit MVC Volser, MVC Drain, Reclaim, Reconcile.


	Media	The volume media type or recording technique.
If Need PTF is displayed, then this host lacks support for this media type, but another host does have support for this media type.


	Media Size (MB)	The size of the MVC in megabytes.
	Storage Class	The Storage Class that owns the MVC. MVCs only become a member of a storage class when they contain migrated VTVs.
Context menu: MVC Drain, Reclaim, Reconcile


	MVC Pool	The name of the MVC Pool the MVC is in.
Context menu: MVC Drain, Reclaim.


	Number of VTVs Migrated	The number of current VTVs migrated to this MVC.
	VTV Count	The number of active VTVs on the MVC.
	Used Percentage	The percentage of the MVC used by current VTVs.
	Fragmented Percentage	The percentage of the MVC that contains noncurrent VTVs. This space is not available for use until it is reclaimed or the MVC is drained.
	Available Percentage	The percentage of the MVC that is physically available for use.
	Usable Percentage	The percentage of space on the MVC that can be used by VTCS. This may be zero even if there is still space physically available. For instance, if the VTV per MVC limit is reached then the usable percentage is reported as zero. Similarly, if an error has been reported against an MVC, VTCS does not use this MVC for output and the usable percentage is reported as zero.
	Times Mounted	The number of times the MVC has been mounted for writing or reading since it was added to the MVC inventory.
	Last Mounted	The date and time at which the MVC was mounted or attempted to be mounted on a RTD.
	Last Migration	The date and time at which the last VTV migration was performed to the MVC.
	Last Drain/Reclaim	The date and time at which the MVC was last processed by Drain or Reclaim processing and its end-of-tape pointer was reset.
	VTSS Last Mounted	The name of the last VTSS that performed a migration to the MVC.
Context menu: Audit VTSS, Vary VTSS.


	Initialized	Indicates the MVC's initialization status, either standard, partitioned, or not initialized.
	Audit	Indicates if the MVC is either currently being audited or has been the subject of a failed audit. While in this state the MVC is not used for migration but can be used for recalls. Due to the inherent state, recalls may fail because the CDS is not yet up-to-date with the MVC contents. To clear this condition, rerun the audit against this MVC.
	Broken	Indicates if the MVC, drive, or combination of the two has a problem. VTCS attempts to depreference MVCs with this state. If the MVC caused the problem, use a DRAIN(EJECT) command to remove the MVC from service. If the RTD caused the problem, use the MVCMAINT utility to reset the MVC state.
	Consolidation	Indicates if the MVC is consolidation MVC.
	Data Check	A data check condition has been reported against this MVC. VTCS attempts to depreference the usage of MVCs with this state. To get into this state, a data transfer must have failed upon two different RTDs.
To clear this state:

If all VTVs on the MVC are duplexed, use MVC Drain on the MVC without the Eject option. This recovers all VTVs and removes the MVC from service.

If all VTVs on the MVC are not duplexed, VTCS AUDIT the MVC. The audit may fail. After the audit, do an MVCDRAIN (no eject). This recalls the VTVs before the data-check area in ascending block-id order and the VTVs after the data-check area in a descending block-id order. Processing the VTVs in this sequence ensures that VTCS recovers as many VTVs as possible from the media. You then need to recreate the data for any VTVs still on the MVC.

Although this indicates that a specific failure has occurred when performing data transfers, this may not be a fault in the media. It could be that a RTD is writing data to the media out of specification. Patterns of failures are therefore important. As an example, lots of DATA CHECK conditions suddenly occurring lots of drives and volumes.


	Deduplication	Indicates if the MVC is deduplicated.
	Drain	Indicates if the MVC is currently the subject of drain or reclaim processing. Should the processing fail, the MVC may be left in this state as a safeguard. To clear this condition, perform a MVCDRain against the MVC.
	Eject	Indicates if the MVC has been ejected.
	Export	Indicates if the MVC is an export MVC.
	Full	Indicates if there is no space available on the MVC.
	Invalid MIR	Indicates if VTCS has received status from an RTD to indicate the MIR (media information record) for a 9x40 media is invalid. An invalid MIR does not prevent access to data but may cause significant performance problems while accessing records on the tape. The MVC is not capable of high-speed searches on areas of the tape that do not have a valid MIR entry.
VTCS attempts to depreference MVCs with this condition. For recalls, if the VTV resides on multiple MVCs, VTCS selects MVCs with valid MIRs ahead of MVCs with invalid MIRs. VTCS avoids using MVCs with invalid MIRs for migration, unless the migration is at the beginning of the tape. Migrating from the beginning of tape corrects the MIR. VTCS detects the invalid MIR condition at either mount time or dismount time. If detected at mount time and the operation can be completed with another MVC, VTCS dismounts the first MVC and selects the alternate MVC.

VTCS has only a limited ability to switch to an alternate MVC. That is, it is mainly used for migrate and virtual mount. For MVCs with invalid MIRs, determine the cause of the error, which may be caused by media or drive problems, and fix the error. To recover an MVC with an invalid MIR, read the MVC to the end of the tape with a VTCS audit. If the media is the problem, run an MVCDRAIN EJECT to recall the VTVs and cause the MVC to be removed from the MVC pool.


	Lost	Indicates if VTCS attempted to mount an MVC and the mount did not complete within a 15-minute time out period. VTCS has had no specific error report although there could be combination of hardware problems, HSC problems, or by the MVC being removed from the ACS. VTCS attempts to depreference the usage of MVCs with this state. Determine the cause of the error and fix it.
You can also use the VTCS MVCMAINT utility to set LOST(OFF) for the following events:

LOST(ON) was set due to LSM failures or drive errors that have been resolved.

LOST(ON) was set because the MVC was outside the ACS and has been reentered.

This condition is automatically cleared by VTCS if it subsequently requests a mount of the MVC and this is successful.


	Maximum VTV	Indicates if the MVC has reached the maximum number of VTVs.
	Mounted	Indicates if the MVC is mounted on an RTD.
	Protected	Indicates if the MVC is protected.
	Read-only	Indicates if the MVC has been marked read-only:
If this is due to the MVC being the target of an export or consolidation process, the read-only state protects the MVC from further updates.

If the MVC media is set to file protect, correct the error and use the MVCMAINT utility to set READONLY(OFF).If the MVC does not have the appropriate SAF rules set to enable VTCS to update the MVC, correct the error and use the MVCMAINT utility to set READONLY(OFF).


	Retired	Indicates if the MVC is retired and is considered by VTCS as having reached the end of its useful life. VTCS recalls from, but does not migrate to, the MVC. Replace the MVC as soon as possible. Once this has been done, use the MVCMAINT utility to set RETIRED(OFF).
	Usable	Indicates if the MVC can be used for migration.
	Warranty Expired	Indicates if the MVC's warranty has expired. VTCS continues to use the MVC but you should start making plans to replace the MVC when it reaches Retired state.
	Last Verified	The date and time the last VTV media verify was performed to the MVC. This date reflects the last time that VTCS knew the MVC contents were valid.
	ACS	The ACD ID where the MVC resides.
	VLE	The VLE where the MVC resides.
	Consolidated Date	For a consolidation MVC, the date and time of the consolidation.
	EOT Block ID	The end-of-tape block ID.
	EOT Partition ID	The end-of-tape partition ID.
	Block ID First Space	The block ID of the first space on the MVC.
	Refreshed	The date and UTC time the data was stored or last updated.






Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden/visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Remove Pane icon]
	Selected Row Data	Show data for selected rows
	[image: Remove Pane icon]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Remove Pane icon]
	Print	Display as a printable page
	[image: Remove Pane icon]
	Filter	See "Using Filters"
	[image: Remove Pane icon]
	Reset Filter	Reset the data filter
	[image: Pane Information icon]
	Refresh	Refresh with data from the VSM GUI database
	[image: Detach Pane icon]
	Detach	Display in a separate window
	[image: Filter Data icon]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










VTVs on MVC

This data table displays a list of all VTVs in the MVC that was selected in the "Multi-Volume Cartridges (MVCs)" data table.

You may need to scroll horizontally or detach the table to view all columns.

[image: Surrounding text describes vsmgu014b_mvcvtvs.png.]

Click a row to display MVCs for that VTV in the "MVCs Containing VTV"data table.

The status for some fields is summarized with a status indicator:


	Icon	Name	Description
	[image: Surrounding text describes good.jpg.]
	Good	Indicates no threshold violations are detected
	[image: Surrounding text describes caution.jpg.]
	Caution	Indicates warning thresholds have been exceeded
	[image: Surrounding text describes critical.jpg.]
	Critical	Indicates critical thresholds have been exceeded
	[image: Surrounding text describes unknown.jpg.]
	Unknown	Indicates status could not be detected






Click a status indicator to display its details.

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

Fields with a context menu indicator can initiate Management commands on specific data items. Right click a field to display the context menu and select the desired menu item.

You can also filter data for individual data columns to further isolate specific information. See "Using Filters" for information about this feature.

Table columns and descriptions include:


	Column	Description
	Tapeplex	The name of the tapeplex the VTV belongs to.
	VTV Volser	The volume serial number of the VTV.
Context menu: Reconcile VTV.


	Management Class	The name of the Management Class for the VTV.
	VTSS	The VTSS where the VTV resides. If the VTV is migrated, the VTSS where the VTSS was last resident. If this field is empty, the VTV is non-existent (not created or used, scratched, and deleted) or has been manually imported.
	Uncompressed Size (MB)	The uncompressed size of the VTV in megabytes. This is the size of the VTV as perceived by the application programs.
	Compressed Size (MB)	The compressed size of the VTV in megabytes. This is the raw space that will be occupied on the MVCs or within the VTSSs.
	Compression Percentage	The VTV compression percentage achieved. This is the difference between the uncompressed and compressed VTV size, expressed as a percentage of the uncompressed VTV size. A compression of zero per cent indicates that no compression was possible on the VTV.
	Maximum VTV Size (MB)	The maximum (compressed) size of VTVs in megabytes (400, 800, 2000 or 4000).
	VTV Page Size	The VTV page size, large or standard.
	Last Mounted	The date and time when the VTV content was last mounted for access by an application.
	Last Recall	The date and time when the VTV was last recalled back from a MVC into a VTSS.
	Last Used	The date and time when the VTV was last touched by VTCS. This includes most functions that update the status of the VTV, including VTV mount, migrate, recall, or scratch.
	Created	The date and time when the VTV contents were last changed by an application.
	Times Read	The number of times the VTV has been read.
	Copies to Migrate	The number of migration copies of the VTV.
	Replication	Indicates the VTV's replication status:
NOT REPLICATED: This VTV has not been replicated.

REPLICATION REQUIRED: This VTV should be replicated and is currently queued for processing.

REPLICATION STARTED: Replication is active for this VTV but not yet complete.

REPLICATED: The VTV has been replicated to the VTSS identified in the Replica VTSS column.


	Replica VTSS	The VTSS where the replica VTV resides.
	Owning Tapeplex	The name of the tapeplex where the replica VTV resides.
	Electronic Export	Indicates electronic export status:
EXPORT-NOT POSSIBLE: Export of this VTV to a remote tapeplex was attempted and the request was rejected. Typically, this is due to a different copy of the VTV residing in the remote tapeplex.

EXPORT-REJECTED: Electronic export was actively rejected. This could be due to the target tapeplex not allowing import of the VTV, or a clash with copy status.

EXPORT-REQUIRED: This VTV should be electronically exported and is currently queued for processing.

EXPORT-STARTED: Electronic export is active for this VTV, but not yet complete.


	Initialized	Indicates if the VTV has been initialized. If VTCS has used the VTV at least once, it is initialized. VTVs that are defined with the CONFIG utility but have never been used by VTCS are not initialized.
	Avoid Early Mount	Indicates if concurrent recall or mount encountered an error with this VTV. If so, no further concurrent recall or mount activity is attempted for this VTV.
	Consolidated	Indicates if VSM has consolidated the VTV.
	Fenced	Indicates if VSM has fenced the VTV.
	Imported	Indicates if VSM has imported the VTV from another tapeplex. Imported VTVs cannot be modified or used for scratch mounts.
	Migrated	Indicates if VSM has migrated the VTV.
	Migration Pending	Indicates if VTV migration is pending. This status is displayed when a VTV is initially created, or when the VTV requires reconciling or archiving. In these latter cases, individual MVC copies may indicate Reconcile or Deletion.
	Mounted	Indicates if the VTV is currently mounted.
	New Create	Indicates if the VTV is newly created.
	Resident	Indicates if the VTV is resident on the VTSS.
	Scratch	Indicates if the VTV is a scratch volume.
	Refresh	The last refresh date and time.






Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden/visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Remove Pane icon]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	See "Using Filters"
	[image: Surrounding text describes filterx.png.]
	Reset Filter	Reset the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard









MVC States

This graph shows MVC counts for each tapeplex, with current state summarized as Warning, Critical, or Good.

[image: Surrounding text describes vsmgu014c_mvcstates.png.]


Warning includes MVCs with one or more of the following states: Audit, Drain, Max VTV, or Warranty Expired.

Critical includes MVCs with one or more of the following states: Not usable, Broken, Data_Check, Invalid MIR, Lost, or Retired.

Good includes MVCs with none of the above states.

Hover on an object to display summary data for the object.

Hover on a label to highlight related objects on the graph.

Click an object to filter the data table by that object.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes verticalbargraph.jpg.]
	Vertical bar graph	Display the graph as a vertical bar chart
	[image: Surrounding text describes horizontalbargraph.jpg.]
	Horizontal bar graph	Display the graph as a horizontal bar chart
	[image: Surrounding text describes stackbargraph.jpg.]
	Stacked bar graph	Display the graph as a stacked bar chart
	[image: Surrounding text describes piechart.jpg.]
	Pie chart	Display the graph as a pie chart
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard









MVC Space Usage

This graph shows MVC space usage counts, sorted by usage type and percentage range.

[image: Surrounding text describes vsmgu014d_mvcspaceuse.png.]

Hover on an object to display summary data for the object.

Hover on a label to highlight related objects on the graph.

Click an object to filter the data table by that object.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes verticalbargraph.jpg.]
	Vertical bar graph	Display the graph as a vertical bar chart
	[image: Surrounding text describes horizontalbargraph.jpg.]
	Horizontal bar graph	Display the graph as a horizontal bar chart
	[image: Surrounding text describes stackbargraph.jpg.]
	Stacked bar graph	Display the graph as a stacked bar chart
	[image: Surrounding text describes piechart.jpg.]
	Pie chart	Display the graph as a pie chart
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Pane Information icon]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard
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Display MVC Pool

This pane displays Multi-Volume Cartridge Pool information.

To display, select Display and MVC Pool on the navigation tree.

[image: Surrounding text describes vsmgu015_mvcpool.png.]



Multi-Volume Cartridge (MVC) Pools

This data table shows MVC Pool information.

You may need to scroll horizontally or detach the table to view all columns.

[image: Surrounding text describes vsmgu015a_mvcpooltable.png.]

Click a row to display MVCs for that MVC Pool in the "MVCs in MVC Pool"data table.

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

Fields with a context menu indicator can initiate Management commands on specific data items. Right click a field to display the context menu and select the desired menu item.

You can also filter data for individual data columns to further isolate specific information. See "Using Filters" for information about this feature.

Table columns and descriptions include:


	Column	Description
	Tapeplex	The tapeplex the MVC Pool belongs to.
	MVC Pool	The MVC Pool name.
Context menu: MVC Drain, Reclaim.


	Initialize MVC	Indicates if un-initialized MVCs are to be initialized when first mounted.
	Minimum Free MVCs	The minimum number of free MVCs.
	Reclaim Threshold Percentage	The fragmented space threshold (as a percentage) that determines when an MVC is eligible for demand or automatic reclamation.
	MVC Pool Inplace Threshold Percentage	The fragmented space threshold (as a percentage) that determines when an MVC in partitioned format is eligible for dynamic reclaim processing.
	Reclaim Max MVC	The MVC limit for a single reclaim.
	Reclaim Start	The percentage of reclaim candidates to total MVCs that trigger automatic reclaim.
	Space Reclaim	The space reclamation setting.
	Total MVCs	The number of MVCs in the MVC Pool.
	Free MVCs	The total number of free MVCs in the MVS Pool.
	Standard MVCs	The number of initialized standard MVCs. in the MVC Pool.
	Partitioned MVCs	The number of initialized partitioned MVCs in the MVC Pool.
	Un-initiated MVCs	The number of un-initialized MVCs in the MVC Pool.
	Audit MVCs	The number of MVCs with status AUDIT.
	Broken MVCs	The number of MVCs with status BROKE.
	Consolidated MVCs	The number of MVCs with status CONSOLIDATE.
	Data Check MVCs	The number of MVCs with data checks.
	Drain MVCs	The number of MVCs with status DRAIN.
	Ejected MVCs	The number of MVCs with status EJECTED.
	Export MVCs	The number of MVCs with status EXPORT
	Full MVCs	The number of MVCs marked FULL.
	Invalid MIR MVCs	The number of MVCs with Invalid MIRs
	Lost MVCs	The number of MVCs with status LOST.
	Max VTV MVCs	The number of MVCs with maximum VTVs.
	Read-only MVCs	The number of MVCs marked Read-Only.
	Retired MVCs	The number of MVCs marked RETIRED.
	Usable MVCs	The number of usable MVCs.
	Warranty Expired MVCs	The number of MVCs with expired warranty.
	Refreshed	The date and UTC time the data was stored or last updated.






Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden/visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	See "Using Filters"
	[image: Surrounding text describes filterx.png.]
	Reset Filter	Reset the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










MVCs in MVC Pool

This data table displays a list of all MVCs in the MVC Pool that was selected in the "Multi-Volume Cartridge (MVC) Pools" data table.

You may need to scroll horizontally or detach the table to view all columns.

[image: Surrounding text describes vsmgu015b_mvcsinpool.png.]

Click a row to display VTVs for that MVC in the "VTVs on MVC" data table.

The status for some fields is summarized with a status indicator:


	Icon	Name	Description
	[image: Surrounding text describes good.jpg.]
	Good	Indicates no threshold violations are detected
	[image: Surrounding text describes caution.jpg.]
	Caution	Indicates warning thresholds have been exceeded
	[image: Surrounding text describes critical.jpg.]
	Critical	Indicates critical thresholds have been exceeded
	[image: Surrounding text describes unknown.jpg.]
	Unknown	Indicates status could not be detected






Click a status indicator to display its details.

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

Fields with a context menu indicator can initiate Management commands on specific data items. Right click a field to display the context menu and select the desired menu item.

You can also filter data for individual data columns to further isolate specific information. See "Using Filters" for information about this feature.

Table columns and descriptions include:


	Column	Description
	Tapeplex	The tapeplex the MVC belongs to.
	MVC Volser	The volser of the MVC.
Context menu: Audit MVC Volser, MVC Drain, Reclaim, Reconcile.


	Media	The volume media type or recording technique.
If Need PTF is displayed, then this host lacks support for this media type, but another host does have support for this media type.


	Media Size (MB)	The size of the MVC in megabytes.
	Storage Class	The Storage Class that owns the MVC. MVCs only become a member of a storage class when they contain migrated VTVs.
Context menu: MVC Drain, Reclaim, Reconcile


	MVC Pool	The name of the MVC Pool the MVC is in.
Context menu: MVC Drain, Reclaim.


	Number of VTVs Migrated	The number of current VTVs migrated to this MVC.
	VTV Count	The number of active VTVs on the MVC.
	Used Percentage	The percentage of the MVC used by current VTVs.
	Fragmented Percentage	The percentage of the MVC that contains noncurrent VTVs. This space is not available for use until it is reclaimed or the MVC is drained.
	Available Percentage	The percentage of the MVC that is physically available for use.
	Usable Percentage	The percentage of space on the MVC that can be used by VTCS. This may be zero even if there is still space physically available. For instance, if the VTV per MVC limit is reached then the usable percentage is reported as zero. Similarly, if an error has been reported against an MVC, VTCS does not use this MVC for output and the usable percentage is reported as zero.
	Times Mounted	The number of times the MVC has been mounted for writing or reading since it was added to the MVC inventory.
	Last Mounted	The date and time at which the MVC was mounted or attempted to be mounted on a RTD.
	Last Migration	The date and time at which the last VTV migration was performed to the MVC.
	Last Drain/Reclaim	The date and time at which the MVC was last processed by Drain or Reclaim processing and its end-of-tape pointer was reset.
	VTSS Last Mounted	The name of the last VTSS that performed a migration to the MVC.
Context menu: Audit VTSS, Vary VTSS.


	Initialized	Indicates the MVC's initialization status, either standard, partitioned, or not initialized.
	Audit	Indicates if the MVC is either currently being audited or has been the subject of a failed audit. While in this state the MVC is not used for migration but can be used for recalls. Due to the inherent state, recalls may fail because the CDS is not yet up-to-date with the MVC contents. To clear this condition, rerun the audit against this MVC.
	Broken	Indicates if the MVC, drive, or combination of the two has a problem. VTCS attempts to depreference MVCs with this state. If the MVC caused the problem, use a DRAIN(EJECT) command to remove the MVC from service. If the RTD caused the problem, use the MVCMAINT utility to reset the MVC state.
	Consolidation	Indicates if the MVC is consolidation MVC.
	Data Check	A data check condition has been reported against this MVC. VTCS attempts to depreference the usage of MVCs with this state. To get into this state, a data transfer must have failed upon two different RTDs.
To clear this state:

If all VTVs on the MVC are duplexed, use MVC Drain on the MVC without the Eject option. This recovers all VTVs and removes the MVC from service.

If all VTVs on the MVC are not duplexed, VTCS AUDIT the MVC. The audit may fail. After the audit, do an MVCDRAIN (no eject). This recalls the VTVs before the data-check area in ascending block-id order and the VTVs after the data-check area in a descending block-id order. Processing the VTVs in this sequence ensures that VTCS recovers as many VTVs as possible from the media. You then need to recreate the data for any VTVs still on the MVC.

Although this indicates that a specific failure has occurred when performing data transfers, this may not be a fault in the media. It could be that a RTD is writing data to the media out of specification. Patterns of failures are therefore important. As an example, lots of DATA CHECK conditions suddenly occurring lots of drives and volumes.


	Deduplication	Indicates if the MVC is deduplicated.
	Drain	Indicates if the MVC is currently the subject of drain or reclaim processing. Should the processing fail, the MVC may be left in this state as a safeguard. To clear this condition, perform a MVCDRain against the MVC.
	Eject	Indicates if the MVC has been ejected.
	Export	Indicates if the MVC is an export MVC.
	Full	Indicates if there is no space available on the MVC.
	Invalid MIR	Indicates if VTCS has received status from an RTD to indicate the MIR (media information record) for a 9x40 media is invalid. An invalid MIR does not prevent access to data but may cause significant performance problems while accessing records on the tape. The MVC is not capable of high-speed searches on areas of the tape that do not have a valid MIR entry.
VTCS attempts to depreference MVCs with this condition. For recalls, if the VTV resides on multiple MVCs, VTCS selects MVCs with valid MIRs ahead of MVCs with invalid MIRs. VTCS avoids using MVCs with invalid MIRs for migration, unless the migration is at the beginning of the tape. Migrating from the beginning of tape corrects the MIR. VTCS detects the invalid MIR condition at either mount time or dismount time. If detected at mount time and the operation can be completed with another MVC, VTCS dismounts the first MVC and selects the alternate MVC.

VTCS has only a limited ability to switch to an alternate MVC. That is, it is mainly used for migrate and virtual mount. For MVCs with invalid MIRs, determine the cause of the error, which may be caused by media or drive problems, and fix the error. To recover an MVC with an invalid MIR, read the MVC to the end of the tape, with a VTCS audit. If the media is the problem, run an MVCDRAIN EJECT to recall the VTVs and cause the MVC to be removed from the MVC pool.


	Lost	Indicates if VTCS attempted to mount an MVC and the mount did not complete within a 15-minute time out period. VTCS has had no specific error report although there could be combination of hardware problems, HSC problems, or by the MVC being removed from the ACS. VTCS attempts to depreference the usage of MVCs with this state. Determine the cause of the error and fix it.
You can also use the VTCS MVCMAINT utility to set LOST(OFF) for the following events:

LOST(ON) was set due to LSM failures or drive errors that have been resolved.

LOST(ON) was set because the MVC was outside the ACS and has been reentered.

This condition is automatically cleared by VTCS if it subsequently requests a mount of the MVC and this is successful.


	Maximum VTV	Indicates if the MVC has reached the maximum number of VTVs.
	Mounted	Indicates if the MVC is mounted on an RTD.
	Protected	Indicates if the MVC is protected.
	Read-only	Indicates if the MVC has been marked read-only:
If this is due to the MVC being the target of an export or consolidation process, the read-only state protects the MVC from further updates.

If the MVC media is set to file protect, correct the error and use the MVCMAINT utility to set READONLY(OFF).If the MVC does not have the appropriate SAF rules set to enable VTCS to update the MVC, correct the error and use the MVCMAINT utility to set READONLY(OFF).


	Retired	Indicates if the MVC is retired and is considered by VTCS as having reached the end of its useful life. VTCS recalls from, but does not migrate to, the MVC. Replace the MVC as soon as possible. Once this has been done, use the MVCMAINT utility to set RETIRED(OFF).
	Usable	Indicates if the MVC can be used for migration.
	Warranty Expired	Indicates if the MVC's warranty has expired. VTCS continues to use the MVC but you should start making plans to replace the MVC when it reaches Retired state.
	Last Verified	The date and time the last VTV media verify was performed to the MVC. This date reflects the last time that VTCS knew the MVC contents were valid.
	ACS	The ACD ID where the MVC resides.
	VLE	The VLE where the MVC resides.
	Consolidated Date	For a consolidation MVC, the date and time of the consolidation.
	EOT Block ID	The end-of-tape block ID.
	EOT Partition ID	The end-of-tape partition ID.
	Block ID First Space	The block ID of the first space on the MVC.
	Refreshed	The date and UTC time the data was stored or last updated.






Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden/visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	See "Using Filters"
	[image: Surrounding text describes filterx.png.]
	Reset Filter	Reset the data filter
	[image: Pane Information icon]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard









MVC States in MVC Pool

This graph shows the number of MVCs in the selected MVC Pool, sorted by current MVC state.

[image: Surrounding text describes vsmgu015c_mvcstates.png.]

Hover on an object to display summary data for the object.

Hover on a label to highlight related objects on the graph.

Click an object to filter the data table by that object.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes verticalbargraph.jpg.]
	Vertical bar graph	Display the graph as a vertical bar chart
	[image: Surrounding text describes horizontalbargraph.jpg.]
	Horizontal bar graph	Display the graph as a horizontal bar chart
	[image: Surrounding text describes stackbargraph.jpg.]
	Stacked bar graph	Display the graph as a stacked bar chart
	[image: Surrounding text describes piechart.jpg.]
	Pie chart	Display the graph as a pie chart
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard









Volumes in MVC Pool

This graph shows the number of MVCs in the selected MVC Pool, sorted by current usage state.

[image: Surrounding text describes vsmgu015d_mvcpoolvols.png.]

Hover on an object to display summary data for the object.

Hover on a label to highlight related objects on the graph.

Click a graph icon to change the graph display type.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes verticalbargraph.jpg.]
	Vertical bar graph	Display the graph as a vertical bar chart
	[image: Surrounding text describes horizontalbargraph.jpg.]
	Horizontal bar graph	Display the graph as a horizontal bar chart
	[image: Surrounding text describes stackbargraph.jpg.]
	Stacked bar graph	Display the graph as a stacked bar chart
	[image: Surrounding text describes piechart.jpg.]
	Pie chart	Display the graph as a pie chart
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard









Sizes in MVC Pool

This graph shows the size of MVCs in the selected MVC Pool, sorted by current usage state.

[image: Surrounding text describes vsmgu015e_mvcpoolsizes.png.]

Hover on an object to display summary data for the object.

Hover on a label to highlight related objects on the graph.

Click an object to filter the data table by that object.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes verticalbargraph.jpg.]
	Vertical bar graph	Display the graph as a vertical bar chart
	[image: Surrounding text describes horizontalbargraph.jpg.]
	Horizontal bar graph	Display the graph as a horizontal bar chart
	[image: Surrounding text describes stackbargraph.jpg.]
	Stacked bar graph	Display the graph as a stacked bar chart
	[image: Surrounding text describes piechart.jpg.]
	Pie chart	Display the graph as a pie chart
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard
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Display VLE

This pane displays Virtual Library Extension (VLE) information.

To display, select Display and VLE on the navigation tree.

[image: Surrounding text describes vsmgu016_vle.png.]



Virtual Library Extension (VLE)

This data table shows VLE information.

You may need to scroll horizontally or detach the table to view all columns.

[image: Surrounding text describes vsmgu016a_vletable.png.]

Click a row to display vRTDs for that VLE in the "Drives (vRTDs) for VLE" data table.

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

You can also filter data for individual data columns to further isolate specific information. See "Using Filters" for information about this feature.

Table columns and descriptions include:


	Column	Description
	Tapeplex	The tapeplex name.
	VLE	The VLE name.
	Status	The VLE status.
	VLE Version	The VLE version.
	Autonomous Devices	Indicates if the VLE has the autonomous devices feature.
	Version 2 API	Indicates if the VLE has the Version 2 API feature.
	Deduplication	Indicates if the VLE has the deduplication feature.
	Mount/Recall	Indicates if the VLE has the mount/recall feature.
	Refreshed	The date and UTC time the data was stored or last updated.






Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden/visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	See "Using Filters"
	[image: Surrounding text describes filterx.png.]
	Reset Filter	Reset the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Filter Data icon]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










Drives (vRTDs) for VLE

This data table displays a list of all vRTDs in the VLE that was selected in the "Virtual Library Extension (VLE)" data table.

You may need to scroll horizontally or detach the table to view all columns.

[image: Surrounding text describes vsmgu016b_vlevrtds.png.]

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

Fields with a context menu indicator can initiate Management commands on specific data items. Right click a field to display the context menu and select the desired menu item.

You can also filter data for individual data columns to further isolate specific information. See "Using Filters" for information about this feature.

Table columns and descriptions include:


	Column	Description
	Device Address	The vRTD address.
	Device Type	The device type of the vRTD. For VLE, the device type is VL.
	MVC Allocated	The volser of the MVC allocated for mounting on the vRTD.
	MVC Mounted	The MVC that is currently mounted on the vRTD.
	MVS Host	The host that currently owns the vRTD.
	Owner VTSS	The VTSS that is currently connected to the vRTD.
	Status	One of the following vRTD statuses:
RECOVER RTD: The vRTD is being reset after a problem, a vary, or an initialization.

MIGRATE VTV: The vRTD is migrating a VTV.

RECALL VTV: The vRTD is recalling a VTV.

UNLOAD MVC: A forced unload of the vRTD is occurring.

VTV TRANSFER: The vRTD is migrating a VTV before recalling it on another VTSS.

AUDIT MVC: An MVC is being audited.

BUSY: The vRTD is busy (non-specific task).

IDLE: An MVC is allocated to the vRTD but the MVC is not being used.

ONLINE/FREE: The vRTD is online and available.

MAINTENANCE: The vRTD is in maintenance mode.

OFFLINE: The vRTD is offline and unavailable to all hosts and VTSSs

RECOVERY: The vRTD is being reset following an error or a vary online mode.

INITIALIZE: The host is verifying vRTD status and availability.

SUSPEND: The vRTD operations are suspended. This occurs when one or more vRTDs and a CLINK are configured on the same port. The vRTDs remain in SUSPEND mode while the CLINK is online.

PATH OFFLINE: The vRTD status is unknown because the VTSS cannot contact the vRTD or if the paths were not correctly configured.

PATH SUSPEND: The vRTD is globally online but the path from the VTSS is suspended due to the vRTD being paired with a Clink.

FAIL/OFFLINE: The vRTD was placed offline due to a failure.

TOP ID: The process Id of the request that is top of the queue for next using this vRTD from this host. The TOP ID column only applies for requests from the host upon which the command has been executed. This host may not have the top claim upon the vRTD.

TOP HOST: The host which has the request that is top of the queue for next using this vRTD. The TOP HOST indicates which host has the top claim upon the vRTD.


	MVC Volser	The volser of the MVC currently mounted on the vRTD or allocated to the vRTD for mounting.
	Internal Device Type	The internal coding of the device type.
	Requests Queued	The number of requests that are currently queued.
	Allocation Time Remaining (mins)	The allocation time remaining, in minutes.
	Local Wait Time (mins)	The local wait time, in minutes.
	Serial Number	The serial number of the vRTD.
	Refreshed	The date and UTC time the data was stored or last updated.






Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden/visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	See "Using Filters"
	[image: Surrounding text describes filterx.png.]
	Reset Filter	Reset the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










Display VTD






Display VTD

This pane displays Virtual Tape Drive (VTD) information.

To display, select Display and VTD on the navigation tree.

[image: Surrounding text describes vsmgu017a_vtd.png.]


Virtual Tape Drives (VTDs)

This data table shows VTD information.

You may need to scroll horizontally or detach the table to view all columns.

[image: Surrounding text describes vsmgu017_vtd.png.]

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

Fields with a context menu indicator can initiate Management commands on specific data items. Right click a field to display the context menu and select the desired menu item.

You can also filter data for individual data columns to further isolate specific information. See "Using Filters" for information about this feature.

Table columns and descriptions include:


	Column	Description
	Tapeplex	The tapeplex the VTD is in.
	VTSS	The VTSS the VTD is in.
Context menu: Audit VTSS, Vary VTSS.


	VTD ID	The VTD ID.
	VTV Volser	The volser of the VTD currently mounted on or allocated to the VTD.
	Refreshed	The date and UTC time the data was stored or last updated.






Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden/visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	See "Using Filters"
	[image: Surrounding text describes filterx.png.]
	Reset Filter	Reset the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard









Hosts for VTD

This data table shows the selected VTD's host system, device address, status and usage.

You may need to scroll horizontally or detach the table to view all columns.

[image: Surrounding text describes vsmgu017d_vtd.png.]

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

Fields with a context menu indicator can initiate Management commands on specific data items. Right click a field to display the context menu and select the desired menu item.

You can also filter data for individual data columns to further isolate specific information. See "Using Filters" for information about this feature.

Table columns and descriptions include:


	Column	Description
	MVS Host	The name of the MVS host that owns the DVD.
	Device Address	The MVS device address of the VTD. If the device has not been defined to this host in the CONFIG, then this will contain physical address within the VTSS prefixed by '##'.
	Status	One of the following:
Available: The VTD is available for work.

Dismounting: The VTV volser shown in the VTV column is was mounted on the VTD and the VTD has been unloaded. VTCS either has not received the dismount request or is currently in the progress of synchronizing the VTV and CDS information.

Imported: The VTV volser shown in the VTV column has been electronically imported with the VTD. It is awaiting the confirmation request from the host that performed the export.

Importing: The VTV volser shown in the VTV column is being electronically imported with the VTD.

Mounted: The VTV volser shown in the VTV column is mounted on the VTD.

Mounting: The VTV volser shown in the VTV column is in the process of being mounted on the VTD. Typically, this indicates that an auto recall is in progress.

Mount(other): The VTV volser shown in the VTV column is mounted on the VTD. The mount was not performed by the host on which the command was executed.

Not Available: The VTD is not available for work.

Redrive Later: A previous attempt to mount the VTV volser shown in the VTV column upon the VTD failed. It will be interpreted again within the next few minutes.

Replicating: The VTV volser shown in the VTV column is in the process of being replicated.

Undefined: The VTV volser shown in the VTV column is undefined.

Unknown: The VTV volser shown in the VTV column is unknown.


	Usage	One of the following:
Configuring: Configuration of the VTD is in progress.

ECAM init error: Unable to initialise VTD through ECAM-t with VTSS.

ECAM I/O error: ECAM-t I/O has failed on this VTD.

ECAM only: The VTD is one of the VTDs connected to another VTSS for the process of replicating VTVs.

Not accessed: The VTD is not found in the VTSS configuration.

Not verified: The VTD is defined with NOVERIFY in the configuration.


	Client Address	The address of the drive as reported by the client that last performed a mount on the VTD.






Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden/visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	See "Using Filters"
	[image: Surrounding text describes filterx.png.]
	Reset Filter	Reset the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard









VTD Status

This graph shows VTD status for the tapeplex and for the host. The graph is color-coded to indicate the number of VTDs that are unknown, unverified, replicating, redrive late, not available, imported, dismounting, mounted, and available.

[image: Surrounding text describes vsmgu017b_vtd.png.]

Hover on an object to display summary data for the object.

Hover on a label to highlight related objects on the graph.

Click an object to filter the data table by that object.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes verticalbargraph.jpg.]
	Vertical bar graph	Display the graph as a vertical bar chart
	[image: Surrounding text describes horizontalbargraph.jpg.]
	Horizontal bar graph	Display the graph as a horizontal bar chart
	[image: Surrounding text describes stackbargraph.jpg.]
	Stacked bar graph	Display the graph as a stacked bar chart
	[image: Surrounding text describes piechart.jpg.]
	Pie chart	Display the graph as a pie chart
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard









VTD Usage

This graph shows VTD usage for the tapeplex and for the host. The graph is color-coded to indicate the number of VTDs that are not verified, not accessed, ECAM only, ECAM I/O error, ECAM init error, and configuring.

[image: Surrounding text describes vsmgu017c_vtd.png.]

Hover on an object to display summary data for the object.

Hover on a label to highlight related objects on the graph.

Click an object to filter the data table by that object.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes verticalbargraph.jpg.]
	Vertical bar graph	Display the graph as a vertical bar chart
	[image: Surrounding text describes horizontalbargraph.jpg.]
	Horizontal bar graph	Display the graph as a horizontal bar chart
	[image: Surrounding text describes stackbargraph.jpg.]
	Stacked bar graph	Display the graph as a stacked bar chart
	[image: Surrounding text describes piechart.jpg.]
	Pie chart	Display the graph as a pie chart
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










Display VTSS






Display VTSS

This pane displays Virtual Tape Storage Subsystem (VTSS) information.

To display, select Display and VTSS on the navigation tree.

[image: Surrounding text describes vsmgu018_vtss.png.]



Virtual Tape Storage Subsystem (VTSS)

This data table shows VTSS information.

You may need to scroll horizontally or detach the table to view all columns.

[image: Surrounding text describes vsmgu018a_vtsstable.png.]

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

Fields with a context menu indicator can initiate Management commands on specific data items. Right click a field to display the context menu and select the desired menu item.

You can also filter data for individual data columns to further isolate specific information. See "Using Filters" for information about this feature.

Table columns and descriptions include:


	Column	Description
	Tapeplex	The tapeplex the VTSS belongs to.
	VTSS	The name of the VTSS.
Context menu: Audit VTSS, Vary VTSS.


	Status	One of the following global VTSS states for all hosts:
QUIESCING: Quiescing state.

QUIESCED: Quiesced state.

OFFLINE: Offline state.

OFFLINE-P: Offline pending state.

ONLINE: Online state.

ONLINE-P: Online pending state.

STARTED: The VTSS is initialized and in process of going to the requested state (online, offline, or quiesced).


	Capacity (MB)	The capacity of the VTSS in megabytes.
	DBU Percentage	The percentage of disk buffer used of the total disk buffer capacity.
	High AMT	The high auto-migrate threshold.
	Low AMT	The low auto-migrate threshold.
	VTV Count	The number of VTVs resident in the VTSS.
	Maximum Migrate Tasks	The maximum number of auto-migrate tasks for the VTSS.
	Minimum Migrate Tasks	The minimum number of auto-migrate tasks for the VTSS.
	Default ACS	The configured default ACS ID for the VTSS.
	Auto-Host	The host system performing the auto-migration.
	Auto-migrate Threshold	The current auto-migration threshold for the VTSS.
	RTD Count	The number of RTDs attached to the VTSS.
	Model	The VTSS model (VSM2, VSM3, VSM4, VSM5, VSM 6, or unknown).
	Maximum VTV Size (MB)	The maximum size of VTVs in megabytes.
	VTV Page Size	The VTV page size, either Standard or Large.
	RTC Data Verify	Indicates if RTC data is verified.
	Connectivity	The Connectivity type, either CHANNEL or ECAM-T protocol.
	Serial Number	The serial number of the VTSS.
	Refreshed	The date and UTC time the data was stored or last updated.






Click a row in the data table to display, for that VTSS, the following data tables:

"CLINKs for VTSS"

"Clusters for VTSS"

"Drive Paths for VTSS"

"Features for VTSS"

"Hosts for VTSS"

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden/visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	See "Using Filters"
	[image: Surrounding text describes filterx.png.]
	Reset Filter	Reset the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










CLINKs for VTSS

This data table displays a list of all CLINKs for the VTSS that was selected in the Virtual Tape Storage Subsystem (VTSS) data table.

If the table is not visible, click the arrows left or right of the displayed tabs and select the table.

You may need to scroll horizontally or detach the table to view all columns.

[image: Surrounding text describes vsmgu018b_vtssclinks.png.]

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

Fields with a context menu indicator can initiate Management commands on specific data items. Right click a field to display the context menu and select the desired menu item.

You can also filter data for individual data columns to further isolate specific information. See "Using Filters" for information about this feature.

Table columns and descriptions include:


	Column	Description
	Partner Tapeplex	The partner tapeplex in the cluster.
	Partner VTSS	The secondary or receiving VTSS in the cluster.
	CLINK ID	The CLINK ID that has been assigned to the CLINK within the VTSS
	Channel ID	The back-end channel interface to which the CLINK is connected.
	IPIF ID	The IPIF ID of the CLINK
	Cluster	The cluster name if the CLINK is used for replication of VTVs within the tapeplex and is part of a cluster. The VTSS name in the Partner VTSS column indicates the other VTSS that operates in the cluster.
	Status	One of the following:
Maint: The link has failed or it has been varied into maintenance mode.

Offline: The link is offline and unavailable to all hosts and VTSSs.

ONLINE: The link is online and available to all hosts and VTSSs.

ON-SYNC: Available for synchronous replication.

ON-ASYNC: Available for asynchronous replication.

P_OFFLINE: The link is pending offline.

P_ONLINE: The link is pending online.

RECOVERY: The link is being reset following an error or a vary online operation.

UNUSABLE: Not available for replication due to hardware errors or assigned-elsewhere conditions.

UUI ERR: This is a CLINK defined for electronic export and it has been unable to contact the remote VTCS. There should be messages in the HSC JOBLOG that indicate the reason for the problem. This could include problems with the definitions, the local SMC, or the remote HTTP server on the remote VTCS.


	Usage	One of the following:
ASSIGNED: Link is assigned to the host in the HOST field but is not currently replicating. This usage occurs when VTCS is starting or terminating link use or is attempting error recovery on the link after a replication failure.

FREE: Link is idle (not doing replications).

REPLICATING: Link is actively doing replications.


	MVS Host	The host that the link is assigned to
	Partner VTD	The address of the VTD on the partner VTSS that forms the other end point to the connection. For a cluster link, the MVS address of the VTD is reported. For an electronic export link, this is not possible as there is no access to the other tapeplex configuration. In this case, only the ordinal number of the VTV is reported.
	Replication Capability	Indicates the CLINK is available for synchronous or asynchronous replication.
	Refreshed	The date and UTC time the data was stored or last updated.






Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden/visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	See "Using Filters"
	[image: Surrounding text describes filterx.png.]
	Reset Filter	Reset the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










Clusters for VTSS

This data table displays a list of all Clusters for the VTSS that was selected in the "Virtual Tape Storage Subsystem (VTSS)" data table.

If the table is not visible, click the arrows left or right of the displayed tabs and select the table.

You may need to scroll horizontally or detach the table to view all columns.

[image: Surrounding text describes vsmgu018c_vtssclusters.png.]

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

Fields with a context menu indicator can initiate Management commands on specific data items. Right click a field to display the context menu and select the desired menu item.

You can also filter data for individual data columns to further isolate specific information. See "Using Filters" for information about this feature.

Table columns and descriptions include:


	Column	Description
	Cluster	The cluster name.
	Direction	The direction of the link between the VTSSs, one of the following:
-----> or <----- indicates the direction of VTV replication in Uni-Directional Cluster. VTVs can only be replicated from the Sending to the Receiving VTSS.

<----> indicates that the VTSSs are configured as a Bi-Directional (Peer-to-Peer) Cluster. VTVs can be replicated from either VTSS to the other.


	Partner VTSS	The partner VTSS in the cluster.
	Mode	One of the following cluster operating modes:
ASYNC-REPLICATE: Both VTSSs in the cluster are online to VTCS. Production workload can go to either VTSS, but for a unidirectional (primary/secondary) cluster, VTVs can only be replicated from the sending VTSS. Synchronous replication is not enabled across the cluster.

SYNC-REPLICATE: Both VTSSs in the cluster are online to VTCS. Production workload can go to either VTSS, but for a unidirectional (primary/secondary) cluster, VTVs can only be replicated from the sending VTSS. Synchronous replication is enabled across the cluster.

DEGRADED: One of the two VTSSs in a bidirectional peer-to-peer cluster is either offline or quiesced. Production workload can go the remaining online VTSS. VTVs requiring replication, however, are allocated to the remaining VTSS only if no other full-function clusters are available and suitable. In this case, replicate VTVs are migrated immediately with keep and queued for replication when the other VTSS comes online. When the other VTSS comes online, VTCS reconciles the contents of both VTSSs.

DEGRADED SECONDARY: The primary is online to VTCS and the secondary is either offline or quiesced. Workload can run on the primary. VTVs requiring replication, however, are allocated to the primary only if no other full-function clusters are available. In this case, replicate VTVs are migrated immediately with keep and are queued for replication, which occurs when the secondary comes online.

DEGRADED PRIMARY: The secondary is online to VTCS and the primary is either offline or quiesced. Workload can run on the secondary. VTVs requiring replication, however, are allocated to the secondary only if no other full-function clusters are available. When the primary comes back online, VTCS reconciles the contents of the primary and secondary.

NON-OPERATIONAL: No workload is possible on this cluster.

CLINKS OFFLINE: All defined CLINKs are offline. No workload is possible on this Cluster.

ONLY SECONDARY: The Secondary is online to VTCS and the Primary has no CLINKs online. Workload can run on the Secondary. VTVs requiring replication, however, are allocated to the Secondary only if no other Full Function Clusters are available.

ONLY PRIMARY: The Primary is online to VTCS and the Secondary has no CLINKs online. Workload can run on the Primary. VTVs requiring replication, however, are allocated to the Primary only if no other Full Function Clusters are available. In this case, Replicate VTVs are migrated immediately with keep and are queued for replication.


	Replication Capability	Indicates the cluster is available for synchronous or asynchronous replication.
	Refreshed	The date and UTC time the data was stored or last updated.






Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden/visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	See "Using Filters"
	[image: Surrounding text describes filterx.png.]
	Reset Filter	Reset the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










Drive Paths for VTSS

This data table displays a list of all drive paths for the VTSS that was selected in the "Virtual Tape Storage Subsystem (VTSS)" data table.

If the table is not visible, click the arrows left or right of the displayed tabs and select the table.

You may need to scroll horizontally or detach the table to view all columns.

[image: Surrounding text describes vsmgu018d_vtssdrivepath.png.]

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

Fields with a context menu indicator can initiate Management commands on specific data items. Right click a field to display the context menu and select the desired menu item.

You can also filter data for individual data columns to further isolate specific information. See "Using Filters" for information about this feature.

Table columns and descriptions include:


	Column	Description
	Path Name	The name allocated to the path.
	VLE	The VLE name.
	Device Address	The device address for the drive.
	Logical Device ID	The logical device ID assigned to the path.
	Channel ID	The CHANIF value that was specified for the path.
	IPIF ID	The IPIF value that was specified for the path.
	Status	One of the following:
ONLINE: The path is online and available for use.

ON-ASYNC: The path is online and available for use for asynchronous replication of VTVs.

ON-SYNC: The path is online and available for use for synchronous replication of VTVs.

OFFLINE: The path or the device to which it connects has been varied offline.

MAINT: The path or the device to which it connects has been varied into an offline maintenance mode. This could be a result of repeated failures.


	Refreshed	The date and UTC time the data was stored or last updated.






Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden/visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	See "Using Filters"
	[image: Surrounding text describes filterx.png.]
	Reset Filter	Reset the data filter
	[image: Pane Information icon]
	Refresh	Refresh with data from the VSM GUI database
	[image: Detach Pane icon]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










Features for VTSS

This data table displays a list of features for the VTSS that was selected in the "Virtual Tape Storage Subsystem (VTSS)" data table.

If the table is not visible, click the arrows left or right of the displayed tabs and select the table.

[image: Surrounding text describes vsmgu018e_vtssfeatures.png.]

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

You can also filter data for individual data columns to further isolate specific information. See "Using Filters" for information about this feature.

Table columns and descriptions include:


	Column	Description
	Feature	The VTSS feature description.
	Refreshed	The date and UTC time the data was stored or last updated.






Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden/visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	See "Using Filters"
	[image: Surrounding text describes filterx.png.]
	Reset Filter	Reset the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










Hosts for VTSS

This data table displays a list of MVS hosts for the VTSS that was selected in the "Virtual Tape Storage Subsystem (VTSS)" data table.

If the table is not visible, click the arrows left or right of the displayed tabs and select the table.

You may need to scroll horizontally or detach the table to view all columns.

[image: Surrounding text describes vsmgu018f_vtsshosts.png.]

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

You can also filter data for individual data columns to further isolate specific information. See "Using Filters" for information about this feature.

Table columns and descriptions include:


	Column	Description
	MVS Host	The MVS host name.
	Migrates	Indicates if the MVS host supports migrates on this VTSS.
	Reclaims	Indicates if the MVS host supports reclaims on this VTSS.
	Status	The VTSS status from the host: Online, Offline, or Quiesced.
	VTD Count	The number of VTDs for the HOST-VTSS.
	Active Migrate Tasks	The number of active migration tasks for the HOST-VTSS.
	VTSS Accessible	Indicates if the VTSS is accessible from the host.
	Immediate Migrate Wait Time (mins)	The migrate wait time fore the HOST-VTSS, in minutes.
	Refreshed	The date and UTC time the data was stored or last updated.






Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden/visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	See "Using Filters"
	[image: Surrounding text describes filterx.png.]
	Reset Filter	Reset the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Detach Pane icon]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard









VTDs in VTSS

This data table displays a list of VTD IDs for the VTSS that was selected in the "Virtual Tape Storage Subsystem (VTSS)" data table.

If the table is not visible, click the arrows left or right of the displayed tabs and select the table.

You may need to scroll horizontally or detach the table to view all columns.

[image: Surrounding text describes vsmgu018g_vtsshosts.png.]

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

Fields with a context menu indicator can initiate Management commands on specific data items. Right click a field to display the context menu and select the desired menu item.

You can also filter data for individual data columns to further isolate specific information. See "Using Filters" for information about this feature.

Table columns and descriptions include:


	Column	Description
	VTD ID	The VTD ID.
	VTV Volser	The Volser of the VTV on the VTD
	Refreshed	The date and UTC time the data was stored or last updated.






Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden/visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Remove Pane icon]
	Selected Row Data	Show data for selected rows
	[image: Remove Pane icon]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	See "Using Filters"
	[image: Surrounding text describes filterx.png.]
	Reset Filter	Reset the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard









DBU Percentage for VTSS

This graph shows the disk buffer utilization (DBU) used percentage for the selected VTSS, with color coding in the background indicating the low and high auto-migration threshold (AMT) percentage settings and also the Critical DBU threshold percentage setting.

[image: Surrounding text describes vsmgu018f_vtssdbu.png.]

Hover on an object to display summary data for the object.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Remove Pane icon]
	Dial gauge	Display the gauge as a dial
	[image: Remove Pane icon]
	LED gauge	Display the gauge as an LED
	[image: Remove Pane icon]
	Meter gauge	Display the gauge as a status meter
	[image: Remove Pane icon]
	Print	Display as a printable page
	[image: Pane Information icon]
	Refresh	Refresh with data from the VSM GUI database
	[image: Filter Data icon]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










Display VTV






Display VTV

This pane displays Virtual Tape Volume (VTV) information.

To display, select Display and VTV on the navigation tree.

[image: Surrounding text describes vsmgu019_vtv.png.]



Virtual Tape Volumes (VTVs)

This data table shows VTV information.

You may need to scroll horizontally or detach the table to view all columns.

[image: Surrounding text describes vsmgu019a_vtvtable.png.]

Click a row to display MVCs for that VTV in the "MVCs Containing VTV"data table.

The status for some fields is summarized with a status indicator:


	Icon	Name	Description
	[image: Surrounding text describes good.jpg.]
	Good	Indicates no threshold violations are detected
	[image: Surrounding text describes caution.jpg.]
	Caution	Indicates warning thresholds have been exceeded
	[image: Surrounding text describes critical.jpg.]
	Critical	Indicates critical thresholds have been exceeded
	[image: Surrounding text describes unknown.jpg.]
	Unknown	Indicates status could not be detected






Click a status indicator to display its details.

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

Fields with a context menu indicator can initiate Management commands on specific data items. Right click a field to display the context menu and select the desired menu item.

You can also filter data for individual data columns to further isolate specific information. See "Using Filters" for information about this feature.

Table columns and descriptions include:


	Column	Description
	Tapeplex	The name of the tapeplex the VTV belongs to.
	VTV Volser	The volume serial number of the VTV.
Context menu: Reconcile VTV.


	Management Class	The name of the Management Class for the VTV.
	VTSS	The VTSS where the VTV resides. If the VTV is migrated, the VTSS where the VTSS was last resident. If this field is empty, the VTV is non-existent (not created or used, scratched, and deleted) or has been manually imported.
	Uncompressed Size (MB)	The uncompressed size of the VTV in megabytes. This is the size of the VTV as perceived by the application programs.
	Compressed Size (MB)	The compressed size of the VTV in megabytes. This is the raw space that will be occupied on the MVCs or within the VTSSs.
	Compression Percentage	The VTV compression percentage achieved. This is the difference between the uncompressed and compressed VTV size, expressed as a percentage of the uncompressed VTV size. A compression of zero per cent indicates that no compression was possible on the VTV.
	Maximum VTV Size (MB)	The maximum (compressed) size of VTVs in megabytes (400, 800, 2000 or 4000).
	VTV Page Size	The VTV page size, large or standard.
	Last Mounted	The date and time when the VTV content was last mounted for access by an application.
	Last Recall	The date and time when the VTV was last recalled back from a MVC into a VTSS.
	Last Used	The date and time when the VTV was last touched by VTCS. This includes most functions that update the status of the VTV, including VTV mount, migrate, recall, or scratch.
	Created	The date and time when the VTV contents were last changed by an application.
	Times Read	The number of times the VTV has been read.
	Copies to Migrate	The number of migration copies of the VTV.
	Replication	Indicates the VTV's replication status:
NOT REPLICATED: This VTV has not been replicated.

REPLICATION REQUIRED: This VTV should be replicated and is currently queued for processing.

REPLICATION STARTED: Replication is active for this VTV but not yet complete.

REPLICATED: The VTV has been replicated to the VTSS identified in the Replica VTSS column.


	Replica VTSS	The VTSS where the replica VTV resides.
	Owning Tapeplex	The name of the tapeplex where the replica VTV resides.
	Electronic Export	Indicates electronic export status:
EXPORT-NOT POSSIBLE: Export of this VTV to a remote tapeplex was attempted and the request was rejected. Typically, this is due to a different copy of the VTV residing in the remote tapeplex.

EXPORT-REJECTED: Electronic export was actively rejected. This could be due to the target tapeplex not allowing import of the VTV, or a clash with copy status.

EXPORT-REQUIRED: This VTV should be electronically exported and is currently queued for processing.

EXPORT-STARTED: Electronic export is active for this VTV, but not yet complete.


	Initialized	Indicates if the VTV has been initialized. If VTCS has used the VTV at least once, it is initialized. VTVs that are defined with the CONFIG utility but have never been used by VTCS are not initialized.
	Avoid Early Mount	Indicates if concurrent recall or mount encountered an error with this VTV. If so, no further concurrent recall or mount activity will be attempted for this VTV.
	Consolidated	Indicates if VSM has consolidated the VTV.
	Fenced	Indicates if VSM has fenced the VTV.
	Imported	Indicates if VSM has imported the VTV from another tapeplex. Imported VTVs cannot be modified or used for scratch mounts.
	Migrated	Indicates if VSM has migrated the VTV.
	Migration Pending	Indicates if VTV migration is pending. This status is displayed when a VTV is initially created, or when the VTV requires reconciling or archiving. In these latter cases, individual MVC copies may indicate Reconcile or Deletion.
	Mounted	Indicates if the VTV is currently mounted.
	New Create	Indicates if the VTV is newly created.
	Resident	Indicates if the VTV is resident on the VTSS.
	Scratch	Indicates if the VTV is a scratch volume.
	Multiple Start	Used to track the start of multi-volume chaining when a data set runs off the end of one volume onto another.
	Multiple Next	Used to track the end of multi-volume chaining when a data set runs off the end of one volume onto another.
	Refresh	The last refresh date and time.






Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden/visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	See "Using Filters"
	[image: Surrounding text describes filterx.png.]
	Reset Filter	Reset the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










MVCs Containing VTV

This data table displays a list of all MVCs containing the VTV selected in the "Virtual Tape Volumes (VTVs)" data table.

You may need to scroll horizontally or detach the table to view all columns.

[image: Surrounding text describes vsmgu019b_vtvmvcs.png.]

Click a row to display VTVs for that MVC in the "VTVs on MVC" data table.

The status for some fields is summarized with a status indicator:


	Icon	Name	Description
	[image: Surrounding text describes good.jpg.]
	Good	Indicates no threshold violations are detected
	[image: Surrounding text describes caution.jpg.]
	Caution	Indicates warning thresholds have been exceeded
	[image: Surrounding text describes critical.jpg.]
	Critical	Indicates critical thresholds have been exceeded
	[image: Surrounding text describes unknown.jpg.]
	Unknown	Indicates status could not be detected






Click a status indicator to display its details.

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

Fields with a context menu indicator can initiate Management commands on specific data items. Right click a field to display the context menu and select the desired menu item.

You can also filter data for individual data columns to further isolate specific information. See "Using Filters" for information about this feature.

Table columns and descriptions include:


	Column	Description
	Tapeplex	The tapeplex the MVC belongs to.
	MVC Volser	The volser of the MVC.
Context menu: Audit MVC Volser, MVC Drain, Reclaim, Reconcile.


	Media	The volume media type or recording technique.
If Need PTF is displayed, then this host lacks support for this media type, but another host does have support for this media type.


	Media Size (MB)	The size of the MVC in megabytes.
	Storage Class	The Storage Class that owns the MVC. MVCs only become a member of a storage class when they contain migrated VTVs.
Context menu: MVC Drain, Reclaim, Reconcile


	MVC Pool	The name of the MVC Pool the MVC is in.
Context menu: MVC Drain, Reclaim.


	Number of VTVs Migrated	The number of current VTVs migrated to this MVC.
	VTV Count	The number of active VTVs on the MVC.
	Used Percentage	The percentage of the MVC used by current VTVs.
	Fragmented Percentage	The percentage of the MVC that contains noncurrent VTVs. This space is not available for use until it is reclaimed or the MVC is drained.
	Available Percentage	The percentage of the MVC that is physically available for use.
	Usable Percentage	The percentage of space on the MVC that can be used by VTCS. This may be zero even if there is still space physically available. For instance, if the VTV per MVC limit is reached then the usable percentage is reported as zero. Similarly, if an error has been reported against an MVC, VTCS does not use this MVC for output and the usable percentage is reported as zero.
	Times Mounted	The number of times the MVC has been mounted for writing or reading since it was added to the MVC inventory.
	Last Mounted	The date and time at which the MVC was mounted or attempted to be mounted on a RTD.
	Last Migration	The date and time at which the last VTV migration was performed to the MVC.
	Last Drain/Reclaim	The date and time at which the MVC was last processed by Drain or Reclaim processing and its end-of-tape pointer was reset.
	VTSS Last Mounted	The name of the last VTSS that performed a migration to the MVC.
Context menu: Audit VTSS, Vary VTSS.


	Initialized	Indicates the MVC's initialization status, either standard, partitioned, or not initialized.
	Audit	Indicates if the MVC is either currently being audited or has been the subject of a failed audit. While in this state the MVC is not used for migration but can be used for recalls. Due to the inherent state, recalls may fail because the CDS is not yet up-to-date with the MVC contents. To clear this condition, rerun the audit against this MVC.
	Broken	Indicates if the MVC, drive, or combination of the two has a problem. VTCS attempts to depreference MVCs with this state. If the MVC caused the problem, use a DRAIN(EJECT) command to remove the MVC from service. If the RTD caused the problem, use the MVCMAINT utility to reset the MVC state.
	Consolidation	Indicates if the MVC is consolidation MVC.
	Data Check	A data check condition has been reported against this MVC. VTCS attempts to depreference the usage of MVCs with this state. To get into this state, a data transfer must have failed upon two different RTDs.
To clear this state:

If all VTVs on the MVC are duplexed, use MVC Drain on the MVC without the Eject option. This recovers all VTVs and removes the MVC from service.

If all VTVs on the MVC are not duplexed, VTCS AUDIT the MVC. The audit may fail. After the audit, do an MVCDRAIN (no eject). This recalls the VTVs before the data-check area in ascending block-id order and the VTVs after the data-check area in a descending block-id order. Processing the VTVs in this sequence ensures that VTCS recovers as many VTVs as possible from the media. You then need to recreate the data for any VTVs still on the MVC.

Although this indicates that a specific failure has occurred when performing data transfers, this may not be a fault in the media. It could be that a RTD is writing data to the media out of specification. Patterns of failures are therefore important. As an example, lots of DATA CHECK conditions suddenly occurring lots of drives and volumes.


	Deduplication	Indicates if the MVC is deduplicated.
	Drain	Indicates if the MVC is currently the subject of drain or reclaim processing. Should the processing fail, the MVC may be left in this state as a safeguard. To clear this condition, perform a MVCDRain against the MVC.
	Eject	Indicates if the MVC has been ejected.
	Export	Indicates if the MVC is an export MVC.
	Full	Indicates if there is no space available on the MVC.
	Invalid MIR	Indicates if VTCS has received status from an RTD to indicate the MIR (media information record) for a 9x40 media is invalid. An invalid MIR does not prevent access to data but may cause significant performance problems while accessing records on the tape. The MVC is not capable of high-speed searches on areas of the tape that do not have a valid MIR entry.
VTCS attempts to depreference MVCs with this condition. For recalls, if the VTV resides on multiple MVCs, VTCS selects MVCs with valid MIRs ahead of MVCs with invalid MIRs. VTCS avoids using MVCs with invalid MIRs for migration, unless the migration is at the beginning of the tape. Migrating from the beginning of tape corrects the MIR. VTCS detects the invalid MIR condition at either mount time or dismount time. If detected at mount time and the operation can be completed with another MVC, VTCS dismounts the first MVC and selects the alternate MVC.

VTCS has only a limited ability to switch to an alternate MVC. That is, it is mainly used for migrate and virtual mount. For MVCs with invalid MIRs, determine the cause of the error, which may be caused by media or drive problems, and fix the error. To recover an MVC with an invalid MIR, read the MVC to the end of the tape, with a VTCS audit. If the media is the problem, run an MVCDRAIN EJECT to recall the VTVs and cause the MVC to be removed from the MVC pool.


	Lost	Indicates if VTCS attempted to mount an MVC and the mount did not complete within a 15-minute time out period. VTCS has had no specific error report although there could be combination of hardware problems, HSC problems, or by the MVC being removed from the ACS. VTCS attempts to depreference the usage of MVCs with this state. Determine the cause of the error and fix it.
You can also use the VTCS MVCMAINT utility to set LOST(OFF) for the following events:

LOST(ON) was set due to LSM failures or drive errors that have been resolved.

LOST(ON) was set because the MVC was outside the ACS and has been reentered.

This condition is automatically cleared by VTCS if it subsequently requests a mount of the MVC and this is successful.


	Maximum VTV	Indicates if the MVC has reached the maximum number of VTVs.
	Mounted	Indicates if the MVC is mounted on an RTD.
	Protected	Indicates if the MVC is protected.
	Read-only	Indicates if the MVC has been marked read-only:
If this is due to the MVC being the target of an export or consolidation process, the read-only state protects the MVC from further updates.

If the MVC media is set to file protect, correct the error and use the MVCMAINT utility to set READONLY(OFF).If the MVC does not have the appropriate SAF rules set to enable VTCS to update the MVC, correct the error and use the MVCMAINT utility to set READONLY(OFF).


	Retired	Indicates if the MVC is retired and is considered by VTCS as having reached the end of its useful life. VTCS recalls from, but does not migrate to, the MVC. Replace the MVC as soon as possible. Once this has been done, use the MVCMAINT utility to set RETIRED(OFF).
	Usable	Indicates if the MVC can be used for migration.
	Warranty Expired	Indicates if the MVC's warranty has expired. VTCS continues to use the MVC but you should start making plans to replace the MVC when it reaches Retired state.
	Last Verified	The date and time the last VTV media verify was performed to the MVC. This date reflects the last time that VTCS knew the MVC contents were valid.
	ACS	The ACD ID where the MVC resides.
	VLE	The VLE where the MVC resides.
	Consolidated Date	For a consolidation MVC, the date and time of the consolidation.
	EOT Block ID	The end-of-tape block ID.
	EOT Partition ID	The end-of-tape partition ID.
	Block ID First Space	The block ID of the first space on the MVC.
	Refreshed	The date and UTC time the data was stored or last updated.






Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden/visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
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	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	See "Using Filters"
	[image: Surrounding text describes filterx.png.]
	Reset Filter	Reset the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard









VTV States

This graph shows VTV counts for each tapeplex, with current state summarized as Warning, Critical, or Good.

Warning includes VTVs in Migrate Pending state.

Critical includes VTVs in Avoid Early Mount or Fenced state.

Good includes VTVs in none of the above states.

[image: Surrounding text describes vsmgu019c_vtvstates.png.]

Hover on an object to display summary data for the object.

Hover on a label to highlight related objects on the graph.

Click an object to filter the data table by that object.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
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	Vertical bar graph	Display the graph as a vertical bar chart
	[image: Surrounding text describes horizontalbargraph.jpg.]
	Horizontal bar graph	Display the graph as a horizontal bar chart
	[image: Surrounding text describes stackbargraph.jpg.]
	Stacked bar graph	Display the graph as a stacked bar chart
	[image: Surrounding text describes piechart.jpg.]
	Pie chart	Display the graph as a pie chart
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard









VTV Compression

This graph shows VTV counts by tapeplex, sorted by compression percentage range.

To display, select Display and VTV on the navigation tree.

[image: Surrounding text describes vsmgu019d_vtvcompress.png.]

Hover on an object to display summary data for the object.

Hover on a label to highlight related objects on the graph.

Click an object to filter the data table by that object.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes verticalbargraph.jpg.]
	Vertical bar graph	Display the graph as a vertical bar chart
	[image: Surrounding text describes horizontalbargraph.jpg.]
	Horizontal bar graph	Display the graph as a horizontal bar chart
	[image: Surrounding text describes stackbargraph.jpg.]
	Stacked bar graph	Display the graph as a stacked bar chart
	[image: Surrounding text describes piechart.jpg.]
	Pie chart	Display the graph as a pie chart
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Filter Data icon]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard









VTV Counts

This graph shows VTV scratch and resident counts by tapeplex, sorted by current status.

[image: Surrounding text describes vsmgu019e_vtvscratch.png.]

Hover on an object to display summary data for the object.

Hover on a label to highlight related objects on the graph.

Click an object to filter the data table by that object.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes verticalbargraph.jpg.]
	Vertical bar graph	Display the graph as a vertical bar chart
	[image: Surrounding text describes horizontalbargraph.jpg.]
	Horizontal bar graph	Display the graph as a horizontal bar chart
	[image: Surrounding text describes stackbargraph.jpg.]
	Stacked bar graph	Display the graph as a stacked bar chart
	[image: Surrounding text describes piechart.jpg.]
	Pie chart	Display the graph as a pie chart
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard
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6 Management Menu

[image: Surrounding text describes vsmgu020_management.png.]

[bookmark: sthref139]This menu provides access to the following VSM GUI panes:


	
"Command Log"



	
"Audit"



	
"MVC Drain"



	
"Reclaim"



	
"Reconcile"



	
"Vary"









Command Log






Command Log

The Command Log lists all the commands that a user has submitted. If the user is also the administrator, all commands submitted by all users are displayed.

When a command is selected from the list, the command output details are displayed in the Detail tabs beneath the list.

To display the Command Log, select Management and Command Log on the navigation tree.

[image: Surrounding text describes vsmgu021_commandlog.png.]

Click a row to display the output for that command in the Detail tabs. Depending on the selected command, these tabs may include:

	
"Audit Output"


	
"Exceptions"


	
"MVC Results"


	
"Tapeplex Results"


	
"VTVs Moved"


	
"VTV Results"


	
"Electronic Exports"


	
"Vary Output"


	
"Cancelled Processes"




Click the arrows in any column header to sort the data table by that column in ascending or descending order.

Exceptions are denoted in the Exceptions column with an icon:


	Icon	Name	Description
	[image: Surrounding text describes critical.jpg.]
	Critical	Indicates exceptions occurred during the running of a command.






Click the icon to display the "Exceptions" tab.

Table columns and descriptions include:


	Column	Description
	Submitted	The time the command was submitted.
	User Name	The user name that submitted the command.
	Tapeplex	The tapeplex the command was run on.
	Command Type	The type of command issued:
AUDIT

MVC DRAIN

RECLAIM

RECONCILE

VARY CLINK

VARY DRIVE

VARY VTSS


	Command	The actual command that was sent to ELS.
	Status	The current status of the command:SubmittedCompleted
	Completed	The date and time ELS completed running the command.
	Exception	Any exceptions that occurred during the running of a command.








Audit Output

The Audit Output detail tab lists Audit events resulting from the command that is currently selected in the Command Log.

[image: Surrounding text describes auditoutput2.jpg.]

Table columns and descriptions include:


	Column	Description
	MVC VTV	The MVC volser (collapsed) and its VTV volsers (expanded)
	Audit Event	A VSM audit action
	Block ID	The Block ID of the audited VTV
	Uncompressed Size (MB)	The uncompressed size of the VTV in megabytes
	Management Class	The management class assigned to the VTV
	Number of VTVs Audited	The number of VTVs in the MVC that were audited
	Process ID	The process ID, which is a unique number in the range 0 - 65536






Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden/visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










Exceptions

The Exceptions detail tab lists by tapeplex exceptions resulting from the command that is currently selected in the Command Log.

[image: Surrounding text describes exceptions.jpg.]

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

You can also filter data for individual data columns to further isolate specific information. See "Using Filters" for information about this feature.

Table columns and descriptions include:


	Column	Description
	Tapeplex	The name of the tapeplex where the exception occurred
	ELS Version	The ELS version running on the host
	MVS Host	The name of the host
	Server Type	The host server software type
	Subsystem	The name of the VTSS
	Reason	The reason for the exception
	Configuration Token	The configuration token is updated when a significant change has been made to the configuration, signaling a need to possibly retrieve the updated configuration
	Process ID	The process ID, which is a unique number in the range 0 - 65536






Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden/visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	See "Using Filters"
	[image: Surrounding text describes filterx.png.]
	Reset Filter	Reset the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










MVC Results

The MVC Results detail tab lists by MVC the results of the command that is currently selected in the Command Log.

[image: Surrounding text describes mvcresults.jpg.]

Table columns and descriptions include:


	Column	Description
	MVC VTV	The MVC volser (collapsed) and its VTV volsers (expanded)
	ACS Location	The name of the ACS where the MVC is located
	Storage Manager Location	The Storage Manager assigned to the MVC
	Media	The media type of the MVC
	Media Size (MB)	The media size of the MVC in megabytes
	Storage Class	The Storage Class assigned to the MVC
	Candidate VTV Count	The number of VTVs in the MVC
	Total VTV Size (MB)	The total size of the MVC in megabytes






Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden/visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










Tapeplex Results

The Tapeplex Results detail tab lists by tapeplex the results of the command that is currently selected in the Command Log.

[image: Surrounding text describes tapeplexresults.jpg.]

Table columns and descriptions include:


	Column	Description
	Tapeplex VTV	The name of the tapeplex (collapsed) and its VTV volsers (expanded)
	Candidate VTV Count	The total number of VTVs
	Total VTV Size (MB)	The total size of the VTVs in megabytes






Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden/visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










VTVs Moved

The VTVs Moved detail tab lists by moved VTV the results of the command that is currently selected in the Command Log.

[image: Surrounding text describes vtvsmoved.jpg.]

Table columns and descriptions include:


	Column	Description
	MVC VTV	The MVC volser (collapsed) and its VTV volsers (expanded)
	MVC Volser Recalled From	The MVC volser the VTV was recalled from
	Block ID Recalled From	The Block ID the VTV was recalled from
	VTSS Recalled From	The VTSS the VTV was recalled from
	MVC Volser Migrated To	The MVC volser the VTV was migrated to
	Block ID Migrated To	The Block ID the VTV was migrated to
	VTSS Migrated To	The VTSS the VTV was migrated to
	Reason	The reason the MVC was recalled or migrated
	VTVs Recalled /Migrated	The number of VTVs in the MVC that were recalled or migrated






Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden/visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










VTV Results

The VTV Results detail tab lists by VTV the results of the command that is currently selected in the Command Log.

[image: Surrounding text describes vtvresults.jpg.]

Table columns and descriptions include:


	Column	Description
	Tapeplex	The name of the tapeplex where the VTV is located
	VTV Volser	The volser of the VTV
	Uncompressed Size (MB)	The uncompressed VTV size in megabytes
	Compressed Size (MB)	The compressed VTV size in megabytes
	Compression Percentage	The VTV compression percentage
	Created	The VTV creation date and time
	Management Class	The management class assigned to the VTV
	MVC Volser	The name of the MVC volser for the reconciled VTV
	Tapeplex	The name of the new tapeplex for the reconciled VTV
	Reason	The reason the VTV was reconciled






Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden/visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	See "Using Filters"
	[image: Surrounding text describes filterx.png.]
	Reset Filter	Reset the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










Electronic Exports

The Electronic Exports detail tab lists VTVs that were electronically exported by the command that is currently selected in the Command Log.

[image: Surrounding text describes electronicexports.jpg.]

Electronic Exports that were rejected are denoted in the Rejected column with an icon:


	Icon	Name	Description
	[image: Surrounding text describes critical.jpg.]
	Critical	Indicates exceptions occurred during the running of a command.






Click the icon to display the "Exceptions" tab.

Table columns and descriptions include:


	Column	Description
	Tapeplex	The name of the tapeplex where the VTV resides
	Tapeplex Exported To	The name of the tapeplex the VTV is electronically exported to
	MVC Volser Exported To	The MVC the VTV is electronically exported to
	Block ID Exported To	The Block ID the VTV is electronically exported to
	VTSS Exported To	The name of the VTSS the VTV is electronically exported to
	Rejected	Indicates if the electronic export has been rejected






Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden/visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










Vary Output

The Vary Output detail tab shows the result of the Vary command that is selected in the Command Log, with a link to the appropriate Display page (Display CLINK, Display Drive, or Display VTSS) where you can see the results of the command.

[image: Surrounding text describes varyoutput.jpg.]





Cancelled Processes

The Cancelled Processes detail tab lists Queued and Active processes that were manually cancelled using the "Cancel a Process" function on the "Active Processes" or "Queued Processes" tabs.

[image: Surrounding text describes cancelledprocesstab.png.]

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

Table columns and descriptions include:


	Column	Description
	Tapeplex	The tapeplex name.
	MVS Host	The MVS host running the process.
	Process ID	The Process ID for the function, which is a unique number in the range 0 - 65536. When the process ID reaches 65536 it wraps back to zero.
	Function	The type of request:
AllocSCR: Job allocation request for a scratch VTV.

AllocVTV: Job allocation request for a specific VTV.

Audit#: Audit utility request.

Cancel@: Cancel command.

Consold#: Consolidate or export utility task.

Consolid: Recall VTVs for remigration to a consolidation MVC. This appears as a child request to an Int_cons or Consold# request.

Dismount: Dismount a VTV from a VTD.

Display@: Display or query command.

Drain: Recall VTVs from MVC for remigration during drain or reclaim processing. This is a child of a VtvMover request.

Drain@: Drain command or utility.

DrainMVC: There is one DrainMVC request per MVC being drained. DrainMVC, which is a child request of a Drain@ request, is responsible for managing the entire drain process for a single MVC. The VTV column indicates the status of the processing against the MVC.

DELETSCR: Delete scratch utility.

Getmgpol: Obtain current management and storage class definitions.

Getconfig: Get configuration information

HSCChnge: Notification of parameter files being changed.

Import#: Importing of VTV or MVC by a utility.

Int_cons: PGMI initiated consolidate request

MEDVERfy: Media Verify parent task

Migrate: General request to perform the migrations of VTVs to a MVC. This may appear as a child to other request types.

Migrate@: Migrate command or utility. This includes migrates to threshold and auto migrates.

Mount: Mount a VTV upon a VTD. Depending upon circumstances, this may be subsequently seen as a VTV transfer or recall request.

Move MVC: There is one Move MVC request per MVC being processed by reconcile or archive. Move MVC, which is a child request of a MoveVTV# request, is responsible for managing the entire VTV movement process for a single MVC. The VTV column indicates the status of the processing against the MVC.


	
	MoveVTV#: This is a request from the ARCHIVE or RECONCILE utility commands to move copies of VTVs between MVCs. The value -TIME- in the VTV column indicates that the ELAPSED parameter was specified.
MvcMaint: MVCMAINT utility request.

MVC_chek: Check status of MVC.

MVC_eot: Reset the end of tape position of a MVC after completing a drain or reclaim. This is a child of either a DrainMVC, ReclmMVC or Move MVC request.

MVC_inv: Audit of an MVC. This appears as a child request to an Audit# request.MVCpool#: Obtain details and status of MVC pools for a utility.PGMI_req: A request received through the PGMI interface that has yet to be decoded.Query@l: Query or Display command.

MVC_upd: Reset or update MVC status.

Recall: General request to perform the recall of VTVs from a MVC. This may include a Cross TapePlex Autorecall (CTA) request from the mounting system. Recall may appear as a child to other request types.

Recall@: Recall command or utility.

Reclaim@: Auto reclaim request or a Reclaim command or utility. The value -TIME- in the VTV column indicates that the ELAPSED parameter was specified.

ReclmMVC: There is one ReclmMVC request per MVC being reclaimed. ReclmMVC, which is a child request of a Reclaim@ request, is responsible for managing the entire reclaim process for a single MVC. The VTV column indicates the status of the processing against the MVC.

Reconcil: Perform a crosscheck between the contents of the two VTSSs in a cluster.

Replicat: Perform the replication of VTVs between VTSSs in a cluster.

Scratch: Scratch a VTV request from HSC.

Sel_scr: PGMI select scratch

Set@: Set command.

Transfer: Mount a VTV upon a VTD by transferring the VTV between two VTSSs.

Unload: Unload MVC from RTD.

Uscratch: Unscratch a VTV request from HSC.

Vary_dev: Perform very processing against an individual RTD or CLINK. This appears as a child request to an VARY@ request.

Vary@: Vary command.

VtvMaint: VTVMAINT utility request.


	
	VTVMover: There is one VTVMover request per MVC being drained or reclaimed. This is a child of either a DrainMVC, ReclmMVC or Move MVC request. This request is responsible for the movement of VTVs from one MVC to another.
VTSS_inv: Audit of a VTSS. This appears as a child request to an Audit# request.

VTSS_list: Obtain a list of VTV resident within a VTSS. This appears as a child request to a Reconcil or auto migration request.

VTV_upd: Resynchronize VTV status in the VTSS with the CDS.


	Parent ID	The ID of the parent process associated with the request.
	VTSS	The VTSS name or the VTSS list name associated with the request.
	VTV Volser	The volser of the VTV currently being used in the process.
	MVC Volser	The volser of the MVC currently being used in the process.
	RTD Device Address	The unit address of the RTD currently being used in the process.
	VTD Device Address	The device address of the VTD currently being used in the process
	Task Type	The task that is processing the queue or the task to which the request is queued.
	Reason	The reason why the process is active.
	ACS	The ACS the process is using.
	LSM	The LSM the process is using.
	Storage Manager	The Storage manager the process is using.
	Internal Device Type	The Internal device type the process is using.
	For Mount	Indicates if the process is for a mount.
	For VTV Move	Indicates if the process is for VTV moves.
	Local Wait Time (mins)	The local wait time in minutes.
	Storage Class	The storage class for migration targets.
	Refreshed	The date and UTC time the data was stored or updated.






Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden/visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
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	Print	Display as a printable page
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










Audit






Audit

The Audit command request issues a direct request to ELS to run the AUDIT command. AUDIT updates the MVC and VTV information in the HSC CDS.

Select Management and Audit on the navigation tree to display this pane.

[image: Surrounding text describes vsmgu022_audit.png.]

Select the tapeplex to audit on the drop-down list.

Then select one of the following:

	
"Audit by MVC"


	
"Audit by VTSS"






Audit by MVC

[image: Surrounding text describes vsmgu022a_audit.png.]


If Audit by MVC was selected, enter the MVC volsers to audit, separated by commas, or click the magnifying glass to display the Select MVCs dialog box.

[image: Surrounding text describes vsmgu022aa_audit.png.]

In the Select MVCs dialog box, type in your search string and then click Apply. The search operator looks for volsers containing the search string.

The search results are listed in the Tapeplex and MVC Volser fields.

[image: Surrounding text describes vsmgu022aa_selectmvc.png.]

To search again, click Reset to blank the search field and start over.

To select a volser, click the volser and then click OK.

To select a range of volsers, click the first volser in the range and then press SHIFT and the down arrow key simultaneously to define the range of volsers. Then click OK.

When the MVC volsers to audit have been selected, they are displayed on the Audit Command pane.

[image: Surrounding text describes vsmgu022x_audit.png.]

Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the "Command Log" pane.






Audit by VTSS
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If Audit by VTSS was selected, click the magnifying glass to display a dialog box with available VTSSs in the specified tapeplex.
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In the Available column, click the VTSS to audit and then click the arrow button to move it to the Selected column. Then click OK.

[image: Surrounding text describes vsmgu022d_audit.png.]

To select a range of VTSSs, click the first VTSS in the range and then use the down arrow key to define the range. Use the arrow button to move the range of VTSSs to the Selected column. Then click OK.

To move all VTSSs to the Selected column, click the double arrow button. Then click OK.

The selected VTSSs are displayed on the Audit Command pane for submission to the host.
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Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the "Command Log" pane.






MVC Drain






MVC Drain

The MVC Drain command request issues a direct request to ELS to run the MVCDRain command. MVC Drain recalls all current and scratched VTVs from an MVC and, optionally, virtually ejects the MVC, making it unavailable for VSM use without physically ejecting it from the library

Select Management and MVC Drain on the navigation tree to display this pane.

Select the tapeplex to drain on the drop-down list.
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Then select one of the following:

	
"Drain by MVC"


	
"Drain by MVC Pool"


	
"Drain by Storage Class"






Drain by MVC

[image: Surrounding text describes vsmgu023b_mvcdrain.png.]

If Drain by MVC was selected, enter the MVC volsers to drain, separated by commas, or click the magnifying glass to display the Select MVCs dialog box.

[image: Surrounding text describes vsmgu022aa_audit.png.]


In the Select MVCs dialog box, type in your search string and then click Apply. The search operator looks for volsers containing the search string.

The search results are listed in the Tapeplex and MVC Volser fields.

[image: Surrounding text describes vsmgu022aa_selectmvc.png.]

To search again, click Reset to blank the search field and start over.

To select a volser, click the volser to highlight it and then click OK.

To select a range of volsers, click the first volser in the range and then press SHIFT and the down arrow key simultaneously to define and highlight the range of volsers. Then click OK.

When the MVC volsers have been selected, they are displayed in the MVC Drain Command pane.

[image: Surrounding text describes vsmgu023c_mvcdrain.png.]

Select optional parameters:

	
EJECT specifies that VTCS virtually ejects the MVC (the MVC will not be used for output) and physically deletes the VTVs. Without this parameter, the VTVs are not physically deleted but the CDS record is updated to show no VTVs on the MVC.


	
WARRANTY selects MVCs with expired warranties.


	
ERROR selects MVCs that are in error.


	
CONMVC specifies the maximum number of MVCs that VTCS concurrently processes for both drain and reclaim. Valid values are 1 to 99. If not specified, the default is the CONMVC value specified on the CONFIG RECLAIM statement.


	
NOWAIT specifies that the utility does not wait for the operation to complete and returns after the request is submitted.


	
RETIRED selects MVCs that are retired.


	
DATACHK selects MVCs that have a data check.


	
RECALWER specifies whether VTCS recalls VTVs with read data checks. NO is the default. YES recalls VTVs with read data checks.




Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the "Command Log" pane.






Drain by MVC Pool
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If Drain by MVC Pool was selected, select the MVC Pool to drain on the drop-down list.

When the MVC Pool has been selected, it is displayed in the MVC Drain Command pane.
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Select optional parameters:

	
EJECT specifies that VTCS virtually ejects the MVC (the MVC will not be used for output) and physically deletes the VTVs. Without this parameter, the VTVs are not physically deleted but the CDS record is updated to show no VTVs on the MVC.


	
WARRANTY selects MVCs with expired warranties.


	
ERROR selects MVCs that are in error.


	
CONMVC specifies the maximum number of MVCs that VTCS concurrently processes for both drain and reclaim. Valid values are 1 to 99. If not specified, the default is the CONMVC value specified on the CONFIG RECLAIM statement.


	
NOWAIT specifies that the utility does not wait for the operation to complete and returns after the request is submitted.


	
RETIRED selects MVCs that are retired.


	
DATACHK selects MVCs that have a data check.


	
RECALWER specifies whether VTCS recalls VTVs with read data checks. NO is the default. YES recalls VTVs with read data checks.




Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the "Command Log" pane.






Drain by Storage Class
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If Drain by Storage Class was selected, select the Storage Class to drain on the drop-down list.

When the Storage Class has been selected, it is displayed in the MVC Drain Command pane.
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Select optional parameters:

	
EJECT specifies that VTCS virtually ejects the MVC (the MVC will not be used for output) and physically deletes the VTVs. Without this parameter, the VTVs are not physically deleted but the CDS record is updated to show no VTVs on the MVC.


	
WARRANTY selects MVCs with expired warranties.


	
ERROR selects MVCs that are in error.


	
CONMVC specifies the maximum number of MVCs that VTCS concurrently processes for both drain and reclaim. Valid values are 1 to 99. If not specified, the default is the CONMVC value specified on the CONFIG RECLAIM statement.


	
NOWAIT specifies that the utility does not wait for the operation to complete and returns after the request is submitted.


	
RETIRED selects MVCs that are retired.


	
DATACHK selects MVCs that have a data check.


	
RECALWER specifies whether VTCS recalls VTVs with read data checks. NO is the default. YES recalls VTVs with read data checks.




Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the "Command Log" pane.
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Reclaim

The Reclaim command request issues a direct request to ELS to run the RECLAIM command. RECLAIM performs demand MVC space reclamation.

Select Management and Reclaim on the navigation tree to display this pane.
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Select the tapeplex to reclaim space from on the drop-down list.

Then select one of the following:

	
"Reclaim by All MVCs"


	
"Reclaim by MVC"


	
"Reclaim by MVC Pool"


	
"Reclaim by Storage Class"


	
"Reclaim by ACS"






Reclaim by All MVCs

[image: Surrounding text describes vsmgu024a_reclaim.png.]

If Reclaim by All was selected, all MVCs across the tapeplex will be examined for Reclaim eligibility regardless of MVC Pool, Storage Class, or ACS.

Select optional parameters:

	
MAXMVC: Maximum number of MVCs processed by a single space reclamation task. Valid values are 1 to 98. The default is the CONFIG RECLAIM value.


	
INPTHRESH: Percentage of fragmented space that makes a partitioned MVC eligible for dynamic reclaim processing. Valid values are 3 to 97. The default is the current active global INPTHRSH value.


	
CONMVC: Maximum number of MVCs to concurrently process. Valid values are 1 to 99. The default is the CONFIG RECLAIM value.


	
THRESH: Percentage of fragmented space that makes an MVC eligible for demand or automatic reclamation. Valid values are 4 to 98. The default is the CONFIG RECLAIM value.


	
ELAPSE: Maximum time for reconciliation in minutes. Valid values are 1 to 1440. If not specified, there is no time limit on the reclaim process.


	
NOWAIT: Do not wait for operation to complete. Return after the request is submitted.




Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the "Command Log" pane.






Reclaim by MVC
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If Reclaim by MVC was selected, enter the MVC volsers to reclaim, separated by commas, or click the magnifying glass to display the Select MVCs dialog box.

[image: Surrounding text describes vsmgu022aa_audit.png.]


In the Select MVCs dialog box, type in your search string and then click Apply. The search operator looks for volsers containing the search string.

The search results are listed in the Tapeplex and MVC Volser fields.

[image: Surrounding text describes vsmgu022aa_selectmvc.png.]

To search again, click Reset to blank the search field and start over.

To select a volser, click the volser to highlight it and then click OK.

To select a range of volsers, click the first volser in the range and then press SHIFT and the down arrow key simultaneously to define and highlight the range of volsers. Then click OK.

When the MVC Reclaim candidates have been selected, they are displayed on the Reclaim Command pane.

[image: Surrounding text describes vsmgu024e_reclaim.png.]

Select optional parameters:

	
MAXMVC: Maximum number of MVCs processed by a single space reclamation task. Valid values are 1 to 98. The default is the CONFIG RECLAIM value.


	
INPTHRESH: Percentage of fragmented space that makes a partitioned MVC eligible for dynamic reclaim processing. Valid values are 3 to 97. The default is the current active global INPTHRSH value.


	
CONMVC: Maximum number of MVCs to concurrently process. Valid values are 1 to 99. The default is the CONFIG RECLAIM value.


	
THRESH: Percentage of fragmented space that makes an MVC eligible for demand or automatic reclamation. Valid values are 4 to 98. The default is the CONFIG RECLAIM value.


	
ELAPSE: Maximum time for reconciliation in minutes. Valid values are 1 to 1440. If not specified, there is no time limit on the reclaim process.


	
NOWAIT: Do not wait for operation to complete. Return after the request is submitted.




Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the "Command Log" pane.






Reclaim by MVC Pool
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If Drain by MVC Pool was selected, select the MVC Pool to reclaim space from on the drop-down list.
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Select optional parameters:

	
MAXMVC: Maximum number of MVCs processed by a single space reclamation task. Valid values are 1 to 98. The default is the CONFIG RECLAIM value.


	
INPTHRESH: Percentage of fragmented space that makes a partitioned MVC eligible for dynamic reclaim processing. Valid values are 3 to 97. The default is the current active global INPTHRSH value.


	
CONMVC: Maximum number of MVCs to concurrently process. Valid values are 1 to 99. The default is the CONFIG RECLAIM value.


	
THRESH: Percentage of fragmented space that makes an MVC eligible for demand or automatic reclamation. Valid values are 4 to 98. The default is the CONFIG RECLAIM value.


	
ELAPSE: Maximum time for reconciliation in minutes. Valid values are 1 to 1440. If not specified, there is no time limit on the reclaim process.


	
NOWAIT: Do not wait for operation to complete. Return after the request is submitted.




Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the "Command Log" pane.






Reclaim by Storage Class
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If Reclaim by Storage Class was selected, select the Storage Class to reclaim MVC space from on the drop-down list.
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Select optional parameters:

	
MAXMVC: Maximum number of MVCs processed by a single space reclamation task. Valid values are 1 to 98. The default is the CONFIG RECLAIM value.


	
INPTHRESH: Percentage of fragmented space that makes a partitioned MVC eligible for dynamic reclaim processing. Valid values are 3 to 97. The default is the current active global INPTHRSH value.


	
CONMVC: Maximum number of MVCs to concurrently process. Valid values are 1 to 99. The default is the CONFIG RECLAIM value.


	
THRESH: Percentage of fragmented space that makes an MVC eligible for demand or automatic reclamation. Valid values are 4 to 98. The default is the CONFIG RECLAIM value.


	
ELAPSE: Maximum time for reconciliation in minutes. Valid values are 1 to 1440. If not specified, there is no time limit on the reclaim process.


	
NOWAIT: Do not wait for operation to complete. Return after the request is submitted.




Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the "Command Log" pane.






Reclaim by ACS
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If Reclaim by ACS was selected, select the ACS to reclaim MVC space from on the drop-down list.
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Select optional parameters:

	
MAXMVC: Maximum number of MVCs processed by a single space reclamation task. Valid values are 1 to 98. The default is the CONFIG RECLAIM value.


	
INPTHRESH: Percentage of fragmented space that makes a partitioned MVC eligible for dynamic reclaim processing. Valid values are 3 to 97. The default is the current active global INPTHRSH value.


	
CONMVC: Maximum number of MVCs to concurrently process. Valid values are 1 to 99. The default is the CONFIG RECLAIM value.


	
THRESH: Percentage of fragmented space that makes an MVC eligible for demand or automatic reclamation. Valid values are 4 to 98. The default is the CONFIG RECLAIM value.


	
ELAPSE: Maximum time for reconciliation in minutes. Valid values are 1 to 1440. If not specified, there is no time limit on the reclaim process.


	
NOWAIT: Do not wait for operation to complete. Return after the request is submitted.




Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the "Command Log" pane.






Reconcile






Reconcile

The Reconcile command request issues a direct request to ELS to run the RECONcil command. Reconcile performs cross-checks between the MVCs, VTVs, Storage Class, and Management Class definitions. VTVs are optionally moved from one Storage Class to another to reconcile VTV media and location.

Select Management and Reconcile on the navigation tree to display this pane.
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Select the tapeplex to reconcile on the drop-down list.

Select one of the following to define which MVCs will be checked:

	
"Reconcile by All MVCs"


	
"Reconcile by MVC"


	
"Reconcile by Storage Class"






Reconcile by All MVCs

Click All MVCs to select all MVCs as reconciliation candidates.
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MVCs can be further filtered to reconcile the following:

	
"Reconcile All VTVs in All MVCs"


	
"Reconcile Selected VTVs in All MVCs"


	
"Reconcile by Management Class in All MVCs"






Reconcile All VTVs in All MVCs

If Reconcile by All VTVs is also selected, All VTVs in All MVCs will be reconciled.

Select optional parameters:

	
MAXMVC: Specifies the maximum number of MVCs that will be processed by a single reconciliation task. Valid values are 1 to 98. If not specified the CONFIG RECLAIM value (or default) is used. This parameter is ignored if MOVEVTV is not specified.


	
ELAPSE: Specifies the maximum time for the reconciliation in minutes. Valid values are 1 to 1440. If not specified, there is no time limit on the reconciliation process. This parameter is ignored if MOVEVTV is not specified.


	
CONMVC: Specifies the maximum number of MVCs that VTCS concurrently processes during subsequent recall and migrate operations. Valid values are 1 to 99. If not specified the CONFIG RECLAIM value (or default) is used. This parameter is ignored if MOVEVTV is not specified.


	
MOVEVTV: Move VTVs per the currently active Management Policies as specified by the MGMTclas statements that apply to the VTVs. If you do not specify MOVEVTV, only a report is generated and no VTVs are moved.




Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the "Command Log" pane.






Reconcile Selected VTVs in All MVCs

If Reconcile by VTV is also selected, only the selected VTVs in all MVCs will be reconciled. Enter the VTV volsers to reconcile, separated by commas, or click the magnifying glass to display the Select VTVs dialog box.

[image: Surrounding text describes vsmgu027_reconvtv.png.]


In the Select VTVs dialog box, type in your search string and then click Apply. The search operator looks for volsers containing the search string.

The search results are listed in the Tapeplex and VTV Volser fields.

[image: Surrounding text describes vsmgu025b_reconcile.png.]

To search again, click Reset to blank the search field and start over.

To select a volser, click the volser and then click OK.

To select a range of volsers, click the first volser in the range and then press SHIFT and the down arrow key simultaneously to define and highlight the range of volsers. Then click OK.

Selected VTVs are displayed on the Reconcile Command pane.

[image: Surrounding text describes vsmgu025bb_reconcile.png.]

Select optional parameters:

	
MAXMVC: Specifies the maximum number of MVCs that will be processed by a single reconciliation task. Valid values are 1 to 98. If not specified the CONFIG RECLAIM value (or default) is used. This parameter is ignored if MOVEVTV is not specified.


	
ELAPSE: Specifies the maximum time for the reconciliation in minutes. Valid values are 1 to 1440. If not specified, there is no time limit on the reconciliation process. This parameter is ignored if MOVEVTV is not specified.


	
CONMVC: Specifies the maximum number of MVCs that VTCS concurrently processes during subsequent recall and migrate operations. Valid values are 1 to 99. If not specified the CONFIG RECLAIM value (or default) is used. This parameter is ignored if MOVEVTV is not specified.


	
MOVEVTV: Move VTVs per the currently active Management Policies as specified by the MGMTclas statements that apply to the VTVs. If you do not specify MOVEVTV, only a report is generated and no VTVs are moved.




Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the "Command Log" pane.






Reconcile by Management Class in All MVCs

If Reconcile by Management Class is also selected, all VTVs in the selected Management Classes in all MVCs will be reconciled. Click the magnifying glass to display a dialog box with all defined Management Classes in the specified tapeplex.

[image: Surrounding text describes vsmgu025c_reconcile.png.]

In the Available column, click the class to reconcile and then click the arrow button to move it to the Selected column. Then click OK.

[image: Surrounding text describes vsmgu025d_reconcile.png.]

To select a range of classes, click the first class in the range and then use the down arrow key to define the range. Use the arrow button to move the range of classes to the Selected column. Then click OK.

To move all classes to the Selected column, click the double arrow button. Then click OK.

The selected Management Classes are displayed on the Reconcile Command pane.

[image: Surrounding text describes vsmgu025cc_reconcile.png.]

Select optional parameters:

	
MAXMVC: Specifies the maximum number of MVCs that will be processed by a single reconciliation task. Valid values are 1 to 98. If not specified the CONFIG RECLAIM value (or default) is used. This parameter is ignored if MOVEVTV is not specified.


	
ELAPSE: Specifies the maximum time for the reconciliation in minutes. Valid values are 1 to 1440. If not specified, there is no time limit on the reconciliation process. This parameter is ignored if MOVEVTV is not specified.


	
CONMVC: Specifies the maximum number of MVCs that VTCS concurrently processes during subsequent recall and migrate operations. Valid values are 1 to 99. If not specified the CONFIG RECLAIM value (or default) is used. This parameter is ignored if MOVEVTV is not specified.


	
MOVEVTV: Move VTVs per the currently active Management Policies as specified by the MGMTclas statements that apply to the VTVs. If you do not specify MOVEVTV, only a report is generated and no VTVs are moved.




Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the "Command Log" pane.








Reconcile by MVC

Click MVC to specify selected MVCs as reconciliation candidates.

[image: Surrounding text describes vsmgu025f_reconcile.png.]

If Reconcile by MVC is selected, enter the MVC volsers to reconcile, separated by commas, or click the magnifying glass to display the Select MVCs dialog box.

[image: Surrounding text describes vsmgu022aa_audit.png.]


In the Select MVCs dialog box, type in your search string and then click Apply. The search operator looks for volsers containing the search string.

The search results are listed in the Tapeplex and MVC Volser fields.

[image: Surrounding text describes vsmgu022aa_selectmvc.png.]

To search again, click Reset to blank the search field and start over.

To select a volser, click the volser and then click OK.

To select a range of volsers, click the first volser in the range and then press SHIFT and the down arrow key simultaneously to define and highlight the range of volsers. Then click OK.

Selected VTVs are displayed on the Reconcile Command pane.

[image: Surrounding text describes vsmgu025ccc_reconcile.png.]

MVCs can be further filtered to reconcile the following:

	
"Reconcile All VTVs in Selected MVCs"


	
"Reconcile Selected VTVs in Selected MVCs"


	
"Reconcile by Management Class in Selected MVCs"






Reconcile All VTVs in Selected MVCs

If Reconcile by All VTVs is also selected, all VTVs in the selected MVCs will be reconciled.

Select optional parameters:

	
MAXMVC: Specifies the maximum number of MVCs that will be processed by a single reconciliation task. Valid values are 1 to 98. If not specified the CONFIG RECLAIM value (or default) is used. This parameter is ignored if MOVEVTV is not specified.


	
ELAPSE: Specifies the maximum time for the reconciliation in minutes. Valid values are 1 to 1440. If not specified, there is no time limit on the reconciliation process. This parameter is ignored if MOVEVTV is not specified.


	
CONMVC: Specifies the maximum number of MVCs that VTCS concurrently processes during subsequent recall and migrate operations. Valid values are 1 to 99. If not specified the CONFIG RECLAIM value (or default) is used. This parameter is ignored if MOVEVTV is not specified.


	
MOVEVTV: Move VTVs per the currently active Management Policies as specified by the MGMTclas statements that apply to the VTVs. If you do not specify MOVEVTV, only a report is generated and no VTVs are moved.




Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the "Command Log" pane.






Reconcile Selected VTVs in Selected MVCs

If Reconcile by VTV is also selected, only the selected VTVs in the selected MVCs will be reconciled. Enter the VTV volsers to reconcile, separated by commas, or click the magnifying glass to display the Select VTVs dialog box.

[image: Surrounding text describes vsmgu027_reconvtv.png.]


In the Select VTVs dialog box, type in your search string and then click Apply. The search operator looks for volsers containing the search string.

The search results are listed in the Tapeplex and VTV Volser fields.

[image: Surrounding text describes vsmgu025b_reconcile.png.]

To search again, click Reset to blank the search field and start over.

To select a volser, click the volser and then click OK.

To select a range of volsers, click the first volser in the range and then press SHIFT and the down arrow key simultaneously to define and highlight the range of volsers. Then click OK.

Selected VTVs are displayed on the Reconcile Command pane.

[image: Surrounding text describes vsmgu025bb_reconcile.png.]

Select optional parameters:

	
MAXMVC: Specifies the maximum number of MVCs that will be processed by a single reconciliation task. Valid values are 1 to 98. If not specified the CONFIG RECLAIM value (or default) is used. This parameter is ignored if MOVEVTV is not specified.


	
ELAPSE: Specifies the maximum time for the reconciliation in minutes. Valid values are 1 to 1440. If not specified, there is no time limit on the reconciliation process. This parameter is ignored if MOVEVTV is not specified.


	
CONMVC: Specifies the maximum number of MVCs that VTCS concurrently processes during subsequent recall and migrate operations. Valid values are 1 to 99. If not specified the CONFIG RECLAIM value (or default) is used. This parameter is ignored if MOVEVTV is not specified.


	
MOVEVTV: Move VTVs per the currently active Management Policies as specified by the MGMTclas statements that apply to the VTVs. If you do not specify MOVEVTV, only a report is generated and no VTVs are moved.




Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the "Command Log" pane.






Reconcile by Management Class in Selected MVCs

If Reconcile by Management Class is also selected, all VTVs in the selected Management Classes in the selected MVCs will be reconciled. Click the magnifying glass to display a dialog box with all defined Management Classes in the specified tapeplex.

[image: Surrounding text describes vsmgu025c_reconcile.png.]

In the Available column, click the class to reconcile and then click the arrow button to move it to the Selected column. Then click OK.

[image: Surrounding text describes vsmgu025d_reconcile.png.]

To select a range of classes, click the first class in the range and then use the down arrow key to define the range. Use the arrow button to move the range of classes to the Selected column. Then click OK.

To move all classes to the Selected column, click the double arrow button. Then click OK.

The selected Management Classes are displayed on the Reconcile Command pane.

[image: Surrounding text describes vsmgu025cc_reconcile.png.]

Select optional parameters:

	
MAXMVC: Specifies the maximum number of MVCs that will be processed by a single reconciliation task. Valid values are 1 to 98. If not specified the CONFIG RECLAIM value (or default) is used. This parameter is ignored if MOVEVTV is not specified.


	
ELAPSE: Specifies the maximum time for the reconciliation in minutes. Valid values are 1 to 1440. If not specified, there is no time limit on the reconciliation process. This parameter is ignored if MOVEVTV is not specified.


	
CONMVC: Specifies the maximum number of MVCs that VTCS concurrently processes during subsequent recall and migrate operations. Valid values are 1 to 99. If not specified the CONFIG RECLAIM value (or default) is used. This parameter is ignored if MOVEVTV is not specified.


	
MOVEVTV: Move VTVs per the currently active Management Policies as specified by the MGMTclas statements that apply to the VTVs. If you do not specify MOVEVTV, only a report is generated and no VTVs are moved.




Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the "Command Log" pane.








Reconcile by Storage Class

Click Storage Class to specify MVCs in selected Storage Classes as reconciliation candidates.

[image: Surrounding text describes vsmgu025h_reconcile.png.]

If Reconcile by Storage Class was selected, click the magnifying glass to display a dialog box with all Storage Classes in the specified tapeplex.

[image: Surrounding text describes vsmgu025i_reconcile.png.]

In the Available column, click the Storage Class and then click the arrow button to move it to the Selected column. Then click OK.

[image: Surrounding text describes vsmgu025j_reconcile.png.]

To select a range of Storage Classes, click the first Storage Class in the range and then use the down arrow key to define the range. Use the arrow button to move the range of Storage Classes to the Selected column. Then click OK.

To move all Storage Classes to the Selected column, click the double arrow button. Then click OK.

The selected Storage Classes are displayed on the Reconcile Command Request pane.

[image: Surrounding text describes vsmgu025jj_reconcile.png.]

MVCs can be further filtered to reconcile the following:

	
"Reconcile All VTVs in Selected Storage Classes"


	
"Reconcile Selected VTVs in Selected Storage Classes"


	
"Reconcile by Management Class in Selected Storage Classes"






Reconcile All VTVs in Selected Storage Classes

If Reconcile by All VTVs is also selected, all VTVs in the selected Storage Classes will be reconciled.

Select optional parameters:

	
MAXMVC: Specifies the maximum number of MVCs that will be processed by a single reconciliation task. Valid values are 1 to 98. If not specified the CONFIG RECLAIM value (or default) is used. This parameter is ignored if MOVEVTV is not specified.


	
ELAPSE: Specifies the maximum time for the reconciliation in minutes. Valid values are 1 to 1440. If not specified, there is no time limit on the reconciliation process. This parameter is ignored if MOVEVTV is not specified.


	
CONMVC: Specifies the maximum number of MVCs that VTCS concurrently processes during subsequent recall and migrate operations. Valid values are 1 to 99. If not specified the CONFIG RECLAIM value (or default) is used. This parameter is ignored if MOVEVTV is not specified.


	
MOVEVTV: Move VTVs per the currently active Management Policies as specified by the MGMTclas statements that apply to the VTVs. If you do not specify MOVEVTV, only a report is generated and no VTVs are moved.




Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the "Command Log" pane.






Reconcile Selected VTVs in Selected Storage Classes

If Reconcile by VTV is also selected, only the selected VTVs in the selected Storage Classes will be reconciled. Enter the VTV volsers to reconcile, separated by commas, or click the magnifying glass to display the Select VTVs dialog box.

[image: Surrounding text describes vsmgu027_reconvtv.png.]


In the Select VTVs dialog box, type in your search string and then click Apply. The search operator looks for volsers containing the search string.

The search results are listed in the Tapeplex and VTV Volser fields.

[image: Surrounding text describes vsmgu025b_reconcile.png.]

To search again, click Reset to blank the search field and start over.

To select a volser, click the volser and then click OK.

To select a range of volsers, click the first volser in the range and then press SHIFT and the down arrow key simultaneously to define and highlight the range of volsers. Then click OK.

Selected VTVs are displayed on the Reconcile Command pane.

[image: Surrounding text describes vsmgu025bb_reconcile.png.]

Select optional parameters:

	
MAXMVC: Specifies the maximum number of MVCs that will be processed by a single reconciliation task. Valid values are 1 to 98. If not specified the CONFIG RECLAIM value (or default) is used. This parameter is ignored if MOVEVTV is not specified.


	
ELAPSE: Specifies the maximum time for the reconciliation in minutes. Valid values are 1 to 1440. If not specified, there is no time limit on the reconciliation process. This parameter is ignored if MOVEVTV is not specified.


	
CONMVC: Specifies the maximum number of MVCs that VTCS concurrently processes during subsequent recall and migrate operations. Valid values are 1 to 99. If not specified the CONFIG RECLAIM value (or default) is used. This parameter is ignored if MOVEVTV is not specified.


	
MOVEVTV: Move VTVs per the currently active Management Policies as specified by the MGMTclas statements that apply to the VTVs. If you do not specify MOVEVTV, only a report is generated and no VTVs are moved.




Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the "Command Log" pane.






Reconcile by Management Class in Selected Storage Classes

If Reconcile by Management Class is also selected, all VTVs in the selected Management Classes in the selected Storage Classes will be reconciled. Click the magnifying glass to display a dialog box with all defined Management Classes in the specified tapeplex.

[image: Surrounding text describes vsmgu025c_reconcile.png.]

In the Available column, click the class to reconcile and then click the arrow button to move it to the Selected column. Then click OK.

[image: Surrounding text describes vsmgu025d_reconcile.png.]

To select a range of classes, click the first class in the range and then use the down arrow key to define the range. Use the arrow button to move the range of classes to the Selected column. Then click OK.

To move all classes to the Selected column, click the double arrow button. Then click OK.

The selected Management Classes are displayed on the Reconcile Command pane.

[image: Surrounding text describes vsmgu025cc_reconcile.png.]

Select optional parameters:

	
MAXMVC: Specifies the maximum number of MVCs that will be processed by a single reconciliation task. Valid values are 1 to 98. If not specified the CONFIG RECLAIM value (or default) is used. This parameter is ignored if MOVEVTV is not specified.


	
ELAPSE: Specifies the maximum time for the reconciliation in minutes. Valid values are 1 to 1440. If not specified, there is no time limit on the reconciliation process. This parameter is ignored if MOVEVTV is not specified.


	
CONMVC: Specifies the maximum number of MVCs that VTCS concurrently processes during subsequent recall and migrate operations. Valid values are 1 to 99. If not specified the CONFIG RECLAIM value (or default) is used. This parameter is ignored if MOVEVTV is not specified.


	
MOVEVTV: Move VTVs per the currently active Management Policies as specified by the MGMTclas statements that apply to the VTVs. If you do not specify MOVEVTV, only a report is generated and no VTVs are moved.




Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the "Command Log" pane.








Vary






Vary

The Vary command request issues a direct request to ELS to run the VARY command.

Select Management and Vary on the navigation tree to display this pane.

[image: Surrounding text describes vsmgu026_vary.png.]

Select the tapeplex with devices to vary on the drop-down list.

Then select one of the following:

	
"Vary by CLINK"


	
"Vary by RTD"


	
"Vary by VTSS"






Vary by CLINK

[image: Surrounding text describes vsmgu026a_vary.png.]

If Vary by Clink was selected, select the VTSS and CLINK ID.

Select whether to vary the selection ONLINE or OFFLINE.

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the "Command Log" pane.






Vary by RTD

[image: Surrounding text describes vsmgu026c_vary.png.]

If Vary by RTD was selected, click the magnifying glass to display a dialog box with all defined RTDs in the specified tapeplex.

[image: Surrounding text describes vsmgu026ca_vary.png.]

In the Available column, click the RTD to vary and then click the arrow button to move it to the Selected column. Then click OK.

[image: Surrounding text describes vsmgu026caa_vary.png.]

To select a range of RTDs, click the first RTD in the range and then use the down arrow key to define the range. Use the arrow button to move the range to the Selected column. Then click OK.

To move all RTDs to the Selected column, click the double arrow button. Then click OK.

The selected RTDs are displayed on the Vary Command Request pane.

Select whether to vary the selection ONLINE, OFFLINE, or MAINT.

Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the "Command Log" pane.






Vary by VTSS

[image: Surrounding text describes vsmgu026d_vary.png.]

If Vary by VTSS was selected, select the VTSS to vary.

Select whether to vary the selection ONLINE, OFFLINE, or QUIESCED.

Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the Command Log pane.
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This menu provides access to the following:


	
"Site Configuration"



	
"Application Logs"



	
"Database Update Log"









Site Configuration






Site Configuration




	
Note:

Ingest must be disabled before you add or change any value in the site configuration.







Site configuration is where you define and manage site-specific information that is required by the VSM GUI. Site configuration is performed as a part of the initial installation process but can be run again at any time after installation to modify any of the configuration details.

Site configuration is performed using a multi-page wizard, the Site Configuration Wizard, which steps you through the configuration process.

Before you start, disable the Ingest service on your virtual machine.

Select Administration and Site Configuration on the navigation tree.

The Introduction page is displayed.

[image: Surrounding text describes vsmgusiteconfig1.png.]

The Introduction page summarizes the site configuration tasks:

"Configure Supported Tapeplexes"

	
Supply tapeplex names and severity level of log file messages for each tapeplex supported


	
Select whether data for all VTVs or just initialized VTVs is to be collected


	
For each tapeplex, provide connection details for each connected host


	
There must be at least one HTTP server defined for each tapeplex


	
The UI can only collect data and display data from the defined HTTP servers


	
Configured hosts must run a version of ELS supported by the UI




"Configure Application Users"

	
Provide user names and optional Email addresses


	
Assign the roles for each user on each tapeplex


	
The Email address is optional


	
The user role defines the set of VSM GUI pages available. If a user has no access for a tapeplex, then the user will not see data for that tapeplex.




"Configure Alert Levels"

	
Define alert levels to apply tapeplex-wide


	
Define the VTSSs in each tapeplex


	
Add the alert levels for each VTSS


	
All alert levels must be supplied




	
The default database update configuration can be altered, if required




"Edit Default Configuration Properties"

	
Several site configuration properties are editable to fine-tune host cycle times and batch record sizes for your site.




"Review Site Configuration Summary"

	
All configuration data is displayed and can be amended by returning to the appropriate page.




Click Next Page to display the Configure Supported Tapeplexes page and begin the site configuration process.



Configure Supported Tapeplexes

[image: Surrounding text describes vsmgusiteconfig2.png.]

Configure Supported Tapeplexes has two elements:

	
"Create/Edit Tapeplex" is where you define and manage site configuration information about your supported tapeplexes


	
"Create/Edit Host Data for Tapeplex" is where you define and manage site configuration information about the host systems associated with the tapeplexes






Create/Edit Tapeplex

Create/Edit Tapeplex is where you identify and manage site configuration information about supported tapeplexes.

[image: Surrounding text describes vsmgusiteconfig2a.png.]

Data columns and descriptions include:


	Column	Description
	Tapeplex	The name of the supported tapeplex
	Logging Level	Defines the level at which logging entries will be created by the database refresh code. Enabling logging at a given level also enables logging at all higher levels.
Logging levels (in ascending order from lowest to highest) include:

ALL: All messages should be logged

FINEST: Highly detailed tracing messages should be logged

FINER: Fairly detailed tracing messages should be logged

FINE: Basic tracing messages should be logged

CONFIG: Static configuration messages should be logged

INFO: Informational messages should be logged

WARNING: Warning messages indicating a potential problem should be logged

SEVERE: Severe messages indicating a serious failure should be logged

OFF: No messages should be logged


	Initialized VTVs	Determines whether data for all VTVs or just initialized VTVs is to be collected






Click the icons to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes add.png.]
	Add	Add a new tapeplex to the configuration
	[image: Surrounding text describes edit.png.]
	Edit	Edit the selected tapeplex and associated host entries in the configuration
	[image: Surrounding text describes delete.png.]
	Delete	Delete the selected tapeplex and associated host entries from the configuration







Add a New Tapeplex

Click the Add icon. A dialog is displayed.

[image: Surrounding text describes vsmgusiteconfig2aa.png.]

Enter the name of the tapeplex.

Select the Logging Level and Initialized VTVs settings for this tapeplex.

Click OK to enter the data, or click Cancel to end the dialog. Your entries are recorded in the configuration when you click OK.

Repeat these steps to add another tapeplex.

When finished adding tapeplexes, go to "Create/Edit Host Data for Tapeplex" to define and manage information about the host systems associated with the tapeplexes.

When finished with Configure Supported Tapeplexes, click Next Page to display the next configuration page, or click Previous Page to go back one page.





Edit a Tapeplex

Select the tapeplex to edit.

Click the Edit icon. A dialog is displayed.

[image: Surrounding text describes vsmgusiteconfig2ab.png.]

Change the settings you want to edit.

Click OK to enter the revised data, or click Cancel to end the dialog. Your changes are entered in the configuration when you click OK.

When finished with Configure Supported Tapeplexes, click Next Page to display the next configuration page, or click Previous Page to go back one page.





Delete a Tapeplex

Select the tapeplex to delete.

Click the Delete icon. A dialog is displayed.

[image: Surrounding text describes vsmgusiteconfig2ac.png.]

Click OK to delete the tapeplex and all data associated with the tapeplex, or click Cancel to end the dialog. The tapeplex will be deleted when you click OK.

When finished with Configure Supported Tapeplexes, click Next Page to display the next configuration page, or click Previous Page to go back one page.








Create/Edit Host Data for Tapeplex

Create/Edit Host Data for Tapeplex is where you define and manage site configuration information about the host systems associated with a selected tapeplex.

[image: Surrounding text describes vsmgusiteconfig2b.png.]

Data columns and descriptions include:


	Column	Description
	Tapeplex	The name of the tapeplex the host is associated with
	Server Address	Either the IP address for the host or the fully qualified domain name for the host
	Server Port	The port number for the SMC HTTP server that is expected to be running on the host. If this is not running, then the database refresh process will not collect data from this host.
	SMC Subsystem	The SMC subsystem name on the host
	ELS Subsystem	The ELS subsystem name on the host
	ELS Version	The ELS version on the host must be ELS 7.1 or higher. Data will not be collected from a host with an unsupported ELS version.






Click the icons to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes add.png.]
	Add	Add a new host entry to the selected tapeplex
	[image: Surrounding text describes edit.png.]
	Edit	Edit the selected host entry
	[image: Surrounding text describes delete.png.]
	Delete	Delete the selected host entry







Add a New Host

Select the tapeplex the host is associated with in the Create/Edit Tapeplex table.

Click the Add icon for the Create/Edit Host Data for Tapeplex table. A dialog is displayed.

[image: Surrounding text describes vsmgusiteconfig2bb.png.]

Enter the host's HTTP server address and optionally the host's HTTP server port, SMC subsystem, ELS subsystem, and ELS version.

Click OK to enter the data, or click Cancel to end the dialog. Your entries are recorded in the configuration when you click OK.

Repeat these steps to add additional hosts to the tapeplex or to add hosts to a different tapeplex.

When finished with Configure Supported Tapeplexes, click Next Page to display the next configuration page, or click Previous Page to go back one page.





Edit a Host

Select the host to edit.

Click the Edit icon. A dialog is displayed.

[image: Surrounding text describes vsmgusiteconfig2bc.png.]

Change the settings you want to edit.

Click OK to enter the revised data, or click Cancel to end the dialog. Your changes are entered in the configuration when you click OK.

When finished with Configure Supported Tapeplexes, click Next Page to display the next configuration page, or click Previous Page to go back one page





Delete a Host

Select the host to delete.

Click the Delete icon. A dialog is displayed.

[image: Surrounding text describes vsmgusiteconfig2bd.png.]

Click OK to delete the host, or click Cancel to end the dialog. The host will be deleted when you click OK.

When finished with Configure Supported Tapeplexes, click Next Page to display the next configuration page, or click Previous Page to go back one page.










Configure Application Users

User Information is where you identify and manage information about the users who will access VSM GUI. Each user must be in your site's LDAP directory. and must be assigned at least one user role on at least one tapeplex.

User Information has two elements:

	
"Create/Edit User Information" is where you identify the users who will be authorized for VSM GUI login


	
"Create/Edit User Roles for User" is where you define and manage user roles and tapeplex access for specific users




[image: Surrounding text describes vsmgusiteconfig3.png.]



Create/Edit User Information

Create/Edit User Information is where you identify the users who will be authorized for VSM GUI login.

[image: Surrounding text describes vsmgusiteconfig3a.png.]

Table columns and descriptions include:


	Column	Description
	Username	The name of a user that is allowed to run the application. The user name must be the name of a user defined on the site's LDAP directory services
	Email Address	The user's Email address (optional). The email address is used to send information messages to a user that has the VsmGuiAdm role.






Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes add.png.]
	Add	Add or modify user authorization information in the configuration
	[image: Surrounding text describes edit.png.]
	Edit	Edit the selected user and all assigned roles for that user in the configuration
	[image: Surrounding text describes delete.png.]
	Delete	Delete the selected user and all assigned rolls for that user in the configuration







Create a User

Click the Add icon. A dialog is displayed.

[image: Surrounding text describes vsmgusiteconfig3aa.png.]

Enter the username of the user.

Optionally, enter the user's Email address.

Click OK to enter the data, or click Cancel to end the dialog. Your entries are recorded in the configuration when you click OK.

Repeat these steps to add another user.

When finished, go to "Create/Edit User Roles for User" to define and manage user roles and tapeplex access for the user's you create.

When finished with User Information, click Next Page to display the next configuration page, or click Previous Page to go back one page.





Edit a User

Select the username to edit.

Click the Edit icon. A dialog is displayed.

[image: Surrounding text describes vsmgusiteconfig3aaa.png.]

Change the settings you want to edit.

Click OK to enter the revised data, or click Cancel to end the dialog. Your changes are entered in the configuration when you click OK.

When finished with User Information, click Next Page to display the next configuration page, or click Previous Page to go back one page





Delete a User

Select the username to delete.

Click the Delete icon. A dialog is displayed.

[image: Surrounding text describes vsmgusiteconfig3aaaa.png.]

Click OK to delete the user, or click Cancel to end the dialog. The user will be deleted when you click OK.

When finished with User Information, click Next Page to display the next configuration page, or click Previous Page to go back one page.








Create/Edit User Roles for User

Create/Edit User Roles for User is where you define and manage user roles and tapeplex access for specific users. Each user must be assigned at least one user role on at least one tapeplex

[image: Surrounding text describes vsmgusiteconfig3b.png.]

Table columns and descriptions include:


	Column	Description
	User Name	The name of the user to create or edit user roles for
	Tapeplex	The name of the tapeplex to which the user role field will apply
	User Role	The user's access role for this tapeplex:
There are three user roles:

	
VsmViewer: Accesses only the Status and Display tabs, with no access to context menus or Management and Administration tabs on the specified tapeplex


	
VsmOperator: Accesses the Status, Display, Management, and Administration tabs (excluding the Site Configuration and Download Logs options) on the specified tapeplex


	
VsmGuiAdmin: Accesses the Status, Display, and Administration tabs (excluding access to context menus) across all tapeplexes











Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes add.png.]
	Add	Add a new user role entry in the configuration
	[image: Surrounding text describes edit.png.]
	Edit	Edit the selected user role entry in the configuration
	[image: Surrounding text describes delete.png.]
	Delete	Delete the selected user role entry from the configuration







Create a User Role Entry

Select the username whose role entry you want to create.

Click the Add icon. A dialog is displayed.

[image: Surrounding text describes vsmgusiteconfig3bb.png.]

Select the tapeplex the user role is for.

Select the user role.

Click OK to enter the data, or click Cancel to end the dialog. Your entries are recorded in the configuration when you click OK.

Repeat these steps to create another user role entry.

When finished with User Information, click Next Page to display the next configuration page, or click Previous Page to go back one page.





Edit a User Role Entry

Select the username whose role entry you want to edit.

Click the Edit icon. A dialog is displayed.

[image: Surrounding text describes vsmgusiteconfig3bbb.png.]

Change the settings you want to edit.

Click OK to enter the revised data, or click Cancel to end the dialog. Your changes are entered in the configuration when you click OK.

When finished with User Information, click Next Page to display the next configuration page, or click Previous Page to go back one page.





Delete a User Role Entry

Select the username whose role entry you want to delete.

Click the Delete icon. A dialog is displayed.

[image: Surrounding text describes vsmgusiteconfig3bbbb.png.]

Click OK to delete the selected user role entry, or click Cancel to end the dialog. The user role entry will be deleted when you click OK.

When finished with User Information, click Next Page to display the next configuration page, or click Previous Page to go back one page.










Configure Alert Levels

[image: Surrounding text describes vsmgusiteconfig4.png.]

Configure Alert Levels has two elements:

	
"Create/Edit Tapeplex Alert Levels" is where you define the critical alert level threshold for the number of offline VTSSs in a tapeplex that will raise a critical alert


	
"Create/Edit Alert Levels for VTSS" is where you define and manage alert level thresholds for VTSSs within a tapeplex




When finished with Configure Alert Levels, click Next Page to display the next configuration page, or click Previous Page to go back one page.



Create/Edit Tapeplex Alert Levels

Create/Edit Tapeplex Alert Levels is where you define the critical alert level for the number of offline VTSSs in a tapeplex that will raise a critical alert.

[image: Surrounding text describes vsmgusiteconfig4a.png.]

Data columns and descriptions include:


	Column	Description
	Tapeplex	The name of the tapeplex to define or edit alert values for
	VTSS Critical Level	The number of offline VTSSs within the tapeplex that will raise a critical alert






Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes add.png.]
	Add	Add a new tapeplex alert in the configuration
	[image: Surrounding text describes edit.png.]
	Edit	Edit the selected alert for the tapeplex and associated VTSS alerts in the configuration
	[image: Surrounding text describes delete.png.]
	Delete	Delete the selected alert for the tapeplex and associated VTSS alerts in the configuration







Add a New Tapeplex VTSS Critical Level Alert

Click the Add New Alert icon. A dialog is displayed.

[image: Surrounding text describes vsmgusiteconfig4aa.png.]

Select the tapeplex the VTSS Critical Level alert is associated with.

Enter the VTSS Critical Level for the selected tapeplex.

Click OK to enter the data, or click Cancel to end the dialog. Your entries are entered in the configuration when you click OK.





Edit VTSS Critical Level Alert for a Tapeplex

Select the tapeplex where you want to edit the VTSS Critical Level alert.

Click the Edit Alert icon. A dialog is displayed.

[image: Surrounding text describes vsmgusiteconfig4ab.png.]

Change the setting for the VTSS Critical Level alert.

Click OK to enter the revised data, or click Cancel to end the dialog. Your entries are entered in the configuration when you click OK.





Cancel an Alert for a Tapeplex

Select the tapeplex where the Critical Alert Level alarm will be deleted.

Click the Delete icon. A dialog is displayed.
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Click OK to delete the alert, or click Cancel to end the dialog. Your entries are entered in the configuration when you click OK.








Create/Edit Alert Levels for VTSS

Create/Edit Alert Levels for VTSS is where you define and manage alert level thresholds for VTSSs within a tapeplex.
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Table columns and descriptions include:


	Column	Description
	Tapeplex	The name of the tapeplex to add or edit alerts for
	VTSS	The name of the VTSS in the tapeplex to add or edit alerts for
	Critical DBU Level (%)	The disk buffer usage (as a percentage) at which a critical alert is raised for the specified VTSS
	RTD Warning Level	The number of offline RTDs attached to a VTSS that will raise a warning alert
	RTD Critical Level	The number of offline RTDs attached to a VTSS that will raise a critical alert
	VRTD Warning Level	The number of offline vRTDs attached to a VTSS that will raise a warning alert
	VRTD Critical Level	The number of offline vRTDs attached to a VTSS that will raise a critical alert
	FICON CLINK Warning Level	The number of offline FICON CLINKS that will raise a warning alert
	FICON CLINK Critical Level	The number of offline FICON CLINKS that will raise a critical alert
	IP CLINK Warning Level	The number of offline IP CLINKS that will raise a warning alert
	IP CLINK Critical Level	The number of offline IP CLINKS that will raise a critical alert
	Queued Migrates Warning Level	The number of queued migrates that will raise a warning alert
	Queued Migrates Critical Level	The number of queued migrates that will raise a critical alert
	Queued Replications Warning Level	The number of queued replications that will raise a warning alert
	Queued Replications Critical Level	The number of queued replications that will raise a critical alert






Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes add.png.]
	Add	Create alert levels for a VTSS in the configuration
	[image: Surrounding text describes edit.png.]
	Edit	Edit the selected alert in the configuration
	[image: Surrounding text describes delete.png.]
	Delete	Delete the selected alert from the configuration







Add New VTSS Alerts for a Tapeplex

Select the tapeplex where you want to add VTSS alerts.

Click the Add icon. A dialog is displayed.

[image: Surrounding text describes vsmgusiteconfig4ba.png.]

Enter the VTSS name and the then enter alert levels in each field.

Click OK to enter the data, or click Cancel to end the dialog. Your entries are entered in the configuration when you click OK

Repeat these steps to add additional VTSS alert levels.

When finished with Configure Alert Levels, click Next Page to display the next configuration page, or click Previous Page to go back one page.





Edit a VTSS Alert

Select the VTSS in the tapeplex where you want to edit the VTSS alerts.

Click the Edit icon. A dialog is displayed.

[image: Surrounding text describes vsmgusiteconfig4bb.png.]

Change the settings you want to edit.

Click OK to enter the revised data, or click Cancel to end the dialog. Your entries are entered in the configuration when you click OK.





Cancel a VTSS Alert

Select the tapeplex and VTSS for which where the VTSS alerts will be deleted.

Click the Delete icon. A dialog is displayed.

[image: Surrounding text describes vsmgusiteconfig4bc.png.]

Click OK to delete the alert, or click Cancel to end the dialog. Your entries are entered in the configuration when you click OK.










Edit Default Configuration Properties

[image: Surrounding text describes vsmgusiteconfig5.png.]

Several site configuration properties are editable to fine-tune host cycle times and batch record sizes for your site.

Table columns and descriptions include:


	Column	Description
	Primary Cycle Time (minutes)	Primary cycle times are for the data ingest process. The primary ingest gets updates from VTCS on VTV and MVC data, which causes VTCS to scan the CDS and requires MVS resources To avoid impacting other production activity, this process should be done less frequently. The recommended frequency is 60 minutes, which is the default.
	Secondary Cycle Time (minutes)	Secondary cycle times are for the data ingest process. Secondary ingest gets data for all tables not updated by primary ingest. This is less work for VTCS, so the secondary cycle can be run more frequently with little impact on other production activity. The recommended value is 10 minutes, which is the default.
	Batch Size (records)	The number of records added to a database table in a single action during an ingest process. A larger number will result in a faster data load, but any error in a batch results in any remaining rows not being updated. The recommended value is 1000, which is the default.






Click the icon above the graph to perform the following operation:


	Icon	Name	Description
	[image: Surrounding text describes edit.png.]
	Edit	Edit configuration properties







Edit Configuration Properties

Click the Edit icon above the graph. A dialog is displayed:

[image: Surrounding text describes vsmgusiteconfig5aa.png.]

Change the settings you want to edit.

Click OK to enter the revised data, or click Cancel to end the dialog. Your entries are entered in the configuration when you click OK.

When Configure Properties is complete, click Next Page to display the Summary page, or click Previous Page to go back one page in the Site Configuration wizard.








Review Site Configuration Summary

[image: Surrounding text describes vsmgusiteconfig6.png.]

The Summary page lists your current site configuration settings.

Review the settings to ensure they are complete and accurate.

If you need to make changes, use Previous Page to go back to the page where you want to make changes.

When you are finished, click Done to close the Site Configuration Wizard. A dialog is displayed:

[image: Surrounding text describes siteconfigdone.png.]

Click OK to exit the Site Configuration Wizard.

Any changes made are now committed to the database.

Enable the Ingest service on your virtual machine to activate these changes.






Application Logs






Application Logs

The VSM GUI's application logs may be downloaded to your computer as a zip file.

Select Administration and Application Logs on the navigation tree.

[image: Surrounding text describes applicationlogs.png.]

Click Download Logs to start the process.

A dialog appears with options to open or save the file.

[image: Surrounding text describes applicationlogs2.png.]

Select the option to Save File and click OK.

A dialog appears requesting the name of the file to save to.

[image: Surrounding text describes applicationlogs3.png.]

Enter the file name and directory where you want to save the downloaded zip file and click Save.

Use your usual applications for extracting the contents of the zip file and viewing the downloaded application logs.




Database Update Log






Database Update Log

The database update log details the state and status of processes that are run to update the VSM GUI database and displays any error messages that were generated for each process.

Select Administration and Database Update Logs on the navigation tree.

[image: Surrounding text describes databaseupdatelog.png.]


Database Update Log Data Table

This data table shows VSM GUI database update process status.

[image: Surrounding text describes databaseupdatetable.png.]

If errors have occurred, the Status field will contain a status indicator.

If a status indicator is displayed, select that row to display error information about that database update process in the "Errors for Database Update" data table.


	Icon	Name	Description
	[image: Surrounding text describes caution.jpg.]
	Warning	Indicates an error may have occurred
	[image: Surrounding text describes critical.jpg.]
	Critical	Indicates a critical error has occurred
	[image: Surrounding text describes unknown.jpg.]
	Unknown	Indicates status could not be detected






Click the arrows in any column header to sort the data table by that column in ascending or descending order.

Fields with a context menu indicator can initiate Management commands on specific data items. Right click a field to display the context menu and select the desired menu item.

You can also filter data for individual data columns to further isolate specific information. See "Using Filters" for information about this feature.

Table columns and descriptions include:


	Column	Description
	Tapeplex	The tapeplex the database update process was run on
	Type	The database update type
	Manifest ID	The manifest ID of the database update process
	Start Time	The date and time the database update process started
	End Time	The date and time the database update process ended
	State	The state of the database update process
	Status	The status indicator for the database update process
	Re-Run	Enables the corresponding Command Refresh update to be re-launched. This is not available for PRIMARY and SECONDARY manifests as these updates are run automatically.






Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden/visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	See "Using Filters"
	[image: Surrounding text describes filterx.png.]
	Reset Filter	Reset the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










Errors for Database Update

This data table shows the error number and error message for the selected database update process with errors.

[image: Surrounding text describes errorsfordbupdate.png.]

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

You can also filter data for individual data columns to further isolate specific information. See "Using Filters" for information about this feature.

Table columns and descriptions include:


	Column	Description
	Error Number	The error number with the selected database update process
	Error Message	The error message with the selected database update process






Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden/visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	See "Using Filters"
	[image: Surrounding text describes filterx.png.]
	Reset Filter	Reset the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Detach Pane icon]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










Using Filters






A Using Filters

Filters may be applied to VSM GUI data tables to further isolate specific types of information.

The Filter and Reset Filter icons on the toolbar above the data table control filtering:


	Icon	Name	Description
	[image: Surrounding text describes filter.png.]
	Filter	Filter the data
	[image: Surrounding text describes filterx.png.]
	Reset filter	Reset the data filter






When you click the Filter icon, a Filter Table dialog is displayed:

[image: Surrounding text describes filtertable.png.]

Click Match All if you want display candidates to be included only if they match all of the filtering criteria.

Click Match Any if you want display candidates to be included if they match any of the filtering criteria.

Enter filtering criteria in one or more of the displayed data fields.




	
Note:

By default, filtering identifies data fields that contain the specified filtering criteria. For more complex filtering, the Advanced button opens a dialog to a list of alternate filtering operators.







Click Apply to update the data table with the selected filters.

Click Reset to clear the filters and enter new criteria.

Click OK to close the dialog.

Click the Reset Filter icon on the toolbar above the table to re-display the unfiltered table.

For more complex filtering, click the Advanced button on the dialog:

Select one of the following operators for each data column you want to filter:

	
Starts with: Includes only items starting with the entry


	
Ends with: Includes only items ending with the entry


	
Equals: Includes only items that are identical to the entry


	
Does not equal: Includes only items that are not exactly identical to the entry


	
Less than: Includes only items that are less than the entry


	
Less than or equal to: Includes only items that are less than or equal to the entry


	
Greater than: Includes only items that are greater than the entry


	
Greater than or equal to: Includes only items that are greater than or equal to the entry


	
Between: Includes only items that are between the entries


	
Not between: Includes only items that are not between the entries


	
Contains: Includes only items containing the entry


	
Does not contain: Includes only items that do not contain the entry


	
Is blank: Includes only items that are blank


	
Is not blank: Includes only items that are not blank




Enter filtering criteria in the data fields.

Click Apply to update the data table with the selected operators and filtering criteria.

Click Add Fields to add additional fields to the dialog. Select from the list of fields that are currently in the data table but not in the Filter Table dialog.

Enter filtering criteria in the new data fields.

Click Apply to update the data table with the new data fields.

Click Reset to clear the filters and enter different criteria.

Click Basic to toggle back to the previous Filter screen.

Click OK to close the dialog.

Click the Reset Filter icon on the toolbar above the table to re-display the unfiltered table.




Reporting Problems






B Reporting Problems

If a problem in encountered with VSM GUI, open a Service Request to Oracle.

Describe the problem and provide a screen shot if possible, attached to the Service Request.

Collect diagnostic logs from the VSM GUI application server, and attach them to the Service Request.

To gather diagnostic logs, run the following command from a terminal on the VSM GUI application server:

vsmgui@vsmguisvr:~$ /opt/vsmgui/scripts/vsmGui_getlogs.sh

The generated log file can be found in /opt/vsmgui/logs/archive/.

For example:

vsmgui@vsmguisvr:~$ /opt/vsmgui/scripts/vsmGui_getlogs.sh

[ Feb 6 14:01:11 INFO: vsmGui_getlogs.sh: stage log files... ]

[ Feb 6 14:01:12 INFO: vsmGui_getlogs.sh: tar log files... ]

[ Feb 6 14:01:17 INFO: vsmGui_getlogs.sh: VSMGUI_LOGS-020615_140112.tar.gz log file is available in /opt/vsmgui/log/archive ]
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